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I Introducing DeskProto

1.1 Disclaimer

All  milling  devices  (whether  or  not  Numerically  Controlled)  are  dangerous
devices: when working with a milling machine it is possible to damage either
the  workpiece  or  the  machine,  or  even  to  injure  yourself.  So  do  take  care,
and always check your milling paths before sending them to the machine - in
case you are a novice user have an experienced colleague check them.

Delft  Spline  Systems,  the  software  distributor,  the  dealer  and  any  other
intermediate  parties  are  in  no  way  responsible  for  any  damage  or  injury,
direct or consequential, relating to the use of this software.

Copyright © 1995, 2013  Delft Spline Systems
This  computer  program  is  protected  by  copyright  law.  Unauthorized
reproduction or distribution of this program is prohibited.

DeskProto ® is a registered trademark of Delft Spline Systems.

Windows is a trademark of Microsoft Corporation.
All other trademarks are owned by their respective owners.
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1.2 Essentials

What does it offer
DeskProto is a 3D CAM program for 3-axis, 4-axis and 5-axis CNC milling
machines,  offering  Desktop  Prototyping.  DeskProto  will  allow  you  to
machine  even  the  most  complex  3D  geometry  (STL  file),  any  2D  drawing
(DXF file) as well as 3D reliefs based on photos (any bitmap file). It can be
used  for  product  design,  jewelry,  woodworking,  medical,  arts,  education,
hobby,  etc.  DeskProto  can  be  combined  with  any  3D  CAD  program,  and
with any CNC milling machine.
Do  note  that  three  different  editions  of  DeskProto  are  available:  Entry,
Expert  and  Multi-Axis,  the  first  two  offering  a  subset  of  DeskProto’s
functionality. An edition comparison table can be found on www.deskproto.
com 

How does it work
The starting point for DeskProto is a STL file. This file type is standard for
all  types  of  Rapid  Prototyping,  and  contains  a  geometry-description  in  the
form  of  small  triangles  connected  at  their  edges  to  form  a  surface.  Any
current  3D  CAD-system  is  able  to  write  this  type  of  file.  Also  DXF  files
containing  “3D faces”  (like  from  3D Studio  Max)  and  VRML files  can  be
processed. 
It  is  not  possible  to  create  new  geometry  in  DeskProto  (it  is  not  CAD
software,  it  is  about  Rapid  Prototyping).  DeskProto  simply  reads  a  file
created  by  another  program  and  displays  its  contents.  At  this  point  it  is
possible  to  scale  the  geometry,  translate,  rotate  etc.  After  entering  some
milling  parameters  (type  of  cutting  tool,  required  accuracy,  etc)  DeskProto
will  automatically  calculate  the  milling  paths.  No  danger  of  damaging  the
model as the paths are gouge free ! In addition DeskProto can also import 2D
files (DXF, AI, EPS) in  2D Operations, and bitmap files (BMP, GIF, JPG,
PNG, TIFF) for Bitmap Operations.
Run the toolpath program on the desktop CNC milling machine in your own
office or workshop, and you will have your model ready: within a few hours!

What hardware/software is needed
DeskProto is a MS Windows application, it needs Win XP (SP3), Win Vista,
Win 7, Win 8 or newer. On 64 bits  Windows versions a 64 bits  DeskProto
will be installed, otherwise a 32 bits version. Minimum required hardware is
a Pentium PC with 1 GB RAM and 100 GB free disk space: faster/more is
better. An OpenGL compatible 3D graphics card is recommended.

http://www.deskproto.com
http://www.deskproto.com
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1.3 Specifications

Required operating system:
Windows XP (SP3) / Vista / Win7 / Win8 or newer  (Win 95 / 98 / ME / NT
/ 2000 are no longer supported from V 6.0).
For Win XP (at least) Service Pack Three is needed: SP3.

DeskProto  supports  the  64  bit  versions  (x64):  a  special  64  bits  build  of
DeskProto  is  available  to  take  advantage.  Where  the  standard  32  Windows
versions  limit  the  memory  use  to  max  2  GB  per  application,  in  64  bits
versions  this  is  almost  unlimited (many Terabytes).  So  for  users  with  large
STL files and/or large NC program files this is great news !
The  64  bits  build  of  DeskProto (called  x64)  will  be  automatically  installed
on 64 bits versions of Windows: the Setup will detect that the Windows is 64
bits  and  install  the  64  bits  build  of  DeskProto.  Both  builds  behave
identically,  you  can  only  find  out  which  version  by  looking  in  the  About
box.

DeskProto is reported to run OK on an Apple Mac under  Mac OS X using
the Parallels Desktop Win XP emulation software.

Required hard disk space:
About 100 MB for program only, plus at least 100 GB for projects

Required internal memory:
As much as possible, recommended at least 1 GB

Recommended:
A 3D graphics card that supports OpenGL 

Supported Project files:
DPJ, version 2.0
DPJ, version 3.0 / 3.1
DPJ, version 4.0 / 4.1
DPJ, version 5.0
DPJ, version 6.0 / 6.1

Project files exist in two versions: with and without calculated toolpaths.

Supported 3D Geometry file types:
STL STereoLithography
ASCII & binary
DXF AutoCAD Drawing Interchange File
limited to triangles and rectangles (3D)
VRML Virtual Reality Modeling Language
limited to triangles and rectangles



DeskProto Reference

Page 8

Entities  in  these  files  that  are  not  supported  will  be  simply  ignored  by
DeskProto.

Supported 2D file types:
DXF AutoCAD Drawing Interchange File
limited to points, lines, polylines, arcs, circles and ellipses (2D)
EPS Encapsulated PostScript and
AI Adobe Illustrator
limited to points, lines, polylines, arcs, circles and ellipses (2D)

Supported Bitmap file types:
BMP Windows BitMaP
Used by the bitmap operation to load a bitmap
GIF Compuserve Graphic Interchange File
Used by the bitmap operation to load a bitmap
JPG Joint Photographic Experts Group
Used by the bitmap operation to load a bitmap
PNG Portable Network Graphics File
Used by the bitmap operation to load a bitmap
TIFF Tagged Image File Format
Used by the bitmap operation to load a bitmap

Supported NC program files (toolpath data):
NC-program Numeric Controlled
only ASCII, machine-dependent format and file extension

Maximum File size
The  DeskProto  code  does  not  have  a  maximum  for  any  file.  However,
because of the memory limitation for 32 bits Windows versions (see above)
the  max  file  size  nevertheless  is  limited.  As  the  memory  needs  to  contain
both the geometry and the toolpaths these are related:  for a very large STL
file (say 1 GB) only simple toolpaths will be possible. Roughly speaking the
STL file size maximum for 32 bits DeskProto will be about 800 MB (binary
STL).
The 64 bits version can accept much larger STL files. This mainly depends
on how much RAM memory  is  present:  when Windows needs  to  swap  the
calculations will become too slow for most users.
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1.4 Support

If  you  encounter  problems  while  working  with  DeskProto,  please  try  the
following:

1. Search for a solution in the on-line Help system.

2.  Look  in  the  FAQ  (Frequently  Asked  Questions)  on  the  DeskProto
website.

3. Look in the Forum on the same website

4. Carefully read the appropriate sections in the printed Manuals.

5. In case no solution found: ask the Dealer who supplied DeskProto to you.

In case of any other problem: contact Delft Spline Systems.
When you send us  a  project  please  do  so  using  the  option  Create  Problem
Report.

http://www.deskproto.com/support/faq.htm
http://www.deskproto.com/support/forum.php
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1.5 Delft Spline Systems

Delft  Spline  Systems  is  a  Dutch  software  house,  founded  in  1985,
specialized in the development and the use of CAD/CAM software. The first
product of the company, the SIPSURF CAD/CAM package, was released in
1986,  and  is  specialized  in  designing  freeform  surfaces.  For  products
containing  freeform  surfaces  it  is  absolutely  necessary  to  create  physical
models in order to really evaluate the design, so a module to easily calculate
NC milling paths has been present from the start. 

Since that time Rapid Prototyping has  been recognized  as  vital  for  product
development, has even become a buzz word. Based on a long experience of
Rapid Prototyping and NC milling, Delft Spline Systems was able to develop
this unique DeskProto package, meant for product designers. 

Since that time we have found that DeskProto is  very well  suited for  many
other applications as well. Key feature is the ease of use: DeskProto does not
aim  at  CNC  specialists  (like  most  other  CAM  software),  but  instead  at
professionals  in  a  different  application.  Like  in  jewelry,  arts,  design,
education,  prostheses,   woodworking,  food  and  sweets,  and  so  on.  This  is
worded in our motto

"CNC machining for non-machinists"

We hope you will enjoy using it, and we expect it will help you in producing
high quality designs within a short time.

If  you  do  want  more  information,  register  now;  using  the  registration  card
included in the DeskProto box or by sending us an email. Please include the
serial  number  of  your  DeskProto  license.  You  will  be  sent  interesting
information about new releases and other  DeskProto-related subjects.  It’s  a
great  opportunity to keep up  with  the  latest  developments  in  the  promising
world of computer aided design, and CNC-milling machines particularly.

Delft Spline Systems

PO.  Box  2071
3500 GB  Utrecht
The Netherlands

Tel: +31 30 296 5957

Website: www.deskproto.com

Email info@deskproto.com

The DeskProto software © is owned by Delft Spline Systems.
DeskProto ® is a registered trademark of Delft Spline Systems.

mailto:info@deskproto.com
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II Screen layout

The  computer  screen  presented  by  DeskProto  looks  like  the  screenshot
shown  above.  In  this  chapter  a  short  explanation  will  be  given  of  each
element  on  the  screen.  From  top  to  bottom,  the  following  elements  are
present:

· The  top  line  is  called  the  Title  bar,  default  color  blue.  It  contains  the
name of the current project, the word DeskProto, information  about your
license, and a few Windows icons.

· The Menu bar  is the next horizontal line. It  contains in black characters
the names of the available pull-down menus.

· The  button  bar  or  Toolbar  is  the  horizontal  line  below,  containing  a
number of buttons for commands that need to be at hand. DeskProto can
show  these  buttons  in  two  sizes  (setting  in  the  View  menu),  the
illustration shows the small buttons.

· The View window. The large screen-area below the button bar (right part
of the screen) is used to display the geometry in one or more views. The
border of this window contains the Thumb-wheels.

· The  Project  Tree  window  at  the  left  of  the  view  window  displays  the
Project Tree, showing the structure of the current project.

· The NC Files window at the bottom left shows the NC Program files that
have been saved for this project.

· Finally  the  bottom  line  or  Status  bar  displays  extra  information  on  the
DeskProto commands, and some standard Windows messages.
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You can Resize the DeskProto screen, just as most Windows dialog screens.
Two standard sizes and Custom are available: 
· Minimized  (no  window  visible,  only  a  button  on  the  Taskbar),  to  be

achieved using the Minimize button.
· Maximized (full screen window), and in addition, to be achieved using the

 Maximize button.
· Custom  size,  to  be  achieved  using  the  Restore  size  button.  When  in

custom size  mode  you  can  change  the  size  by  positioning  the  cursor  on
one of the borders  or corners of the dialog window (note that  the  cursor
changes to an arrow), pressing the left mouse button and then moving the
cursor.

You can also resize two areas of the  DeskProto screen:  of  both  the  Project
Tree window and the NC Files window the size can be changed. You can do
so  exactly  as  described  above:  move  your  cursor  over  the  border  of  this
screen  area,  see  the  cursor  change,  press  the  left  mouse  button  and  move.
This only works on one side of this screen area, called the splitter.
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2.1 Title Bar

The Title bar is located along the top of a window.
It's  exact  appearance  depends  on  your  version  of  Windows  and  on  the
Windows Theme that you have selected. In many cases this bar will be semi-
transparent, which is a feature of the Windows Aero interface.

To move the window, drag the title bar.  You can also move other dialogs in
DeskProto by dragging their title bars.

A title bar may contain the following elements:
· Application Control-menu button (the orange icon "DP")
· Name of the current DeskProto project, or "Untitled" if the project has not

yet been saved (here "Teapot.dpj")
· Name of the application (here "DeskProto")
· License type: commercial,  educational, hobby, etc. (here "Dealer license:

Not For Resale").
· Minimize button
· Maximize or Restore button
· Close button



DeskProto Reference

Page 14

2.2 Menu Bar

The  menu-bar  is  the  main  route  to  all  the  commands  that  are  available  in
DeskProto.  This  is  why  the  command  reference  in  the  next  chapter  of  this
manual is structured following the  pull down menus. Each item in the menu-
bar represents a pull down menu, which can be made visible by clicking the
left  mouse  button  with  the  cursor  on  the  item.  The  following  items  are
present:

File File management and Print options.

Edit Standard Windows options Edit and Properties.

View Display and View control options.

Parameters Options to change the geometry and milling parameters.

Create Toolpath calculation and saving options.

Options Customization of libraries, defaults and other settings.

Help Online Help options

Note that in the illustration above one character is underlined for each menu-
item. The underlined character can be used to control the program without a
mouse.  Pressing  Alt  +  F  (at  the  same  time)  will  open  the  File  menu  for
instance. 
In most  current versions of Windows the underlining will  be invisible:  you
can press the Alt button to make it visible.
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2.3 Toolbar

The  toolbar  is  the  series  of  buttons  displayed  across  the  top  of  the
application window, below the menu bar.  The toolbar provides quick access
to  many  tools  used  in  DeskProto.  All  these  functions  can  also  be  accessed
via the menus.

To  hide  or  display  the  Toolbar,  choose  Toolbar  from  the  View  menu.  A
check mark appears next to the menu item when the Toolbar is displayed. 

The  next  command  in  the  View  menu  is  "Large  Toolbar  Buttons",  with
which  you  can  choose  between  two  sizes  of  buttons.  Again  with  a  check
mark  if  large  buttons  have  been  selected  (which  is  the  default  status).  The
illustration  above  shows  the  small  size,  in  order  to  fit  all  buttons  on  the
screen.  The best  choice will  depend on  the  resolution  of  your  screen:  on  a
high-res screen the small buttons will become too small.

Below  a  list  of  all  buttons  with  for  each  button  an  explanation  of  its
functions.

Open  a  New  project.  Same  command  as  New  in  the  File
menu

Open  an  existing  project.   DeskProto  displays  the  Open
dialog, in which you can locate and open the desired DPJ-
file.

Save the open project with its current name as DPJ file.  If
you have not yet named the project, DeskProto displays the
Save As dialog.

 

Load or Add a geometry file into the project.

Calculate  the  toolpaths  for  all  visible  operations  of  the
current part.

Write  the  NC  program  for  all  visible  operations  of  the
current part.

Print the image of all views.
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Preview how the image would be printed.

Show or hide the Geometry information dialog.

Change the Layout out of the views.

Change which Subjects should be shown in the active view
(the Scene).

Change  the  Viewpoint  (camera  position)  of  the  active
view.

Set the viewpoint of the active view to Top view (XYZ  0 /
0 / 0 ).

Set the viewpoint of the active view to Front view ( -90 / 0
/ 0).

Set the viewpoint of the active view to Right side view ( -
90 / -90 / 0).

Set  the viewpoint  of the active view to  Bottom view (  0  /
180 / 0).

Set  the  viewpoint  of  the  active  view to  Back view (  -90  /
180 / 0).

Set the viewpoint of the active view to Left side view ( -90
/ 90 / 0).

Set the viewpoint of the active view to Isometric view.

Set the viewpoint of the active view to Default view.

Restore the previous viewpoint settings.
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Change mouse-function to rotation.

Change mouse-function to panning.

Change mouse-function to zooming.

Change  mouse-function  to  zoom  window:  zooming  in  by
selecting a specific area in the active view.

Note that one of these four mouse-functions is active at any
moment,  so  choosing  one  means  deselecting  the  previous
one.  DeskProto  also  offers  other  tools:  the  red  thumb-
wheels  on  the screen are  for  rotations,  the  yellow for  pan
and  the  blue  wheel  is  for  zoom.  A  handy  alternative  is
using the middle mouse button (the mouse-wheel): rotating
this  wheel  zooms,  and  moving  the  mouse  with  the  wheel
depressed pans.

Set  the  Zoom  percentage  to  100%  to  show  the  complete
geometry.

Display the Help Topics dialog.

Enable Context sensitive help.
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2.4 View Window

The  view  window  shows  the  geometry  that  you  are  working  with,  the
toolpaths that you create, and much more. In the screenshot above the most
important items to be displayed are indicated:

The wireframe block in orange is the Part segment:  the material block that
you start with.
The wireframe block in green is  the Operation subsegment:  the area to be
machined.
Both  blocks  can  be  shown  shaded  by  making  them  Translucent  in  the
Subjects dialog
Drawn in metallic blue is the Geometry  that you loaded (the STL file):  the
part to be created.
The  lines  in  red  are  the  Toolpaths:  the  path  that  the  tip  of  the  cutter  will
follow to create your part.
Start and end of the toolpath are shown as small red arrows.
Some of the toolpaths are in violet: these are done at reduced speed because
of a High chipload. 
And the dashed lines in grey are positioning movements in Rapid.
The  green  orientator  at  the  bottom  left  helps  to  orient  by  showing  the
directions of the axes.
The blue orientator shows the position of the WorkPiece zero point.
The  six  Thumb-Wheels  in  the  window  border  can  be  used  to  change  the
camera position.
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The list above includes the most used subjects (items) in the View Window.
Many  more  items  can  be  displayed  though:  this  can  be  defined  with  the
Subjects in View dialog. This dialog contains a large number of checkboxes
to switch the various subjects on and off.

Mind the two different orientators: the green Orientator does not indicate the
WorkPiece zero point, that is shown by the blue Orientator.
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2.5 Project Tree

In DeskProto the structure of the Project is shown in the project tree, which
is placed on the left  of the screen.  In the above example the project  'Torso'
contains  two  parts,  one  with  five  operations  and  one  with  two.  Three
different Operation types can be  present:  the  (standard)  Operation  which is
3D, and the 2D Operation and the Bitmap operation (note the different icons
in the Tree).

The Lamp icon  indicates if a line in the Tree is visible (yellow) or not
(grey). Only one Part can be current (visible) at a time. Of the Operations in
that part none, several or all can be visible. Click on a Lamp icon to change
the status of that line. The Project line has no lamp icon as that line cannot
be turned off.

The lamp can also be red , indicating an error status for that line.
Note that the icon also changes when you are editing the parameters for that

Part or Operation: icon indicates Edit status.

If you do not see a Project tree window, check the option Project tree in the
View menu.  A check-mark appears next to the menu item when the Project
Tree  is  displayed.  Un-checking  this  option  will  make  the  Tree  window
disappear. The size of the Window can be changed by dragging it's borders
with the mouse.

Shortcuts:
The black arrow button in the border of the View Window to open this Tree
Window, and in the Project Tree window Title bar to close it.
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The project tree offers you a number of functions:

Editing parameters
Double-clicking  on  a  line  in  the  tree  will  open  the  dialog  to  edit  the
parameters of the Project, Part or Operation.

Making a part current
To see a particular part you should make it current.  To make a part  current
just click with the left mouse-button on the grey lamp icon of that part. You
can also  use  the  Context  menu (see  below).  When a  part  is  not  current,  its
icon is grayed.
There is always exactly one part that’s current. No more, no less.
You  cannot  make  a  Part  "un-current"  by  clicking  on  a  yellow  lamp  icon:
instead you need to make a different part current.

Making an operation (in)visible
To be able to see how the toolpaths or z-grid looks for a particular operation,
this operation should be visible. To make an operation visible just click with
the left mouse-button in the tree on the grey lamp icon of that  operation to
make  it  yellow  (turn  the  light  on).  Clicking  on  the  yellow  lamp  icon  of  a
visible  project  will  make  it  invisible.  When  an  operation  is  not  visible,  its
icon is grayed.
Of the operations in a Part none, one, several or all can be visible.

Displaying parameters in the status bar
When you single-click on one of the items in the project-tree, that particular
item  is  highlighted  (shown  with  a  blue  background),  meaning  that  it  is
selected. At that moment some of the parameters of that item will be shown
in the Status bar.

Context menus
When you right-click on an item in the tree a small menu pops up called the
context  menu,  offering  you  a  number  of  functions.  The  available  functions
will  be  different  for  each  line  of  the  tree,  and  will  include  the  following
options:

Edit the parameters of that tree-item.

Add a Part to the project. The settings of the default part are used.
Add an Operation to that part. The settings of the first  default operation are
used.  There  are  Add  options  for  a  3D  Operation,  a  2D  Operation  and  a
Bitmap Operation.
Copy  an operation or a part will add an item that is  identical  to the current
one.
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Remove a Part from the project.  This is only possible when there will  be at
least one part left after it has been removed.
Remove an Operation from that part. This is only possible when there will be
at  least  one  operation  left  in  the  part  where  it  belongs  to  after  it  has  been
removed.

Move  Parts  and  Operations  in  the  Tree  can  be  used  when  the  sequence  is
important (for instance first roughing, then finishing).

The other options in the context menu will be self explaining.
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2.6 NC Files

The NC files window shows a list of NC program files that have been saved
for this project. For each file name, location and time are listed. This may be
easy for you to manage NC files for this project.

By right-clicking on any line in this window you can open a Context menu,
offering  options  to  remove  or  delete  the  file,  and  also  to  send  it  to  the
machine (only in case that option has been configured).

The  Window  can  made  visible  or  invisible  by  checking  or  unchecking  the
option NC Files list in the View menu. This same effect can be achieved by
pressing the  black arrow button in the title bar of this window. Note that the
NC  Files  window  can  only  be  visible  when  the  Project  Tree  Window  is
visible too.
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2.7 Status Bar

The status bar is displayed at the bottom of the DeskProto window, and gives
status information about various relevant items. To display or hide the status
bar,  use the Status Bar command in the View menu. A check mark appears
next to the menu item when the Status Bar is displayed.

The left side of the status bar describes the actions of toolbar buttons as you
point to them  (a sort of extra Help information). Menu item actions are also
described when you use the arrow keys to navigate through the menus.

In  the  middle  area  the  most  important  parameters  of  the  selected  tree-item
are displayed: geometry filename for the Project, machine and rotation for a
Part, cutter and precision for an Operation.

At  the  right  side  of  the  status  bar  the  coordinates  of  the  current  mouse
position are displayed, however only when the geometry is displayed in one
of  the  main  views.  These  coordinate  values  shown  are  in  “Transformed”
coordinates:  after  the  Scale,  Mirror  and  Rotate  transformations,  but  before
Translation.  This  is  a  very  handy  option  that  enables  you  to  quickly  check
dimensions and positions on the screen.
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III Menu and commands

3.1 File Menu

The  File  menu  contains  all  options  for  File  management  and  for  Printing,
conform Windows conventions.
On  the  right  side  of  the  menu  you  can  see  "shortcuts"  for  a  number  of
commands: for instance when you keep the Ctrl key pressed and then press
the N key ("Ctrl+N")  DeskProto will open a New project for you. No need
to use your mouse !

Note that not all options are present in the DeskProto Entry edition.

3.1.1 New command

This  File  menu command creates  a  new  project  in  DeskProto.  This  project
will be called "Untitled" until it has been saved.
As a next step you can then load a geometry. 

When  started  DeskProto  automatically  starts  a  new  project,  so  no  need  to
again give this command.
You can open an existing project with the Open command.
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Shortcuts:

Toolbar:
Keys: CTRL+N

3.1.2 Open command

This  File  menu  command  opens  an  existing  project.  The  currently  open
project will  be closed,  and the standard  Windows Open File  dialog will  be
displayed, showing DeskProto project files (.DPJ).

You can’t open more than one project at a time.
You can create a new project with the New command.
A  'Close'  option  is  not  present:  you  can  close  your  current  project  using
either 'New', 'Open' or 'Exit'.

Note that you can not load a geometry file using the Open command: it can
only open DeskProto projects. In order to load a geometry you need to use
the Load Geometry command. Still easier is to use one of the Wizards.

Shortcuts:

Toolbar:
Keys: CTRL+O

When  opening  a  project  file,  the  geometry  file  that  was  used  will  be  read
again:  the  DPJ  files  does  not  store  the  geometry  but  only  a  link  to  the
Geometry  file.  The  geometry  file  must  thus  be  found  at  the  same  place  as
where it was when the project file was saved. So when sending out a project
file make sure to also send the geometry data.

If  the  geometry  file  cannot  be  found  (for  instance  when  the  DPJ  file  was
copied  from  a  different  computer  system)  then  DeskProto  will  check  if  a
geometry  file  with  the  correct  name  can  be  found  in  the  current  directory
(same as the DPJ file) or in the default Data directory. If yes, DeskProto will
ask you if it can use that file instead, see the File Not Found dialog.

3.1.3 Save command

This  File  menu  command  saves  the  open  project  to  its  current  name  and
directory,  in  a  DeskProto project  file  (.DPJ).   When you save  a  project  for
the  first  time,  DeskProto  will  display  the  Save  As  dialog  so  you  can  name
your project.  
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If you want to change the name and directory of the open project before you
save it, choose the Save As command.
Also  if  you  want  to  save  the  DPJ  file  with  toolpaths  you  need  to  use  that
command.

Note  that  the  project  file  does  not  contain  the  geometry,  only  a  link  to  the
geometry file. For saving the geometry after it has been changed use the Save
Geometry As command.

Shortcuts:

Toolbar:
Keys: CTRL+S

3.1.4 Save As command

This  File  menu  command  saves  and  names  (or  renames)  the  open  project,
using the Save As dialog. 

In this dialog you can:
· Name your project. 
· Select a new location for the project file.
· Select the type of DPJ file to be written: standard, with Toolpaths, or V6.0

compatible

To  save  a  project  with  its  existing  name  and  directory,  use  the  Save
command.
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3.1.5 Show Start Screen

The DeskProto Start Screen shown above is a help to quickly start that task
that you need to do. 

Three groups of tasks are presented:
· Open a recent project  -  only filled in case you have used DeskProto V6

before)
· Start  a  new  project   -   either  using  the  Wizard  interface  or  the  Dialog

based interface
· Other
Each line in these three lists is a link that will directly start that task.
The command "Start custom wizard" is not available in the Entry Edition.

The  DeskProto  Setup  has  installed  a  number  of  Sample  projects  and
Sample  geometries  on  your  PC.  Including  some  great  geometries  like  the
DeskProto picture frame: see lesson 1 in the DeskProto Tutorial book.

Conform  Microsoft's  specifications  the  Samples  have  been  installed  in  the
\ProgramData\ folder, which may not be easy to find as it is a hidden folder
and  its  location  is  different  per  Windows  version.  Sorry  about  that,



Menu and commands

Page 29

DeskProto Reference

unfortunately  other  locations  are  not  possible  unless  the  user  has
administrative privileges on the PC.
Using the checkbox Use samples folder  you will always be able to find the
sample geometries.
And  the  'other  task'  Open  sample  project  makes  it  easy  to  find  the  sample
projects.

The  checkbox  Show  this  start  screen  on  startup  makes  this  screen
automatically appear at each start of DeskProto. After having de-selected this
option, you can still access the Start Screen using the command Show Start
screen in the File menu.

3.1.6 Start Wizard command
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The  wizard-based  user  interface  is  an  important  feature  of  DeskProto.  It
makes  it  possible  for  users  without  CAM  know-how  to  easily  create  the
toolpaths that they need for their projects. Each wizard is a series  of dialog
screens (forms) that need to be filled in: the wizard in a way takes your hand
and guides you through the process of creating toolpaths.

Navigating the Wizard is  done  using the Wizard buttons,  on  the  bottom of
the screen:

 Back,  Next,  Cancel,  Help,   Finish, 

Apply, and  Calculate.
Apply will refresh your screen and apply the currently selected settings.
Calculate will calculate the toolpath with the currently selected settings.

The DeskProto wizards start  with the page shown above.  On the top of the
page you can see 7 icons: these are the tabs for the seven pages of the basic
wizard  (not  all  wizards  have  these  seven  pages).  Tabs  2-7  now  are  grey,
when  progressing  they  will  be  colored,  and  then  can  be  used  to  navigate
(click on a colored icon to jump to that page of the wizard). The 7 icons have
the following meaning:
1. Which wizard
2. What to machine
3. Material and supports
4. Roughing (optional)
5. Finishing
6. Contouring (optional)
7. Send to machine

Other available wizard pages (in other wizards) are:
· 2D machining
· Bitmap machining

Important  are  the   yellow  question  marks  in  front  of  each  question.
When you position the cursor over such mark a Tooltip will pop up, giving
extra information about that question. It will also tell you where to find that
setting in the Dialog based interface.

The first question, "Machine to be used" in most cases need not be changed
as your default machine will already have been selected here.

This File menu command presents six wizards that you can choose from: you
need to select one before continuing.  
Not all  wizards will  be available  for all  users  (some may have been grayed
out):  some  wizards  are  not  available  in  all  DeskProto  editions,  and  some
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wizards  are  only  available  in  case  you  selected  a  machine  with  a  rotation
axis.

Basic 3D Milling
This  'basic'  wizard  shows  the  simplest  way  to  machine  a  model  from  your
geometry.  It  is  meant  for  novel  DeskProto  users,  and  explains  step-by-step
the  procedure  to  create  an  NC  toolpath  file  (NC  program)  based  on  your
geometry.  The  model  will  be  machined  from  one  side,  using  three
operations: Roughing, Finishing and a smoothing contour.
In  the  Entry  edition  of  DeskProto  the  pages  "Material  and  supports"  and
"Contouring" are not present.

Two sides, manual flip, also called Two-sided Wizard  (not available in the
Entry edition)
This  advanced  wizard  is  a  unique  feature  of  DeskProto,  and  makes  it  very
easy for you to create a compete 3D model by machining it from two sides,
on any three axis  milling machine.  DeskProto assists you by  taking care  of
the repositioning needed to machine the second half: no need to change the
workpiece zero point (starting position of the cutter).

Two  or  more  sides,  automatic  rotation,  also  called  N-Sided  Wizard   (
available only in the Multi-Axis edition)
N-sided  milling  is  meant  for  machines  with  a  rotation  axis,  and  allows
indexed  machining:  this  wizard  generates  toolpaths  to  machine  the  part
from several (N) sides, with a rotation in-between. The number of sides can
be  freely  chosen:  for  two  sides  the  result  is  the  same  as  for  the  previous
wizard, though now with automatic rotation.

Rotation Axis Machining   (available only in the Multi-Axis edition)
If  your  machine  is  equipped  with  a  rotation-axis  (A-axis)  you  can  use  this
wizard  to  create  toolpaths  for  a  model  that  is  machined  from  all  sides:
rotation axis machining. In contrast to the previous wizard, now the material
rotates  during  machining.  The  rotation  axis  is  an  extra  piece  of  equipment
that lets your model rotate during machining (just like the meat rotating on a
spit above a barbecue).

Basic 2D Machining
This  wizard  shows  how  to  create  2D  toolpaths  for  just  one  2D  file  (DXF,
EPS, AI). It is meant for novel DeskProto users, and explains this procedure
step-by-step. As DeskProto is in fact meant for 3D applications, 2D milling
is more complicated than 3D, and offers less options. So it is a short wizard.

Basic Bitmap Machining
This  wizard  shows  how  to  create  a  relief  based  on  a  bitmap  figure  (BMP,
GIF, JPG, PNG, TIFF file), and create toolpaths to machine this relief.  It  is
meant for novel DeskProto users, and explains this procedure step-by-step. 
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Do note that all  functionality offered by the wizards is also available  in the
dialog-based user interface: the wizards are only meant to make things easier
for you, they do not add new options. After finishing any wizard you can still
use the dialogs to fine-tune the settings that the wizard made.

You can find the Wizard in the File menu  (File >> Start wizard)  or in the
Start Screen.

3.1.7 Start Custom wizard

The Custom Wizard (also called HTML wizard or Script wizard) is a wizard
written in a Script language and later added to DeskProto. 
This is a very powerful option, as it makes it possible for any user and
reseller to create a custom wizard for a specific application and/or a specific
fixture.

Using a Custom Wizard.

Script Wizards can be accessed via the File menu. 

After selecting command Start Custom Wizard the dialog shown above will
pop up, allowing you to select which Custom wizard to use. This list is filled
when DeskProto starts, with all valid Wizards found in the subdirectory
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\Wizard\ of the DeskProto directory, for instance in C:\Program Files
\DeskProto 6.1\Wizard\
As most of the wizards shown in the illustration above require a rotation
axis, the list of wizards will be much shorter for users of an Entry edition
and/or an Expert edition of DeskProto.

A Custom wizard can also be started by:
· calling it's DPW-file as a  command line parameter.
· double-clicking it's DPW-file in Windows explorer.

When you are a user of a DeskProto Custom Wizard and need any Help
information, please refer to the documentation that came with that  Wizard.

Creating a Custom Wizard.

A valid Custom Wizard consist of one DPW file (DeskProto Wizard) and a
subdirectory with the same name.
For  instance  the  file  Basic3D.dpw  and  the  directory  C:\Program  Files
\DeskProto 6.1\Wizard\Basic3D\
The  DPW  file  specifies  the  name  of  the  Wizard,  how  many  pages  are
present, and the files that define each page. These files typically are present
in the subdirectory just mentioned.

Each wizard page is defined by an HTML file that also contains a script. The
HTML part defines the user interface (dialog design, texts, edit  boxes, etc),
and  the  script  defines  the  actions  to  be  performed.  As  scripting  language
JavaScript is used.

So basically all you need to add a Custom wizard to DeskProto is a plain text
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editor.  Copy  the  resulting  files  to  the  location  specified  above,  and
DeskProto will show your new wizard.

For  more  information  on  scripting see  the  Scripts  page,  and  the  DeskProto
Script  Reference  on  the  DeskProto  distribution  CD.  Note  that  a  very  easy
way to create a Script wizard is to copy and rename one of the sample Script
wizards: then the correct structure  already is present.

For software specialists: 
you can set the location of this wizard directory in the registry, at
HKEY_CURRENT_USER\Software\Delft  Spline  Systems\DeskProto\6.1
\Preferences\File Locations\WizardsLocation
Do not change this unless you are sure what you are doing.

3.1.8 Run Script

Normally when you use DeskProto you will load a geometry, set a number of
parameters, calculate toolpaths and save an NC program file. So a number of
actions that are manually done, in a specific sequence. In some applications
the actions to be done and the parameter  settings to be used are always the
same, which makes it possible to automate this task. Such automation can be
achieved by Scripting.

A  Script  is  a  list  of  actions  to  be  done,  saved  in  a  file.  These  actions  of
course need to be described in a language that the computer will understand:
in  a  DeskProto  script  you  need  to  use  the  JavaScript  scripting  languages.
For more information also see the Scripts page.

You can start a script via the "Run Script..." command the File menu.
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This  command  will  open  the  Run  Script  dialog  as  shown  above.  Here  you
can  browse  the  Script  file  (files  are  seen  with  extension  .js  for  JavaScript)
and then press the Run button to start it.

Complete automation can be achieved by starting DeskProto with the name
of the Script file as command line parameter. Then this complete dialog will
be  skipped:  the  script  will  be  started  and  executed  automatically.  More
information about this in Command line parameters.

Note that also a special  type  of  Script  does  exist,  called  the  Script  Wizard,
which  does  exactly  as  the  name  suggests.  These  script  wizards  can  not  be
started using this Run Script command.
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Above you see the very simple script file ExampleScript.js  that was present
in  the  dialog  just  shown.  It  contains  two  functions,  one  to  load  a  3D
geometry  file,  and  one  to  add  and  rotate  a  part.  Line  starting  with  "//"  in
JavaScript  are  comment  lines.  This  is  just  a  very  simple  example:  you  can
add any DeskProto functionality here, which makes scripting a very powerful
tool for automation.

The  second  example  script  file  that  has  been  installed  is  called
ScriptedBottle.js
This  script  will  load  the  bottle  sample  geometry,  rotated  and  segment  it,
calculate toolpaths and save an NC file. No path for the NC Program file is
specified, so it will be saved in the default location which is in most cases is
the (My) Documents folder.
When using such script as command line parameter you can even add an Exit
command: then the actual user does not need to perform any user-interaction
with DeskProto.

For more information on scripting see the DeskProto Script Reference on the
DeskProto distribution CD. 

3.1.9 Load Geometry command

The  File  menu  command  Load  Geometry  displays  the  standard  Windows
Open File dialog in which you can select the geometry-file you want to load.
It will be showing all 3D Geometry file types that DeskProto can read: STL,
DXF and WRL.
After  browsing  the  file  it's  contents  will  be  loaded,  at  project  level
(DeskProto uses one 3D geometry per project).

Shortcuts:

Toolbar:

When  you  already  have  loaded  a  geometry,  this  command  will  change  to
Add  Geometry  and  the  new  geometry  will  be  Added,  top  form  one
combined new geometry. If you want to replace your current geometry with a
new,  then  go  to  the  Parameters  menu  and  choose  the  option  Project
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Parameters.

Only when Adding a second 3D geometry file  an extra  dialog will  pop up:
the  Add  Geometry  Transformation  dialog.  This  dialog  enables  you  to
position the new geometry relative to the current one:

It  offers  basically  the  same  transformations  as  also  present  in  the  Part
Parameters (see there for more help),  however these  will  be applied to the
new  geometry  file  only.  After  adding  the  second  geometry  file  DeskProto
only sees  one  resulting geometry,  making  it  impossible  to  later  translate  or
rotate only the new geometry elements.

A very  handy tool  in  this  dialog is  the  Preview  button,  as  it  will  draw  the
new geometry  file  according  to  the  transformations  that  you  entered  in  the
dialog.  If  this  new  position  is  not  OK,  you  can  enter  new  transformation
values and again press Preview for a new drawing. When all is OK you can
acknowledge with OK, or abort with Cancel.
Note that on top of the Transformations that you enter in this dialog, also the
Part Transformations of the visible part will be applied to the drawing. This
means that when a rotation is applied in the Part Parameters setting a correct
Rotation for Add geometry will be very difficult.
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An  application  for  this  extra  transformation  is  for  instance  if  you  want  to
machine two parts in one setup, positioned next to one another.

3.1.10 Save Geometry as command

This File menu command displays the standard Windows Save File dialog in
which  you  can  define  the  geometry-file  you  want  to  write.  This  command
makes it possible to use DeskProto as a converter for geometry files. It also
can be used to merge several geometry files to a combined new file. All this
applies only to 3D geometry files.

DeskProto supports six file formats for geometry files, you can select one in
the Save as Type box.
STL STereoLithography File ASCII
STL Binary
DXF AutoCAD Drawing eXchange File Polyface Meshes
DXF 3D Faces
VRML Virtual Reality Modeling Language Version 1.0
VRML Version 2.0

STL is  preferred as being most  standard,  and then binary results  in a much
smaller file size than ASCII. So Binary STL is the default file type here

Before  this  standard  Save  dialog  an  extra  dialog  will  pop  up:  the  Save
Geometry Options dialog, which enables you to apply Transformations that
you have set in the Part Parameters. The dialog looks like this:
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It  offers  the  six  transformations  that  can  be  set  in  the  Part  Parameters  (see
there  for  more  help).  Note  that  only  those  transformations  can  be  checked
that indeed have been applied.  When you check a transformation, DeskProto
will  save  the  3D  geometry  including  that  transformation.  So  new  file  will
then  contain  rotated  geometry,  scaled  geometry,  with  support  blocks,  etc.
This  is  ideal  for  instance  for  saving  a  scaled  or  rotated  version  of  your
geometry  file.  This  feature  also  can  be  used  to  create  more  than  4  support
blocks (save with 4 blocks, load again and again add blocks).

3.1.11 Print Setup command

This  File  menu  command  selects  a  printer  and  a  printer  connection.   This
command  presents  the  standard  Windows  Print  Setup  dialog,  where  you
specify the printer and its connection. The available options will depend on
the Printer driver that you have selected.

Note  that  some  CNC milling  machines  also  use  a  Windows  Printer  Driver
and  thus  a  Print  Setup  Dialog.  Do  NOT  select  such  milling  machine  here,
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instead use the DeskProto Preferences. This command is only for printing on
paper.

3.1.12 Print Image Preview command

This  File  menu  command  displays  the  image  of  the  View  Window  as  it
would appear when printed.

When you choose this command, the main window will  be replaced  with  a
print preview window in which one or two pages will  be displayed in their
printed format.  The print preview toolbar offers you options to view either
one  or  two  pages  at  a  time;  move  back  and  forth  through  the  document;
zoom in and out of pages; and initiate a print job.

Shortcuts:

Toolbar:

3.1.13 Print Image command

This File menu command prints an image of the DeskProto View Window.

This command presents  a Print  dialog,  where you may specify the range of
pages to be printed, the number of copies, the destination printer, and other
printer setup options.

Shortcuts:

Toolbar:
Keys: CTRL+P

3.1.14 Print Project Data command

This File menu command prints all the data in the project, that means all the
project parameters, the parameters of all of its parts, and the parameters of all
of  their  operations.  The  printed  pages  can  be  used  for  backup  and
documentation purposes.

This command presents  a Print  dialog,  where you may specify the range of
pages to be printed, the number of copies, the destination printer, and other
printer setup options.
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3.1.15 File 1, 2, 3, 4 command

Use the numbers and filenames listed at the bottom of the File menu to open
one  of  the  last  eight  projects  you  closed.   Choose  the  number  that
corresponds with the project you want to open.
This list is called the Recent File List,  and is a convenient standard option
of current Windows software.

3.1.16 Exit command

This File menu command ends your DeskProto session. You can also use the
 Close  command on  the application  Control  menu.  DeskProto  prompts  you
to save projects with unsaved changes.

Shortcuts:
Mouse: Click  the  application's  Close  button  (top  right  button  of  the  title
bar).

Keys: ALT+F4
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3.2 Edit Menu

The  Edit  menu  contains  all  options  for  Clipboard  actions  and  a  Properties
command, conform Windows conventions. The number of commands is very
limited though as DeskProto does not include an Undo function, and as Cut,
Paste, Select and Search actions are not applicable for DeskProto.

3.2.1 Copy Image command

This  Edit  menu  command  copies  the  contents  of  the  DeskProto  View
Window to the Windows Clipboard.
The clipboard is  used to  cut  and paste  data  between  windows  applications:
you can for instance Paste this image into a Word document.

Copying data to the clipboard replaces the contents previously stored there.
Note that this command has no visible effect in DeskProto.

Shortcuts:
Keys: CTRL+C

3.2.2 Properties command

This Edit menu command can be used to edit the highlighted tree-item or the
active view. Depending on what is selected last this command will open one
of the following five dialogs:
Project Parameters , Part Parameters , Operation Parameters ,  2D Operation
Parameters , Bitmap Operation Parameters , Viewpoint .
This  is  conform Microsoft's  specifications  for  Windows:  Edit  ->  Properties
should open the Properties dialog for the selected item.



Menu and commands

Page 43

DeskProto Reference

3.3 View Menu

The  functions  in  the  View  menu  let  you  control  what  is  visible  on  your
screen.

3.3.1 Toolbar

The  toolbar  is  the  series  of  buttons  displayed  across  the  top  of  the
application window, below the menu bar.  The toolbar provides quick access
to  many  tools  used  in  DeskProto.  All  these  functions  can  also  be  accessed
via the menus.

To  hide  or  display  the  Toolbar,  choose  Toolbar  from  the  View  menu.  A
check mark appears next to the menu item when the Toolbar is displayed. 

The  next  command  in  the  View  menu  is  "Large  Toolbar  Buttons",  with
which  you  can  choose  between  two  sizes  of  buttons.  Again  with  a  check
mark  if  large  buttons  have  been  selected  (which  is  the  default  status).  The
illustration  above  shows  the  small  size,  in  order  to  fit  all  buttons  on  the
screen.  The best  choice will  depend on  the  resolution  of  your  screen:  on  a
high-res screen the small buttons will become too small.

Below  a  list  of  all  buttons  with  for  each  button  an  explanation  of  its
functions.
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Open  a  New  project.  Same  command  as  New  in  the  File
menu

Open  an  existing  project.   DeskProto  displays  the  Open
dialog, in which you can locate and open the desired DPJ-
file.

Save the open project with its current name as DPJ file.  If
you have not yet named the project, DeskProto displays the
Save As dialog.

 

Load or Add a geometry file into the project.

Calculate  the  toolpaths  for  all  visible  operations  of  the
current part.

Write  the  NC  program  for  all  visible  operations  of  the
current part.

Print the image of all views.

Preview how the image would be printed.

Show or hide the Geometry information dialog.

Change the Layout out of the views.

Change which Subjects should be shown in the active view
(the Scene).

Change  the  Viewpoint  (camera  position)  of  the  active
view.

Set the viewpoint of the active view to Top view (XYZ  0 /
0 / 0 ).
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Set the viewpoint of the active view to Front view ( -90 / 0
/ 0).

Set the viewpoint of the active view to Right side view ( -
90 / -90 / 0).

Set  the viewpoint  of the active view to  Bottom view (  0  /
180 / 0).

Set  the  viewpoint  of  the  active  view to  Back view (  -90  /
180 / 0).

Set the viewpoint of the active view to Left side view ( -90
/ 90 / 0).

Set the viewpoint of the active view to Isometric view.

Set the viewpoint of the active view to Default view.

Restore the previous viewpoint settings.

Change mouse-function to rotation.

Change mouse-function to panning.

Change mouse-function to zooming.

Change  mouse-function  to  zoom  window:  zooming  in  by
selecting a specific area in the active view.

Note that one of these four mouse-functions is active at any
moment,  so  choosing  one  means  deselecting  the  previous
one.  DeskProto  also  offers  other  tools:  the  red  thumb-
wheels  on  the screen are  for  rotations,  the  yellow for  pan
and  the  blue  wheel  is  for  zoom.  A  handy  alternative  is
using the middle mouse button (the mouse-wheel): rotating
this  wheel  zooms,  and  moving  the  mouse  with  the  wheel
depressed pans.
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Set  the  Zoom  percentage  to  100%  to  show  the  complete
geometry.

Display the Help Topics dialog.

Enable Context sensitive help.

3.3.2 Large toolbar buttons

The  Toolbar  is  the  series  of  buttons  displayed  across  the  top  of  the
application window, below the menu bar.
In case your have a very high resolution monitor - or if you do not have clear
eye-sight  -  these  buttons  might  be  too  small  for  you  to  clearly  recognize
them.  To  solve  that  problem  you  can  ask  DeskProto  to  display  large  size
buttons. Note that in the Windows Display properties you can select a larger
font for all text.

To  select  or  deselect  this  option,  choose  "Large  toolbar  buttons"  from  the
View  menu.  A  check  mark  appears  next  to  the  menu  item  when  the  large
buttons are displayed. 

The illustration shows the difference between normal size and large size.

3.3.3 Status bar

The status bar is displayed at the bottom of the DeskProto window, and gives
status information about various relevant items. To display or hide the status
bar,  use the Status Bar command in the View menu. A check mark appears
next to the menu item when the Status Bar is displayed.

The left side of the status bar describes the actions of toolbar buttons as you
point to them  (a sort of extra Help information). Menu item actions are also
described when you use the arrow keys to navigate through the menus.

In  the  middle  area  the  most  important  parameters  of  the  selected  tree-item



Menu and commands

Page 47

DeskProto Reference

are displayed: geometry filename for the Project, machine and rotation for a
Part, cutter and precision for an Operation.

At  the  right  side  of  the  status  bar  the  coordinates  of  the  current  mouse
position are displayed, however only when the geometry is displayed in one
of  the  main  views.  These  coordinate  values  shown  are  in  “Transformed”
coordinates:  after  the  Scale,  Mirror  and  Rotate  transformations,  but  before
Translation.  This  is  a  very  handy  option  that  enables  you  to  quickly  check
dimensions and positions on the screen.

3.3.4 Geometry information dialog

The  View  menu  command  Geometry  Information  displays  or  hides  the
Geometry  Information  dialog,  which  shows  information  about  the
geometry and the current part.  A check mark appears next to the menu item
when the dialog is displayed.

Shortcuts

Toolbar:

Depending on which Operations are present in the project,  four,  five or six
tab pages are shown.

General:
Information about the file: file name, location, size; 
Information about its contents: number of facets (triangles) and points.
Original:
The dimensions of the original 3D geometry, as read from the geometry file
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(CAD-coordinate system). These values are the same for all parts.
Transformed:
The 'transformed' values are an intermediate result (for the current part): all
part  parameters  from  the  Transform  page  have  been  applied  (scale,  mirror
and rotate), supports, segmentation and translation have not. The values are
in an ‘in-between coordinate system”.
Part:
The  dimensions  of  the  prototype  as  it  will  be  machined,  so  after
segmentation and translation have been applied as  well.  These  are  given in
the  workpiece  coordinate  system  set  on  your  milling  machine.  This  is
important information for you, as these are also the dimensions of the Block
of material that you have to prepare.
2D (in case present):
The  dimensions  of  the  2D  Operations  (only  the  visible  Operations),  in  the
workpiece coordinate system.
Bitmap (in case present):
The  dimensions  of  the  Bitmap  Operations  (only  the  visible  Operations),  in
the workpiece coordinate system.

In all TAB pages coordinates are given for min, max and delta. The min and
max  part  values  are  handy  when  setting  the  workpiece  zero  point  on  the
machine, the delta values can be used to prepare the  block of material to be
machined. 

A nice detail is that you can easily copy the contents of this Geo information
dialog to the Clipboard: 
just press Ctrl-C while this dialog is active, after that you can paste the text
into your editor or authoring program

The  dialog  can  be  viewed  in  two  ways;  as  the  small  dialog  box  with  tab
pages (shown above), or as a large dialog box with all the information visible
at  the  same time (shown below).  You can  switch  easily  between  those  two
types of dialogs by pressing the button at  the  bottom on  the right  side  (the
small black arrow).
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The dialog can stay open while you are working with the project.
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3.3.5 Project Tree

In DeskProto the structure of the Project is shown in the project tree, which
is placed on the left  of the screen.  In the above example the project  'Torso'
contains  two  parts,  one  with  five  operations  and  one  with  two.  Three
different Operation types can be  present:  the  (standard)  Operation  which is
3D, and the 2D Operation and the Bitmap operation (note the different icons
in the Tree).

The Lamp icon  indicates if a line in the Tree is visible (yellow) or not
(grey). Only one Part can be current (visible) at a time. Of the Operations in
that part none, several or all can be visible. Click on a Lamp icon to change
the status of that line. The Project line has no lamp icon as that line cannot
be turned off.

The lamp can also be red , indicating an error status for that line.
Note that the icon also changes when you are editing the parameters for that

Part or Operation: icon indicates Edit status.

If you do not see a Project tree window, check the option Project tree in the
View menu.  A check-mark appears next to the menu item when the Project
Tree  is  displayed.  Un-checking  this  option  will  make  the  Tree  window
disappear. The size of the Window can be changed by dragging it's borders
with the mouse.

Shortcuts:
The black arrow button in the border of the View Window to open this Tree
Window, and in the Project Tree window Title bar to close it.
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The project tree offers you a number of functions:

Editing parameters
Double-clicking  on  a  line  in  the  tree  will  open  the  dialog  to  edit  the
parameters of the Project, Part or Operation.

Making a part current
To see a particular part you should make it current.  To make a part  current
just click with the left mouse-button on the grey lamp icon of that part. You
can also  use  the  Context  menu (see  below).  When a  part  is  not  current,  its
icon is grayed.
There is always exactly one part that’s current. No more, no less.
You  cannot  make  a  Part  "un-current"  by  clicking  on  a  yellow  lamp  icon:
instead you need to make a different part current.

Making an operation (in)visible
To be able to see how the toolpaths or z-grid looks for a particular operation,
this operation should be visible. To make an operation visible just click with
the left mouse-button in the tree on the grey lamp icon of that  operation to
make  it  yellow  (turn  the  light  on).  Clicking  on  the  yellow  lamp  icon  of  a
visible  project  will  make  it  invisible.  When  an  operation  is  not  visible,  its
icon is grayed.
Of the operations in a Part none, one, several or all can be visible.

Displaying parameters in the status bar
When you single-click on one of the items in the project-tree, that particular
item  is  highlighted  (shown  with  a  blue  background),  meaning  that  it  is
selected. At that moment some of the parameters of that item will be shown
in the Status bar.

Context menus
When you right-click on an item in the tree a small menu pops up called the
context  menu,  offering  you  a  number  of  functions.  The  available  functions
will  be  different  for  each  line  of  the  tree,  and  will  include  the  following
options:

Edit the parameters of that tree-item.

Add a Part to the project. The settings of the default part are used.
Add an Operation to that part. The settings of the first  default operation are
used.  There  are  Add  options  for  a  3D  Operation,  a  2D  Operation  and  a
Bitmap Operation.
Copy  an operation or a part will add an item that is  identical  to the current
one.

Remove a Part from the project.  This is only possible when there will  be at
least one part left after it has been removed.
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Remove an Operation from that part. This is only possible when there will be
at  least  one  operation  left  in  the  part  where  it  belongs  to  after  it  has  been
removed.

Move  Parts  and  Operations  in  the  Tree  can  be  used  when  the  sequence  is
important (for instance first roughing, then finishing).

The other options in the context menu will be self explaining.

3.3.6 NC Files list

The NC files window shows a list of NC program files that have been saved
for this project. For each file name, location and time are listed. This may be
easy for you to manage NC files for this project.

By right-clicking on any line in this window you can open a Context menu,
offering  options  to  remove  or  delete  the  file,  and  also  to  send  it  to  the
machine (only in case that option has been configured).

The  Window  can  made  visible  or  invisible  by  checking  or  unchecking  the
option NC Files list in the View menu. This same effect can be achieved by
pressing the  black arrow button in the title bar of this window. Note that the
NC  Files  window  can  only  be  visible  when  the  Project  Tree  Window  is
visible too.

3.3.7 Thumbwheels

The Thumb-wheels that are drawn in the border of the View window offer
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an  easy  way to  change the camera  position.  You can  use  them by  pressing
the  left  mouse  button  with  the  cursor  on  the  wheel  and  then  moving  the
mouse,  keeping  the  left  button  pressed.  The  cursor  will  become  arrow-
shaped to guide you. Do look at the small green axis cube (the Orientator)
in the left-bottom corner  of the view to help you when rotating.  The three
red  thumb-wheels  control  the  rotation  (three  axes),  the  two  yellow  wheels
control  the  pan  (horizontal  and  vertical  movement),  and  the  blue  one
controls the zoom.
The Thumb-wheels can be switched on and off in the View menu.

Note  that  these  rotations  only  change  the  viewing  angle  (camera  position),
not the orientation of the part in space.
You  can  make  the  thumb-wheels  visible  and  invisible  using  the  Thumb-
wheels command in the View menu.

3.3.8 Layout dialog

The  View  menu  command  Layout...  displays  the  Views  Layout  dialog  in
which  you  can  change  the  layout  of  the  views  in  which  the  geometry  is
drawn. You can view either 1, 2, 3 or 4 views at the same time.

Shortcuts:

Toolbar:

In this dialog you can change the Layout of the View Window: the way it is
filled with Views. It is possible to show 1, 2, 3 or 4 Views at the same time,
as shown in the dialog.  Each of these Views can have different  settings for
Viewpoint  and  Subjects  in  view.  All  these  settings  will  be  stored  in  the
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project file.

The  two  layouts  at  the  right  automatically  set  the  viewpoint  for  all  views.
Those are the ones with the characters T, F, R and the term DEF, where ‘T’
stands for Top view, ‘F’ stands for Front view, ‘R’ stands for Right view and
‘DEF’. stands for Default view.
Such  a  layout  is  very  handy  to  get  a  quick  impression  of  what  a  new
geometry looks like.

Note:
In a Layout with  more  than  one  view,  one  of  the  views  will  be  the  current
(active)  view.  You  can  make  a  view  current  by  clicking  your  left  mouse-
button  inside  the  view:  do  observe  the  blue  line  that  appears  around  the
active  view.  The  thumb-wheels,  view  buttons  and  view  commands  apply
only on the current view.

3.3.9 Subjects dialog

The View menu command Subjects... displays the Subjects in View dialog,
in which you can change what  is  and what  is  not  shown in the active view
(the Scene). In case none of the boxes is checked the View Window will be
blank. You can also select which operations should be visible.

Shortcuts

Toolbar:
Mouse: Right-click  in  a  View,  and  select  the  Subjects  item in  the  shown
context-menu.

It is even quicker to just double-click inside a View.
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The Title will be displayed on the screen and on the printed view, in the top
left corner of the View.

The  View Orientator  is  the coordinate system icon (green cube with axes)
displayed in the bottom left corner of each view. It helps you to understand
from which direction you are looking at the geometry. This green cube does
NOT indicate the zero point.

The Working Area can be drawn, which is the working area of the machine
selected for this part. Of course DeskProto does not know where you will set
the workpiece zero point, so it will draw the part exactly in the middle of the
working  area.  This  will  give  a  good  indication  how  the  part  relates  to  the
machine.  The  working  area  for  your  machine  can  be  set  in  the  Machine
dialog.

The second group shows the Geometry-related subjects:

In  a  Rendered  geometry  drawing  all  triangles  of
the geometry definition are made "solid" with color.
This is  the  default  Subject  in  View as  this  offers  a
good understanding of your geometry.

The sub-option Show downward faces  will  assign
a  different  color  to   any  triangles  that  are  facing
down  (of  which  the  normal  has  a  negative  Z-
component).  This  option  makes  it  very  easy  to
check  for  Undercuts,  and  to  optimally  rotate  your
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geometry to reduce undercuts.
In  a  Wireframe  geometry  the  triangles  are  drawn
with lines.
it  is  possible  that  you  can’t  see  the  geometry  very
well because all the lines are confusing.

In such case the option remove Hidden lines can be
useful.  This  removes  the  lines  of  triangles  that  are
 hidden (obscured by other triangles).

In a Points geometry only the three vertices (corner
points) of each triangle are  drawn.  Of  course these
are only visible in case Wireframe geometry has not
been selected.

The  Segment  shows  the  rectangular  bounding  box
of  the  part  in  light  brown lines.  This  is  in  fact  the
block  of  material  that  is  needed  to  machine  your
part. Note that often only the green lines of the sub-
segment  will  be  visible,  when  both  segments  are
equal.

The sub-option Translucent  draws the sides of the
segment in a translucent color (for the Part segment
in brown).  This will  show the segment  block more
clearly,  maintaining  visibility  of  the  geometry
inside.

 
A second Orientator is available at request, drawn exactly at the workpiece
zero point  (a  blue  cube).  The position of  the  Workpiece  zero  point  can  be
changed using the Translation options of the Part Parameters. Note that the
small red arrow on the screen is NOT the zero point: the arrows indicate the
first point and the last point of the toolpath.

The  selection  of  checked  subjects  in  the  third  group  may  be  different  per
Operation.   It  is  for  instance  possible  to  show  the  toolpaths  of  Operation
Roughing and not show them for Operation Finishing, while both operations
are visible.

In the list of Operations you can change the  visibility of each Operation by
clicking on the lamp icons. Yellow (lamp on) means visible, gray (lamp off)
means invisible. A red lamp indicates an error status for that Operation. This
is an alternative for clicking the lamp icons in the Project Tree.
In the list you can also Select one or more Operations: making the line blue
(meaning selected) by clicking on it. Two or more operations can be selected
by  keeping  the  Control  or  the  Shift  button  depressed  when  clicking.  The
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Subjects that you will check and uncheck for the Operations, apply ONLY to
the selected operations.
When you have selected two operations and some subject is checked for one
and not checked for the other, the checkbox will show a square instead of a
V, like in the illustration above for the Toolpaths.

2D  Contours  concern  the  2D  drawing(s)  that  are
used in 2D Operations. This option is available only
when one or more 2D Operations are selected.

Bitmaps  concern  the  Bitmap  drawing(s)  that  are
used in Bitmap Operations. This option is available
only  when  one  or  more   Bitmap  Operations  are
selected. For large bitmaps DeskProto will display a
simplified  version  (256x256  pixels)  of  the  bitmap,
in order to speed up drawing. 

When you check the Z-Grids checkbox the Z-grids
of the visible operations will be shown. The Z-grid
is  an  intermediate  representation  of  the  geometry
that  DeskProto  uses  for  it's  toolpath  calculations.
The Z-grid will be drawn in lines.
The same subject will be show for option Rendered
Z-Grids.  Now  the  Z-grid  is  drawn  as  a  rendering,
so  you  can  clearly  see  that  it  is  a  3D  bar  graph
representation of the geometry.

When  you  check  the  Toolpaths  checkbox  the
Toolpaths  of  the  visible  operations  will  be  shown.
The toolpath that is drawn is the same toolpath that
will  be  sent  to  the  machine:  if  there  are  any
problems it should be possible to detect them now.
The  sub-options  Show  points  will  draw  a  small
sphere  on  each point  in  the  toolpath,  so  at  the  end
of each (linear) movement.
When  you  check  the  Simulations  checkbox  the
Simulations of the visible operations will be shown.
You  can  clearly  see  what  the  resulting  model  will
look like.

When  checked  a  Sub-segment  will  be  shown:  the
rectangular  bounding  box  of  the  operation  in  light
green lines. The sub-option Translucent  draws the
sides  of  the  segment  in  a  translucent  green  color.
This  will  show  the  segment  block  more  clearly,
maintaining visibility of the geometry inside.
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The  colors  that  are  used  for  the  various  subjects  in  the  example  drawings
above are the DeskProto default colors. These can be changed in the Colors
tab of the DeskProto Preferences.
For  all  line  drawings  default  fog  may  be  applied  to  simulate  depth,  which
can be set on the same location.

3.3.10 Viewpoint submenu commands

The View -> Viewpoint submenu offers the following commands to set  the
Viewpoint:

Top / Front / Right / Bottom / Back / Left  to set one of the six main views.
Isometric / Use default  to set the Isometric or the Default view.
Previous to return to the previous View settings.
Custom will open the Viewpoint dialog.

The same functions can be accessed more easily using the Toolbar buttons.
Note  that  the  Viewpoint  can  also  be  set  using  the  Thumb-wheels  or  the
Mouse functions.

3.3.11 Viewpoint dialog

The View menu command Viewpoint   ->Custom...  displays  the  Viewpoint
dialog,  in which you can change the settings of  the  active  view,  that  is  the
rotation,  panning  and  zooming  settings.  In  fact  this  is  setting  the  Camera
position.
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Shortcuts:

Toolbar:
Mouse: Right-click in a view, and select the Viewpoint item in the shown
context-menu.

In this dialog you can change the point of view from which you look at the
geometry,  z-grid,  toolpath  etc.  You  can  set  the  values  exactly,  using  the
keyboard. The rotations are executed in the order X, Y, Z. The effect is the
same  as  when  using  mouse  rotation,  pan  and  zoom  or  when  using  the
thumbwheels.

Note:
These  values  do  not  change the way the  geometry  will  be  milled  (only  the
Camera position). To change those settings you should go to the Transform
tab page of the Part Parameters dialog.
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3.3.12 Zoom submenu commands

The View -> Zoom submenu offers the following commands:

Zoom In and Zoom out both change the zooming factor with 15 %.
Zoom All sets the zooming factor to 100 % to completely show the subjects.
Custom... will open the Viewpoint dialog, as the zooming factor is one of the
Viewpoint settings.

The  latter  two  functions  can  be  accessed  more  easily  using  the  Toolbar
buttons.
Note  that  the  Zoom can  also  be  set  using the Thumb-wheels  or  the  Mouse
functions.

3.3.13 Mouse Function submenu commands

This command determines the functionality offered by the left mouse button
inside  the  View  Window.  Four  different  functions  are  possible,  of  which
always exactly one is active (the four functions are toggled). In the Toolbar
you  can  quickly  see  which  function  is  active  as  that  button  is  drawn
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depressed.

Rotation:  use  the  mouse  (move  it  inside  the  graphics  view  with  the  left
mouse button pressed) to rotate your geometry.  Imagine that the geometry is
inside a large hollow glass sphere: with your mouse you can grab the sphere
anywhere, and rotate it round its center  point,  including the geometry.  This
means that grabbing and moving (say) left in the upper part of the screen has
a  different  result  than  grabbing  and  moving  left  in  the  lower  part  of  the
screen.
Do  note  that  in  fact  the  geometry  is  not  rotated,  but  the  camera  position
(viewpoint) instead. You can see this, as during rotation the Orientator (the
small axis cube at the bottom left of your screen) rotates with the geometry.
If you want to rotate the geometry you should use the rotation option in the
Part Parameters.

Pan: use the mouse to pan your geometry (move it on the screen, left-right,
up-down,  etc).  When  zoomed  in  you  can  use  panning  to  determine  which
part of the geometry to look at.

Zoom: use the mouse to zoom in and out: move the mouse up is  zoom out
(push away), move down is zoom in (pull). The center of the screen remains
directed to the same position.

Zoom Window: use the mouse to zoom into any part of the screen. Click the
left mouse button to define one corner of a bounding box, move the mouse
keeping the button pressed, and release it as you have reached the opposite
corner. The part of the screen inside the bounding box will now be displayed
as large as possible.

Using the first  three functions the geometry is continuously redrawn during
the  mouse  movement.  Depending  on  the  size  of  your  file  and  the  speed  of
both your computer and graphics card, this redrawing will take more or less
time.  In  case  the  redrawing  is  too  slow,  you  can  influence  the  number  of
entities to be continuously redrawn: see Options - Preferences - Advanced.

An alternative for Zoom is rotating the  Mouse wheel. This works no matter
which of  the  above  buttons  is  active.  An alternative  for  Pan  is  moving  the
mouse  with  the  middle  button  (the  wheel)  depressed.  So  when  the  mouse-
function button “Rotation” on the screen is active for the left mouse button,
using  these  alternatives  you  have   Rotate,  Pan  as  well  as  Zoom  easily
available without having to press any button.

Note  that  you  can  also  use  the  red,  yellow and  blue  Thumb-wheels  on  the
border of the graphics screen.
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3.4 Parameters Menu

The parameters menu offers access to all milling parameters. The three main
levels  Project,  Part  and  Operation  follow  the  structure  of  the  Project  Tree:
one Project can contain one or more Parts (for instance a left half and a right
half),  and  each  Part  can  contain  one  or  more  Operations  (for  instance  for
roughing, finishing and detailing). Operations can be one of three types: the
standard 3D Operation, the 2D Operation and the Bitmap Operation.

3.4.1 Project Parameters dialog

The  Project  parameters  are  divided  into  2  sections  by  Tab  pages,  both  of
which will be described below.

Do note that the Project Parameters dialog has an extra button: Apply. Using
this  button  you  can  apply  any  new  setting  immediately,  without  having  to
first  close  the  dialog.  Any  changes  will  be  immediately  reflected  in  the
drawing on screen and in the Geometry information dialog.

This dialog can be reached via the Parameters menu, first option.

Shortcuts:
You can double-click on the project-item in the project  tree (the  base  level
item).
Or  right-click  on  the  project-item  and  select  Project  Parameters  in  the
context-menu.

This same dialog is used for the Default Project parameters.
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General parameters

File
The project field (Filepath) shows the path and name of the currently loaded
Project  file.  This  information  cannot  be  changed  in  this  dialog.  To  start  a
new project or to save the project using a different name, see the File menu.

Geometry
The  geometry  field  contains  the  path  and  the  name  of  the  Geometry  file
being  used  in  this  project.  You  can  change  the  geometry  by  pressing  the
Browse  button  at  the  right  of  the  geometry  field.  When  changing  the
geometry within an existing project, all Parts and Operations will remain the
same; they will not automatically be reset or adjusted to the new geometry.
For  starting  with  new geometry  it  is  therefore  better  to  start  a  new  project.
The  button  Reload  can  be  used  to  again  import  the  file  if  it  has  been
changed.

Skip Backfaces
For heavy calculations you may want to check the option Skip Backfaces in
order to save calculation time.  This option will  skip all  facets  (triangles)  of
which the invisible inside (the backface) is on top as seen from the positive
Z-direction.  This  means  that  half  of  the  triangles  can  be  skipped,  which
results  in shorter  calculation time.  The resulting toolpath is  the same (for  a
valid  geometry).  As  the  difference  in  calculation  time  is  not  very  large  the
option is no longer checked by default.
For corrupt geometries you may need to disable this function.

Flip Normals
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In DeskProto for each facet (triangle)  a  normal vector is  stored,  indicating
which  side  of  the  facet  is  on  the  outside  of  the  geometry  (also  see  the
previous  paragraph,  on  Backfaces).  This  information  is  stored  in  the  STL
file.  When using a corrupt  STL file  this  information  can  be  wrong.  In  case
ALL  normal-vectors  point  to  the  inside  of  the  geometry  you  can  use  this
option  Flip  normals  to  correct  the  normal  information.  This  option  is
available  only  when  Skip  Backfaces  has  been  checked,  as  otherwise  the
normal direction is not used anyway.

Parts
The number of Parts present in the project can be controlled here, using the
buttons Add, Remove and Copy. Multiple parts can be used in a project to
create different models, for instance a scale model and a full size, or a front
part and a back part. 
You  can  also  influence  the  sequence  of  the  parts,  using  the  two  Move
buttons. The part that is selected (it’s line made blue) will  be moved in the
direction  of  the  arrow.   This  does  not  have  any  effect  an  the  resulting
toolpaths,  it  can be handy in order to neatly arrange your parts  in case you
have many.

Chaining parameters

Chaining is an option meant to combine Operations in different Parts into
one  large  NC  Program  file.  Operations  in  the  same  Part  will  be  combined
into  one  NC  Program  file  anyway,  so  chaining  is  not  needed  then.  This
option  is  used  for  instance  by  the  N-sided  milling  wizard,  for  indexed
machining. 
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Note  that  chaining  is  of  course  only  available  in  case  more  than  one
Operation is present in the current project.
Also note that Chaining is an option for advanced users.

Chaining can be achieved on two different locations in DeskProto:
- in the Start/End commands of the Operation parameters you can chain the
current operation to be followed by a next one. So here you can only see one
element of one Chain.
-  this  Chaining  tab  of  the  Project  parameters  gives  you  an  overview  of  all
Chains in this project, and allows you to edit them.

The button Create adds an empty new chain to the list of chains.

The button Remove deletes the currently selected chain.

The  combo  box  Chain  shows  the  currently  selected  chain  (if  any),  and
makes  it  possible  to  select  other  chains.  Chain  names  are  automatically
generated: Chain 1, Chain 2, etc.

The field Chained Operations shows all operations in the currently selected
chain. You can use the up and down buttons to change the sequence of the
operations in the chain.

The field Unchained Operations shows all operations in the project that are
not  (yet) part  of a chain.  You can use the left  and right  arrow buttons  to
move  unchained  operations  to  a  chain  and  to  remove  operations  from  the
selected chain.

Note  that  in  the  Operation  Start/End  commands  you  can  also  add  extra
commands to be executed in-between the two chained operations: either after
the first Operation or before the subsequent operation.

3.4.2 Part parameters command

This  Parameters  menu  command  displays  the  Part  Parameters  dialog  in
which you can edit the parameters of a Part.

In  case  a  Project  has  more  than  one  Part,  first  a  dialog  will  be  shown  in
which you can select the part you want to edit.
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The part you select here will also become the current Part, and thus will be
displayed when you have finished editing.

Shortcuts
Double-click  on  a  part-item  in  the  project  tree  (one  of  the  second  level
items).
Or right-click on a part-item and select Part Parameters in the context-menu.

3.4.3 Part Parameters dialog

The  Part  parameters  are  divided  into  6  sections  by  Tab  pages.  The
parameters are applied to the geometry in the sequence as presented by the
Tab  pages,  from  left  to  right.  Also:  the  further  to  the  right,  the  more
advanced the parameters in the tab. 
In  the  Entry  Edition  only  the  first  two  Tab  pages  are  available,  as  it  does
offer  less  parameters  than  the  other  editions.  The  second  Tab  page  also  is
different in the Entry edition.
In the other editions less Tab pages are present when only 2D operations or
Bitmap  operations  are  present,  as  then  these  extra  Part  settings  cannot  be
applied anyway.

Do  note  that  the  Part  Parameters  dialog  has  an  extra  button:  Apply.  Using
this  button  you  can  apply  any  new  setting  immediately,  without  having  to
first  close  the  dialog.  Any  changes  will  be  immediately  reflected  in  the
drawing on screen and in the Geometry information dialog.

This dialog can be reached via the Parameters menu, second option.

Shortcuts: 
You can  double-click  on  a  part-item  in  the  project  tree  (one  of  the  second
level items).
Or right-click on a part-item and select Part Parameters in the context-menu.
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This same dialog is used for the Default Part parameters, only with an extra
button Restore DeskProto defaults to reset the original default parameters.

General parameters

Name
The name of the  part can be changed here. Use a meaningful name to easily
remember  the  purpose  of  each  specific  part:  the  Project  Tree  then  will  be
easy  to  interpret  in  case  of  more  than  one  part.  This  name  is  for  your
convenience only: it is not used in the resulting NC program file.

Machine
This  refers  to  the  machine  you  want  to  use.  DeskProto  uses  the  machine
information to check whether the prototype is not too large for the machine,
and to check whether the milling parameters (speeds) that you will enter are
possible  for  this  machine.  The  selected  machine  also  defines  the  format  of
the  NC  Program  file,  because  the  machine  information  states  which
postprocessor (driver) to use. You can have a look at the machine-definition
using the option Library of machines in the Options menu.

Normally you do not have to bother with this parameter as your machine will
be the default machine. If not, you can change the default machine using the
option Default Part Parameters in the Options menu.
Note:  when you change the selected machine  DeskProto  will  automatically
change values for Feedrate and Spindle speed, as the new machine may not
be capable of outputting the old values.

Use rotation-axis
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A  rotation  axis  is  a  device  on  the  machine  that  rotates  the  part  during
machining.  Like  a  piece  of  meat  on  a  spit  above  the  barbecue.  DeskProto
supports a rotation axis  parallel  to the X-axis,  which is  officially  known as
an A-axis. Note that the difference between an A-axis and a lathe: on a lathe
the spinning of the part causes the cutting, on a rotation axis the spinning of
the tool.  DeskProto supports continuous rotation during machining.

This  option  is  only  available  in  case  a  machine  has  been  selected  that
supports a rotation axis, as defined in the Library of machines   This option
is  only  available  in  the  Multi-Axis  edition  of  DeskProto.  If  this  box  is  not
checked  DeskProto  ignores  the  rotation  axis  and  generates  standard  XYZ
toolpaths.  If  it  is  checked,  DeskProto will  generate  XAZ toolpaths  instead,
so  the  Y-travel  (in  linear  units)  for  each tool-position is  replaced  by  an  A-
value (in degrees).  In the View Window the difference will  be immediately
visible,  as  the  segment  no  longer  is  a  rectangular  block,  but  a  cylinder
instead. 

When you check “Use Rotation axis”, DeskProto will automatically:
· set the  Segment  to  “Use  upper  half  of  geometry”,  in  order  not  to  let  the

tool sink below the rotation axis.
· set the Translation to "None" for the Z-axis (resulting in a Workpiece zero

point exactly on the rotation axis)
· set  the  Borders  to  "No  extra"  for  all  operations  in  that  part  (as  the  part

must not be cut loose of the rotation axis)
· if needed change the Z-values for black and white in the Bitmap settings.
· change the default setting for the Support Blocks.

You are free to change these choices later in case needed.
The  message  box  shown  above  will  remind  you  of  these  changes,  you  can
switch it  off  when no longer needed (not  yet possible  to reset that  choice -
unless by editing the Windows Registry)
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Do  note  that  some  users  prefer  a  different  Translation  setting:  with  the
WorkPiece  zero  point  (Y=0,  Z=0)  on  the  top  of  the  cylinder  block  (Z
Translation “Top of block”). 

Use rotation axis tilt option
This option concerns a special  type of fifth axis:  a  mechanism that  tilts  the
complete  rotation  axis  unit.  Such  fifth  axis  as  present  on   some  machines
offered by Roland (JWX-10, MDX-40), and is meant to machine the inside
of a ring. In fact  this is  a B-axis.  Note that DeskProto does not  control  the
movement of this axis: it has to be manually set. For more information and a
picture  see  the  5th  axis  tab  of  the  Operation  Parameters.  This  tab  page  is
present only if this tilt option is checked.

This  option  is  only  available  in  case  a  machine  has  been  selected  that
supports this "Fourth axis tilt option", at least in case the machine-definition
in the Library of machines does so.  This option also is available only in the
DeskProto  Multi-Axis  edition.  If  this  box  is  not  checked  DeskProto  will
ignores the tilt option and generates standard toolpaths. 

Operations
The  number  of  operations  within  the  part  can  be  changed  by  adding,
removing or copying operations, using the buttons Add, Copy and Remove.
As three different  types of Operation are present (3D, 2D and Bitmap),  the
Add button comes in three flavors. First select the type of operation using the
black arrow button, next press the resulting button to add the Operation you
need.
When more than one operation is  needed to create a part  (for  instance  first
roughing  with  a  large  cutter  and  then  finishing  with  a  smaller  one)  the
sequence of the operations is important. Using the Move arrow buttons you
can change the sequence of the operations.

Apply
The extra Apply button makes it possible to immediately see the result of any
changes,  without  first  having  to  close  the  Part  parameters  dialog.  Using
Apply  also  immediately  affects  the  values  in  the  Geometry  Information
dialog, making it very easy to for instance scale your part until it has certain
required dimensions.
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Transform parameters

The  availability  and  the  contents  of  options  4  and  5  on  this  tab  page  will
differ per edition of DeskProto (Entry, Expert, Multi-Axis).
Note that the order in which the transformations are applied does matter for
the result, which is why they are numbered in the dialog.

1. Scale
Scaling is the first transformation that is applied to the original geometry. It
is possible to scale differently for X, Y and Z, by un-checking the Uniform
option.  The imported  geometry  file  does  not  contain  information  about  the
units  used.  DeskProto assumes  the unit  used in  the  geometry  file  to  be  the
same as set  in  the  Preferences  dialog.  If  this  is  not  true  it  can  be  corrected
using the scale factor. 
Enter  a  scale  factor  of  25.4  to  use  a  geometry  file  created  in  inches  in  a
DeskProto that is configured to use metric units.
Enter  a  scale  factor  of  0.03937  to  use  a  geometry  file  created  in  mm  in  a
DeskProto that is configured to use inches.

2. Mirror
The mirror option is  the  second transformation applied.  It  is  only  useful  to
mirror  in  one  direction,  as  mirroring  in  two  directions  is  identical  to  one
rotation.  Mirroring  in  three  directions  can  be  achieved by  mirroring in  one
direction plus a rotation.  The mirror option can be useful  when you have a
geometry that is one half of a prototype.  By mirroring the geometry for the
second part you can produce two parts that will exactly fit together.

3. Rotation
The  rotate  option  is  the  third  transformation  applied.  Note  the  difference
between  this  rotation  (which  changes  the  geometry)  and  the  view  rotation
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(which only changes the viewpoint / the camera position). Both rotations use
identical values, so you can use the  Viewpoint to find the rotation you need,
and then use these X, Y, Z rotation values to enter here.
Note that when a custom Segment is present (rectangular) only for rotations
over  (multiples  of)  90  degrees  the  segment  can  remain  correct.  For  other
angles the segment boundaries will be changed. For Freeform segments only
rotations over (multiples of) 180 degrees are possible, other rotations are not
permitted

4. Inverse milling
The inverse milling option useful  for  producing  a  mold:  a  cavity  in  a  solid
block  of  material  that  exactly  fits  your  geometry.  In  many  cases  it  will  be
easier  to  create  an  inverse  geometry  using  the  original  CAD  system.
However, this option comes in useful in case you only have the STL file, not
the original CAD data.

Inverse  milling  is  not  the  same  as  mirroring  the  Z-axis.  A  mold  that  is
created by mirroring would produce mirror images of the original geometry.
Instead  DeskProto uses  a  180 degree  rotation  to  create  the  inverse.  As  this
inverting  is  applied  during  toolpath  calculations,  the  STL  geometry  on  the
DeskProto screen is not inverted. To get an idea of what you are machining
you can display the rendered Z-grid instead.

Note  1:  when  selecting  this  option,  in  most  cases  it  is  necessary  also  to
change the Ambient and set it to 'Top level'.
Note  2:  when  this  option  is  checked,  setting  the  Z-values  for  the  Segment
still is done in un-inverted coordinates.
Inverse milling is not available in the DeskProto Entry edition.

5. Center geometry
In  DeskProto  all  Translations  are  applied  at  the  end  of  the  calculation
pipeline, after calculating the actual toolpaths. For rotation axis milling this
is not sufficient, as the position of the geometry during calculation influences
the toolpaths that will result. 
By  default,  so  when  you  do  not  check  this  option,  during  rotation  axis
machining DeskProto will rotate the geometry around the X-axis as defined
in the CAD system.
When you do check this option, DeskProto will rotate around a line parallel
to  the  X-axis,  on  a  YZ  position  in  the  center  of  the  part.  You  can
immediately see the difference as this influences the size of the cylindrically-
shaped segment:  fitting the geometry  if  checked,  too  large  if  not  (unless  of
course Y=0 Z=0 is already in the center of the part). 
When you need any other position of the rotation axis you have to go back to
the CAD system and translate the geometry there.

All  three  axes  X,  Y  and  Z  will  be  centered  prior  to  the  calculations.  In
addition  to  this  option  you  can  still  use  the  Translation  options  for  a
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translation  to  be  applied  just  before  saving  the  toolpaths  file.  For  rotation
axis machining you then can choose between a workpiece zero point on the
rotation axis or on the top of the cylinder block (Z=0 level).

This option is for instance applied when using the N-sided milling wizard.

Bottom level
This parameter is only available in the DeskProto Entry Edition, and replaces
the (more advanced) segmentation options in the full version. 
DeskProto  will  use  a  rectangular  block  as  the  volume  it  needs  to  machine,
being  exactly  the  bounding  box  around  the  geometry.  In  the  Entry  edition
you  cannot  influence  this  block  to  be  machined,  however  you  can  choose
how deep the cutter may go.  For instance for a sphere it does not make sense
to  machine  the  lowest  half,  as  the  cutter  cannot  reach  that  part  of  the
geometry.  Instead  you  will  machine  two  halves  and  later  connect  these  to
become one model. The bottom level can be used to determine which part of
the  geometry  has  to  be  machined.  In  many  cases  (like  the  sphere)  you  can
use  the  preset  option  that  sets  the  bottom  level  exactly  halfway  down  the
part. When you select a Custom level you have to enter a Z value in the Edit
box.

Support parameters

Support blocks (also called bridges, or tabs) can be added to the geometry to
facilitate  machining  a  model  from  several  sides.  These  are  small  blocks  of
material (cylinder or  rectangular),  acting as connection bridges to hold the
model in place within a frame (that has to be larger than the model). 

Each support block is created by loading an STL file from folder C:\Program
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Files\DeskProto 6.1\Supports\
the triangle from this STL file will be scaled and rotated as needed, and will
then  be  added  to  the  geometry  and  be  handled  by  DeskProto  just  like  any
other geometry detail.

For  more  information  also  see  the  help  pages  for  the  Two  Sided  Milling
Wizard, which show the use of support blocks including some illustrations.
Support blocks may be useful in other situations too, for instance a left and a
right bridge for fixturing your model on a rotation axis device.

Four options are available:
· Do not use support blocks, which is the default and will be OK for most

parts.
· Use  Default  support  blocks:  DeskProto  will  locate  these  blocks  at  the

extreme points of the geometry (min and max X, min and max Y, applied
after the rotation), and create blocks of a reasonable size. For normal XYZ
machining  four  rectangular  blocks  are  generated,  for  rotation  axis
machining two cylinder shape blocks.

· When the default  blocks  do  not  satisfy,  you can  choose  to  create  one  to
four  Custom  blocks.  For  each  of  the  four  bridges  you  can  then  check
whether or not to use them, and for each checked bridge you can specify
location and dimensions graphically, using the Edit button. This will open
the  Edit  support  bridge  dialog,  where  you  can  also  set  the  shape  of  the
block.

· Use  bridges  of  first  part  is  very  convenient  when  several  parts  use  the
same support blocks. Define these support blocks only once (for the first
part), and use that same definition in all other parts. In that case also any
changes need to be made only once.

When using support blocks to connect the part to the remaining frame, you
need  to  switch  off  the  borders  in  each  of  the  operations  used  for  this  part
(Operation  parameters,  Tab  page  Borders).  If  not  DeskProto  will  cut  the
outside surface of each block as well, cutting it loose from the frame.
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Segment parameters

The Part-Segment is in fact the block of material to be used (the stock). It is
by  definition  a  rectangular  volume,  bounded  by  Min  and  Max  values  for
each  of  the  three  axes.  Only  the  geometry  inside  this  segment  will  be
processed  during  the  milling  calculations,  the  rest  will  be  removed  when
machining.  As  you  can  see  in  the  icon  pictures,  the  bounding  box  of  the
segment will be drawn in light brown lines (the green lines that you may see
are  for  the  Operation  sub-segment).  At  this  tab  page  you  can  set  the  Part
segment.
Note  that  the  Min  and  Max  A-values  are  available  only  in  case  you  use  a
Rotation axis.

Use the part segment to machine only a part of your geometry. For instance
in  case  your  three  axis  milling  machine  cannot  machine  the  complete
prototype: you can then use segmentation to machine two separate halves. Or
because the model is too large for your machine: use segmentation to split it
up into parts that do fit. 

Three options are given to set the segment boundaries:
· Use whole geometry is the default: the segment will be the bounding box:

exactly  fit  the  total  geometry.  Use  this  if  you  want  to  make  a  prototype
that consists of one part only.

· Use  upper  half  of  geometry  can  be  very  useful  when  you  have  a
symmetrical geometry, that can be machined in two parts.

· Custom. If you want to make your prototype by making parts that are not
exactly  half  the  geometry,  you  can  exactly  define  the  segment  of  the
geometry for a specific part. In that case you can either enter the segment
dimensions by typing the appropriate minimum and maximum values,  or



Menu and commands

Page 75

DeskProto Reference

use the button Set Graphically. You can always reset the values by again
selecting 'Use whole geometry'. Note that the min and man values for the
A-axis are in degrees instead of in mm or inches.

If  you  want  you  can  enter  the  values  for  the  segment  in  Translated
coordinates.  When  you  have  checked  this  checkbox  the  minimum  and
maximum  values  of  the  segment  (the  segment  boundaries)  position  are
displayed  in  the  coordinates  as  used  on  the  machine  (after  Translation  has
been applied).
This checkbox also applies to the graphical settings option.
Note:
Checking or unchecking this checkbox does not influence the position on the
machine. It’s just a temporary conversion on screen for setting the segment
more easily.

The button Set graphically  pops up a dialog that makes it  very easy  to  set
any segment  using the mouse. This  Set  segment  graphically dialog will  be
explained on a separate page.

Note:
You  can  also  use  the  part  segment  to  make  your  part  larger,  adding  some
more  ambient  area  to  be  milled around your  model.  This  can  be  handy  for
instance if your  block of material is too large.

Note: 
This larger block trick applies to the Z-direction as well.  you can make the
segment higher than the geometry, in order to prevent the tool from sinking
too  deep  in  a  block  of  material  that  is  too  thick  for  the  part.  See  the
illustration above.

You  can  also  use  the  segment  to  build  a  large  model  from  separately
machined slabs of material. For instance produce a model of 140 mm high,
milling three separate slabs of standard tooling board blocks of 50 mm thick,
using  three  segments  to  define  these  parts:  part  0-50  mm,  part  50-100  and
part 100-140 mm.
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Note: 
In  case  Inverse  milling  (male  to  female)  is  applied,  then  the  segments
boundaries  entered  here  are  applied  on  the  original  geometry,  before  the
male to female conversion.

Ambient parameters

As  DeskProto  always  creates  toolpaths  for  a  rectangular  area,  and  as  most
prototypes do not have a rectangular geometry, in most cases some area will
be  present  without  geometry.  This  is  called  the  ambient  area.  Or  in  other
words, the area where no geometry is present, seen from the top. On this tab
page you can specify the level (or height) at which the ambient area should
be milled.

· The default choice is Equal to the bottom of the part segment, so at the
minimum  Z-level  of  the  geometry  to  be  milled.  This  will  do  for  most
cases, as then all material around the model will be removed. When using
this option, for ball nose cutters the actual Z-level will be R (radius of the
cutter)  lower  than  the  bottom  of  the  segment  to  make  vertical  walls
possible.

· You can also set the ambient level Equal to the top of the part segment.
This  will  be  useful  when  you  want  to  make  a  mould  by  using  inverse
milling.

· You can also specify the ambient level yourself with the option Custom,
after which a Z-value has to be entered in the Z edit box.
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Translate parameters

As a final part parameter DeskProto will apply an (automatic) translation to
your  geometry.   Although  you  can  see  translation  as  a  form  of
transformation, it’s not placed in the transformation tab page. In DeskProto
the translation is  applied after  all  actual  calculations,  just  before  saving  the
toolpaths to an NC-program.

Translation is in fact the method that DeskProto offers to set the WorkPiece
zero point for your NC programs. Do note that the  Subjects dialog offers an
option to draw an Orientator on the workpiece zero point for visual feedback
on your Translation settings.

Default  translation  is  option  1  for   X,  Y  and  Z,  making  the  front-left-top
corner  of  the  block  the  Workpiece  zero  point.  This  is  customary  for  CNC
milling and very handy: the zero position will now be with the tip of the tool
touching the top of the material, at the front-left corner of the block. So all X
and  Y  positions  of  the  geometry  will  be  positive  (starting  at  0),  and  all  Z
positions will be negative (starting at 0 as well).

Separate  settings  are  possible  for  X,  for  Y  and  for  Z.  For  each  axis  three
predefined  translation  options  are  available  (in  which  DeskProto  will
calculate the actual translation values for you, shown in the edit boxes), plus
the options None and Custom. 

XY:
-  You  can  translate  the  (transformed)  geometry  in  a  way  that  all  geometry
points have positive X & Y values for part-geometry:  the X- and Y-values
of  the  part  start  at  zero  and go  up.  This  option  is  the  most  convenient  one
because it will be easy to set the zero-position on the machine.
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-  You  can  translate  the  (transformed)  geometry  in  a  way  that  all  cutter
positions  (or  toolpath  coordinates)  have  positive  X  & Y values  for  cutter
positions. This option is useful in case the machine can handle only positive
X & Y coordinates (for example the small Roland Modela MDX 15 and 20).
-  The  third  preset  option  is  Make  center  of  part  zero:  the  workpiece  zero
point will then be exactly in the middle of the part geometry for X and Y.
- None means that no translation is applied. The zero-position of the CAD-
geometry will correspond with the work-piece zero-point on the machine.
- Custom makes it possible to use any own defined translation, to be entered
in  the  two  edit  boxes.  The  value  that  you  enter  is  the  translation  between
CAD coordinates and workpiece coordinates.  The edit  boxes also show the
actual translation for any of the other options.

Z:
- You can translate the (transformed) geometry in a way that all points have
negative Z-values. So the Top of the part is zero, and Z-values start at zero
going down into negative. This option is the most convenient one because it
will be easy to set the zero-position on the machine.
- The second preset option is Make center of part zero: the workpiece  zero
point will then be exactly in the middle of the part geometry for Z.
- You can translate the (transformed) geometry in a way that all points have
positive Z-values.  So the Bottom of the part is  zero,  and Z-values  start  at
zero  going  up  into  positive.  Main  advantage  of  this  option  is  that  the
workpiece  zero  point  can  be  the  same  for  parts  of  different  sizes.  Do  note
that in case of ballnose cutter the tip of the cutter can still travel below Z=0
now !
- None means that no translation is applied. The zero-position of the CAD-
geometry will correspond with the workpiece  zero point on the machine.
- Custom makes it possible to use any own defined translation, to be entered
in  the  edit  box.  The  value  that  you  enter  is  again  the  translation  between
CAD coordinates and workpiece coordinates.

For Rotation axis machining only the X and Z coordinates can be translated
here. The Y coordinate value can not be translated as the tool does not move
along the Y axis during rotation axis machining. In this case also some of the
Z-options are not available as they would not make sense.

Note:
When  you  have  checked  the  option  Use  rotation  axis  tilt  option  on  the
General tab of the Part parameters,  a different set of Translation options will
be available. See the illustration below.
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As  explained  for  the  5th  axis  settings  (rotation  axis  tilt  option)  of  the
Operation  parameters,  the  X-translation  will  determine  the  location  of  the
part when the 5th axis rotation has been applied. The workpiece zero point
(X=0.0) needs to be exactly on this 5th axis (so on the rotation point).  The
small illustration on the dialog shows that a larger distance between the axis
and  the  part  will  result  in  a  larger  Z-displacement  when  rotating.  So  the
Distance  to  part  segment  must  be  carefully  set  in  order  to  have  the
toolpaths aligned for operations with and without a 5th axis rotation value.

The  Resulting  Translation  will  be  different  from  the  Distance  to  Part
segment, as the zero point of the STL file in most cases is not located on the
left edge of the Part segment.

A Y-axis  translation  is  not  possible  here:  this  tilt  option  is  combined  with
rotation axis (4th axis) toolpaths, where Y-translation is not applicable.

3.4.4 Set Segment graphically

The  Edit  segment  dialog  makes  it  possible  to  graphically  set  the  size  and
position of a (sub)segment. You can reach this dialog by using the button Set
Graphically  on  the  Segment  tab  of  the  Part  parameters  or  Operation
Parameters dialog.
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The dialog shows a new drawing of your part, with a rectangle that indicates
the (sub)segment that you are editing. The buttons on the right can be used
to influence the drawing. Eleven of these are standard DeskProto buttons of
which the use is known, and that need no explanation here. Note that mouse
rotation is not present: this dialog only used the six main views.
The  Cube buttons  on  the second  row are  for  the  choice  between  rendered
view, wireframe view and both views combined.

The two buttons on the third row are new, these are used to graphically set
the  support  block.  Note  that  these  are  “mouse  buttons”  as  well:  of  the  five
mouse buttons only one is active at any time.

This  button  sets  the  mouse  function  to  drag  a  complete  new
rectangle to define the segment.

This button sets the mouse function to resize the current rectangle
by dragging each of the four sides to a new position.

You  can  also  set  the  new  segment  by  entering  minimum  and/or  maximum
values  for  X,  Y and Z  in  the  six  edit  boxes.  The boundaries  of  the  current
part  are  shown  to  assist  you,  so  are  the  coordinate  values  of  the  current
mouse position.
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When you change the segment,  you will  see  that  both  the  old  and the new
block  remain  visible:  the  changes  will  become  effective  after  pressing  the
OK button.

As  a  segment  is  rectangular  and  aligned  with  the  main  axes,  this  resizing
only  makes  sense  in  the  six  main  views  (looking  along  X,  Y  or  Z):  other
viewpoint  positions  are  not  possible  in  this  dialog.  For  each  of  the  main
views of course only two coordinates can be changed: to change the third as
well  you  have  to  select  a  different  main  view  using  one  of  the  six  view
buttons.

3.4.5 Set support block graphically

The Edit support block dialog makes it possible to set the size and position
of  one  support  block  (bridge).  You  can  reach  this  dialog  by  using  an  Edit
button on the Support tab of the Part parameter dialog.

The dialog shows a new drawing of your part, with a rectangle that indicates
the support block that you are editing. The buttons on the right can be used
to influence the drawing. Eleven of these are standard DeskProto buttons of
which the use is known, and that need no explanation here. Note that mouse
rotation is not present: this dialog only used the six main views.
The  Cube buttons  on  the second  row are  for  the  choice  between  rendered
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view, wireframe view and both views combined.

The two buttons on the third row are new, these are used to graphically set
the  support  block.  Note  that  these  are  “mouse  buttons”  as  well:  of  the  five
mouse buttons only one is active at any time.

This  button  sets  the  mouse  function  to  drag  a  complete  new
rectangle to define the support block.

This button sets the mouse function to resize the current rectangle
by dragging each of the four sides to a new position.

Below  the  buttons  you  can  use  the  combo-box  to  select  the  Shape  of  the
support block. 
By default four shapes are available: Block, Cylinder, Cone, Triangle block.
For  the  latter  three  shapes  the  orientation  of  the  support  is  determined  by
which support bridge you are editing: left, right, front or back.

You  can  also  set  the  new  support  block  by  entering  minimum  and/or
maximum values for X, Y and Z in the six edit boxes. The dimensions of the
current segment are shown to assist you, so are the coordinate values of the
current mouse position.

When you change a support block, you will see that both the old and the new
block  remain  visible:  the  changes  will  become  effective  after  pressing  the
OK button.

As a support block is aligned with the main axes,  this resizing only makes
sense  in  the  six  main  views  (looking  along  X,  Y  or  Z):  other  viewpoint
positions are not possible in this dialog. For each of the main views of course
only two coordinates can be changed: to change the third as well you have to
select a different main view using one of the six view buttons.

Note:
In DeskProto V6 it is possible to add your own support block shape.
The base support blocks are present as STL files in files in C:\Program Files
\DeskProto 6.1\Supports\
You can add any STL file here, and use this geometry as a support block. For
instance a special shape that matches a fixture that you have made.
Important is that the geometry in this STL file must be sized that is exactly
fits inside a cube of 1 by 1 by 1 mm: only then the dimensions that you will
set  in  this  dialog  will  be  set  correctly   (internally  DeskProto  creates  the
support by copying, scaling and rotating the base support block as defined in
this file).

For software specialists: 
you can set the location of this supports directory in the registry, at
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HKEY_CURRENT_USER\Software\Delft  Spline  Systems\DeskProto\6.1
\Preferences\File Locations\SupportsLocation
Do not change this unless you are sure what you are doing.

3.4.6 Operation parameters command

This Parameters menu command displays the Operation Parameters dialog in
which you can edit the parameters of an Operation.
Operations  can  be  either  3D  Operations  ,  2D  Operations  or  Bitmap
Operations.

In case a Part has more than one Operation, first  a  dialog will  be shown in
which you can select the operation you want to edit. 

Shortcuts
Double-click on an operation-item in the project tree (one of the third level
items).
Or  right-click  on  a  operation-item  and  select  Operation  Parameters  in  the
context-menu.

3.4.7 Operation Parameters dialog

The  operation  parameters  are  divided  into  8  sections  by  tab  pages.  The
further to the right, the more advanced the parameters in the tab. In the Entry
edition  of  DeskProto  only  the  first  and  the  third  Tab  page  are  available,
offering less parameters  than the Expert  and Multi-Axis  editions.  Note  that
DeskProto includes three different types of Operations. This dialog is for the
(default) 3D Operation, in addition also dialogs for a 2D Operation and for a
Bitmap Operation are available.
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This dialog can be reached via the Parameters menu, third option.
Or you can double-click on an operation-item in the project tree (one of the
third level items).
Or  right-click  on  an  operation-item and  select  Operation  Parameters  in  the
context-menu.

This same dialog is used for the Default Operation parameters, only with an
extra  button  Restore  DeskProto  defaults  to  reset  the  original  default
parameters.

General parameters

Name
The name of the  operation can be changed; use a meaningful name to easily
remember  the  purpose  of  each  specific  operation.  The  name  is  meant  for
your convenience only, it is not used in the NC program file. It may be used
for the file name though, in case the NC output is in more than one file.

Cutter
You can  select  a  Cutter  from the cutter  library  :  a  list  will  open  when  you
clock on the currently selected cutter. Which cutter is best depends on how
the geometry is shaped. Generally speaking:
- For freeform surfaces use ballnose cutters to reduce the staircase effect.
- For ‘straight/square’ geometries use a flat cutter.
The  larger  the  cutter,  the  smoother  the  resulting  surface  and  the  faster  the
machining. Use small cutters only in case of small details. You can also use a
large  cutter  for  the  complete  part  and  a  small  one  later  for  some  detailed
areas.
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Precision
Here  you  can  enter  the  accuracy  to  be  used.  Two  parameters  are  present:  
Distance  between  the  toolpaths  (also  called  the  Stepover)   and   Stepsize
along  the  toolpath  (each  path  is  built  as  a  large  series  of  movements  or
steps, each being a very small straight line). Normally both distances are set
equal. The smaller the distances, the more accurate the model, however also
proportionally more time will be needed for both calculation and milling.  
In  case  you  have  selected  to  use  the  rotation  axis,  one  of  both  precision
values  should  of  course  be  an  Angle  in  degrees.  Still,  as  this  is  easier  to
imagine, a distance in mm or inch is used. DeskProto will convert this value
to degrees at the outside of the (cylindrical) segment.

An example will  illustrate why this is  called Precision:  in case the distance
between  the  toolpaths  is  set  to  1  mm  and  a  cube  of  10.5  mm  has  to  be
machined, then this is not possible as the resulting cube model will be either
10  or  11  mm  (DeskProto  will  in  fact  make  it  11).  This  inaccuracy  is  a
drawback  of  the  algorithm  that  DeskProto  uses,  and  is  more  than
compensated  for  by  its  advantages  such  as  calculation  speed,  robustness,
ability to work with incomplete/incorrect geometries, and ease of use. In fact
DeskProto has been designed for prototyping, not for production tooling.
The  precision  values  used  will  be  rounded  to  a  value  that  is  calculated  by
dividing  the  diameter  of  the  cutter  by  an  odd  number.  The  8  predefined
values offered by DeskProto do match this formula. You may enter a custom
value  as  well,  which  in  case  it  does  not  match  will  be  rounded  to  a  more
precise  value  that  does  match.  The  reason  to  use  this  rounding  is  that  the
resulting (physical) part will be more accurate, due to the algorithm used by
DeskProto for its calculations. For example: When the diameter of the cutter
(d) is  4.0,  and you enter  a precision value  of  1.0,  it  will  be  rounded  to  0.8
(d/5 = 0.8). The value of 1.0 that you have entered will nevertheless be saved
in the project. So when you later change the cutter, the precision will still be
(close  to)  1.0.  For  advanced  users  some  detail  precision  settings
("subsampling")  are  available  on  the  Strategy  tab  page.  These  will  enable
you to use a precision that is higher than the toolpath distance.
Note 1: 
In this calculation the flute diameter  of the cutter  is  used (so not  the shaft
and not the tip). 
When the Collet collision check is applied in the Advanced parameters, the
diameter of the collet is used.
Note 2: 
Be careful with a Stepsize of D/1 (equal to the cutter Diameter). As the cutter
will move in a straight line to the next calculated position, a large step might
damage  some  in-between  geometry.  This  is  most  likely  in  case  of  vertical
walls, and can be corrected by the option Protect vertical surfaces.
Note 3:
When  a  Skin  is  applied  in  the  Roughing  parameters,  the  diameter  of  the
resulting  virtual  cutter  is  used.  Say  you  use  a  ballnose  cutter  with  a  6  mm
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diameter,  and  a  skin  of  0.5  mm.   Then  DeskProto  will  do  the  calculations
with  a  virtual  cutter  of  7  mm  diameter  (radius  3.0  +  skin  0.5  =  3.5).  This
means  that  the  first  option  in  the  combo-boxes  (drop  down  menu)  for
Precision now will  be "7.0  (d/1)"  As this  is  larger  than  the diameter  of  the
actual cutter, this first option will be grayed out.
For  negative  skin  value  DeskProto  allows  precision  values  that  are  larger
than the virtual cutter.
Same  for  other  cutter  types,  though  then  the  geometry  of  the  virtual  cutter
will be different (sharp corners will be rounded).

Speed
The  Feedrate  is  the  speed  with  which  the  cutter  moves  through  your
material.  The  value  you  enter  here  must  be  between  the  minimum  and
maximum  feedrate  values  permitted  for  the  machine  you  selected  for  the
part.  Do  distinguish  this  speed  from  the  actual  cutting  speed  of  the  tool’s
cutting edge, which is determined by the rotation speed (spindle speed) and
the diameter of the cutter. 
The  unit  used  for  the  Feedrate  are  set  in  the  postprocessor  of  the  machine
that you selected for your part. DeskProto does not check or even understand
these units: it just copies the number that you enter here to the file.

Generally speaking a tougher material will require a lower feedrate. Same for
a  smaller  cutter.  A  very  handy  option  is  to  let  DeskProto  automatically
reduce the Feedrate in high Chipload conditions, on Tab page Movement of
this dialog.

The Spindle speed you use here always uses the unit rpm, which stands for
rotations  per  minute.  The  value  you  enter  here  must  be  between  the
minimum and maximum spindle speed values permitted for the machine you
selected  for  the  part.  The  smaller  the  diameter  of  the  tool,  the  higher  the
spindle speed needed in order to get the same actual cutting speed.

Note: 
It  is  possible  to  check  Automatic  Speed  setting  for  a  cutter  in  the  Cutter
definition.  In  that  case  when  the  cutter  is  chosen  the  Feedrate  and  Spindle
Speed will be set automatically. That is quite useful for very thin cutters that
need a low feedrate and a high spindle speed as otherwise you could forget
to set the correct speeds and break your cutter.
Note:
Each Speed option is only available in case your machine supports it, if not
the option will be grayed out in this dialog. For instance on many machines
the Spindle speed cannot be set from the computer but only using a knob on
the  machine.  This  setting  (so  whether  or  not  this  is  possible  on  your
machine) can be made in the Postprocessor dialog (Options menu).
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Strategy parameters

The eight available Main strategies should be clear from the pictures drawn
in the dialog. Each main strategy (at the left) has its own Detail  settings  at
the right.

Parallel  toolpaths is  the default  strategy: DeskProto will  project  a series  of
parallel toolpaths on the geometry. The toolpath distance is constant (before
projection).
Detail settings for parallel are the following:  Along X-axis means toolpaths
parallel to the X-axis (so on constant Y), and Along Y-axis means toolpaths
parallel to the Y-axis. For each of these two starting point are available: front
versus back and left  versus right.  In addition an Angle  with X-axis  can  be
entered to create toolpaths that are not parallel to X and Y, but still parallel
to one another.

Second  strategy  is  Crosswise.  This  is  the  same  as  creating  two  operations
where one of them uses parallel  to X,  and the other one uses parallel  to Y.
When you would use two operations there would be redundant calculations,
resulting in longer calculation time: hence this strategy. This option is useful
in  case  the  model  you  want  to  produce  must  have  a  very  good  surface
quality:  the  staircase  effect  resulting  from  the  parallel  X  toolpath  will  be
removed by the parallel Y toolpath and vice-versa. 
As Detail setting you can choose which of the two directions has to be done
First, and here as well you can enter an Angle with X-axis.

The  Block  strategy  combines  toolpaths  parallel  to  X  and  Y  to  a  sort  of
rectangular  spiral.  These  are  probably  the  most  efficient  toolpaths,  very



DeskProto Reference

Page 88

suited for roughing. So the wizard will as a default select this strategy for it's
roughing operations.
The Detail settings for block offer two options: inside out versus outside in,
sufficiently explained by the name and the small drawings, and Angle with
X-axis as just described.
The  milling  direction  can  be  set  on  the  page  Movement  tab  of  this  dialog:
Conventional  will  start  left  to  right  along X,  Climb will  start  front  to  back
along Y (for outside-in).
The  last  detail  setting  for  Block  is  the  Surface  sampling  refinement:  see
below..

Circular  is  a  completely  different  strategy  as  here  the  rectangular  base
pattern (grid) applied in the first strategies is no longer used. In top view the
toolpath  shows  true  circles,  projected  onto  the  3D geometry.  For  each  XY
toolpath position the Z-value is calculated using a special Z-grid. Of course
that strategy can very well be used for round geometries, like rings or cups.
Detail settings are:
Inside out versus outside in (same as for block strategy)
Yes or no machine the corners: the area inside the rectangular segment but
outside the largest circle that touches all four sides of the segment.
Yes or no make it a Spiral toolpath (in top view). This is a great strategy for
high speed machines as no sharp angles are present in the toolpath.
Set  the  Center  point  of  the  Circle/spiral  toolpaths.  Standard  this  is  in  the
center of your Operation segment, however you can also choose the Center
of  the  Part  segment,  or  any  Custom  XY  values.  These  custom  values  then
can be either typed or graphically set using the Set button. The center point
may even be outside the segment.
Here as well  the milling direction can be set  on  the  page  Movement  tab of
this  dialog:  Conventional  result  in  a  counter-clockwise  direction,  Climb
clockwise (for outside-in).

Radial  is  the  complement  of  circular:  same  Z-grid,  radial  toolpaths
perpendicular to circular.  So also the same Detail  settings  do  apply,  except
for  the  Spiral.  And  the  sequence  of  the  toolpaths  now is  called  Clockwise
versus Anti-clockwise.

Offset machining generates toolpaths as offset lines to the border of the area
to be machined.
This  area  can  be  defined  either  using  option  Skip  Ambient,  using  a
(freeform)  operation  segment,  or  using  a  combination  of  both.  For  a
rectangular area the paths will  be similar to the Block strategy,  for a round
area the paths will be similar to the Circular strategy; the power of the Offset
strategy is  that  this will  work for  any freeform area  to  create  toolpaths  that
follow the shape of the geometry.
When used in combination with a segment you can apply the automatically
generated freeform segment that follows the outer  contour of the geometry.
This offers more control (than using Skip Ambient) as for a segment border
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the Border settings can be used.
Typical  application  example  is  machining   corrective  insoles  (to  be  worn
inside  shoes),  which can  be  done  very  efficiently  with  toolpaths  parallel  to
the sole's outer contour.
Detail settings for Offset are: 
Inside-Out  versus  Outside-In  will  be  clear,  and  Subsampling  will  be
explained below. 
This  strategy  produces  a  number  of  "parallel"  toolpaths,  and  Smooth
toolpath transitions concerns the transition to each next toolpath. Normally
the last point of the finished path will be connected to the first  point of the
next  path,  resulting in  two  straight  (90  degree)  corners  in  the  toolpath.  On
fast  machines  this  will  cause  the  machine  to  reduce  the  feedrate  at  these
points.  This  can  be  prevented  by  checking  the  option  Smooth  toolpath
transitions: DeskProto then will ignore these last points and first points, and
instead will connect the last-but-one point of the finished path to the second
point  of  the  next  path.  The  result  will  indeed  be  a  smoother  transition.  Be
careful  though:  ignoring  these  two  points  for  each  transition  may  cause
DeskProto to remove too much material.
The  Offset  toolpaths  follow  the  outer  contour  of  the  area  to  be  machined,
each next  toolpath  at  the  prescribed distance  from the  previous  one.  In  the
center  of  the  area  the  paths  from  opposite  sides  will  meet,  and  there  the
distance  between  the  last  toolpaths  may  be  larger  then  the  prescribed
distance, creating gaps in the toolpath pattern. For flat cutters this will not be
a  problem,  for  ballnose  cutters  at  these  gaps  the  cusp  (ridge  of  remaining
material)  will  be  higher  than  for  the  rest  of  the  geometry.  To  prevent  this
unwanted situation you can use the option Fill  Gaps  :  then DeskProto will
add extra toolpaths to also fill these gaps.

Waterline machining produces toolpaths on a constant Z-level (just like the
waterlines on a ship’s hull).  Such strategy is  also called contour machining
or Z-plane machining. While the difference with toolpaths on constant X or
Y  seems  small,  in  reality  the  difference  is  huge  as  completely  different
calculation algorithms are needed. 
In the Detail  settings an extra  parameter  is  needed: the Waterline distance
(so  the  distance  between  two  toolpaths  in  Z-direction).  The  XY  toolpath
distance  parameter  as  set  on  the  General  tab  page  is  also  used:  when
horizontal surfaces have to be machined. 
A second waterline parameter is the choice between Top to bottom: start at
the highest point and work down, and Bottom to top: start at lowest Z-level
on the outside of the block, and work towards the top.

Finally  the  Detail  parameter  Fill  horizontal  planes  is  offered.  This  option
needs some explanation. As waterline toolpaths have a fixed  Z-distance in-
between each two toolpaths, at (almost) horizontal surfaces there might be a
large distance between two toolpaths. This (horizontal) distance might even
be  larger  than  the  diameter  of  the  cutter:  resulting  in  islands  of  material
remaining after  using only that operation.  The option Fill  horizontal  planes
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checks  where  the  horizontal  distance  is  too  large,  and  fills  the  space  with
toolpaths at a distance as specified on the General Tab. All these in-between
toolpaths  have  the  same  Z-value,  so  a  visible  staircase  effect  will  be  the
result. You may consider un-checking this option when you use a waterline
operation  for  finishing,  after  all  material  has  been  already  removed  by
previous operations. This will save you much time, both for calculating and
for milling.

The last strategy Contour only is in fact an additional strategy as it does not
machine the complete part: only the outline of the geometry (outer contour)
at  ambient  level  is  machined.  This  can  be  used  after  a  different  strategy  to
smoothen  the model  (when  DeskProto  creates  toolpaths  that  are  parallel  to
the X- or Y-axis, at places where the outside surfaces are almost vertical the
contour  can  show  a  staircase  effect).  A  next  use  is  for  Pre-roughing  the
material: start with giving your block the correct outside shape.
The only detail setting for Contour only is the Surface sampling refinement:
see below..

The  Surface  sampling  refinement  parameter  that  is  offered  for  some
strategies  is  meant  for  advanced  users,  as  normally  the  default  values  are
appropriate.  After  checking  the  box  you  can  use  the  Settings  button.  As  a
result the Surface Sampling refinement dialog will be shown that allows you
to fine-tune the gridsize or calculation precision.

Roughing parameters

Roughing  stands  for  quickly  getting  rid  of  most  of  the  material  without
milling  very  precisely.  So  after  an  roughing  operation  you  always  need  a
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second  operation  which  machines  the  same  area  more  accurately:  the
finishing  operation.  In  DeskProto  you  can  use  an  operation  either  for
roughing  or  for  finishing,  so  if  you  need  both  you  will  have  to  Add  an
operation in the General Part parameters.

The roughing option Layer Height maximizes the cutting depth: instead of
trying to  remove  all  material  at  once,  this  will  be  done  layer  by  layer.  The
default  layer  height  equals  the  whole  cutting  length  of  the  cutter.  In  most
cases it is preferable to use a smaller custom-defined layer height, as with a
tough material you do not want the cutter to use its total cutting length. The
first  3D operation  of  a  part  always  uses  layers.   This  is  done  automatically
and cannot  be  overruled.  For  subsequent  operations  you  can  un-check  Use
Layers: the cutter will then machine at full depth all the time.
Note:
The  first  layer  starts  at  the  top  of  the  segment.  When  your  block  is  higher
than the part you can use a custom Part Segment and enter a higher Max Z
value.

Entering  a  Skin  Thickness  results  in  a  model  which  is  thicker:  a  skin  is
added everywhere around the model.  In  this  way the chance  that  the  cutter
takes  away  too  much  material  is  reduced  (this  can  happen  as  roughing
typically  will  be  done  using  a  low precision,  and  as  the  cutter  will  vibrate
and  may  bend  during  roughing).  Using  a  skin  also  improves  the  resulting
 surface  quality,  as  then  during  finishing  the  tool  will  remove  the  same
(small)  amount  of  material  all  the  time.  Internally  DeskProto  processes  the
skin by applying a different size (and shape) cutter.
It  is  possible  to set  the Skin on  a  negative  value,  making  the resulting part
too  small.  This  is  interesting  in  some  special  cases,  like  for  creating
electrodes for EDM machining (spark erosion), or for machining a foam core
to apply modeling paste on for the final cut to size.
Of course entering a value of 0.0 means that no skin will be applied.
Warning on skin use: 
The skin is  also applied on vertical  surfaces,  which in case of high vertical
walls  may  lead  to  a  problem  during  finishing.  When  finishing  the  cutter
machines on full depth, so it has to take off the skin of the complete wall in
one go. In case the wall is higher than the cutting length of the tool this is a
problem for which no solution is available yet. A workaround to solve it is to
add an operation using the waterline strategy, milling from top to bottom.

The Ramping angle  is used when starting to machine.  The cutter  will  then
first  move  to  the  correct  XY  position:  exactly  above  the  first  point  to  be
machined, on the Free movement height Z-level. Then the cutter  will  move
down  to  that  first  point  to  be  machined,  which  is  normally  done  in  one
vertical downward movement.
Such  vertical  downward  movement  is  not  ideal:  many  cutters  do  not  like
that,  and  the  chips  cannot  escape  the  deep  round  hole  that  is  created.
Entering a Ramping angle makes DeskProto replace this vertical  movement
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by  a  series  of  ramping  movements:  go  down  along  a  sloping  line.  See  the
small picture in the dialog for this option. You can set how steep this sloping
line  needs  to  be  by  entering  an  angle  value  in  degrees:  this  is  the  angle
between the sloping line and a horizontal line.
- Ramping is  applied when moving down to the first  point  of an Operation
(in  case  of  multiple  layers:  for  every  layer).  It  is  not  applied  on  other
downward vertical movements.
- Ramping uses the space that is available above the first horizontal toolpath.
In case that first toolpath is very short then ramping is not possible.

The  option  to  Protect  Vertical  Surfaces  is  useful  when  roughing  with  a
large value  for  the  Stepsize  along toolpath.  In  case  the  steps  are  large  they
may not “see” all geometry in-between and remove too much material. This
may happen in case of vertical  or steep surfaces in the geometry.  Checking
this  option  will  replace  any  tool-movement  steeper  than  45  degrees  by
separate  horizontal  and vertical  component  movements.  On some machines
this  may  cause  unwanted  vibrations  as  smooth  paths  are  replace  by
staircases.
This  resembles  the  algorithm as  used  in  Vertical  surfaces  in  the  Advanced
Operation  parameters  with  a  height/step  ratio  of  1,  however  this  latter
advanced option is more intelligent.

Sub-Segment parameters

This tab page offers almost the same options as the segment tab page of the
Part parameters. 
Note  that  the  functionality  that  is  offered  is  different  though  !   A  Part
segment defines the size of the complete Part: any geometry outside will be
removed. The Operation sub-segment only defines the area to be machined.
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So  it  limits  the  toolpaths  for  this  Operation,  for   instance  when  there  is  a
small piece in the model that is very detailed and needs to be machined with
a smaller tool in an extra operation. You can use the sub-segment to exactly
define  an  area  that  you  want  to  machine  more  precisely  in  this  extra
operation. Any geometry outside the sub-segment will not be damaged.
As you can  see  in  the  icon  pictures,  the  bounding box  of  this  sub-segment
will be drawn in green lines.

The default option here is Use part segment. This means that the cutter will
machine  the  whole  part  you  want  to  create.  The  sub-segment  may  not  be
larger than the segment of the part.

Two types of custom sub-segment are available:
Custom  Block  sets  a  rectangular  block,  just  as  for  the  Part  segment.  This
block  can  be  defined  by  entering  the  min  and  max  boundaries  in  the  edit
boxes  at  Settings,  or  graphically.  The  button  Set  graphically  pops  up  a
dialog that makes it very easy to set any segment using the mouse, just as is
used for the part segment. See the explanation at the Set Segment graphically
page of this manual.

Checking  the  option  Display  translated  coordinates  changes  the  numbers
that are shown for the segment boundaries:  these will  now be in workpiece
coordinates as used on the machine, so after Translation. Only the numbers
shown  here  for  input  are  changed,  not  the  actual  coordinate  values  in  the
toolpath.
This checkbox also applies to the graphical settings option. Checking or un-
checking this checkbox does not influence the position on the machine. It’s
just a temporary conversion on screen for setting the segment more easily.

The second type of sub-segment is the Freeform segment.This option allows
the  use  of  segments  that  are  not  rectangular,  for  instance  a  circle  or  any
freeform  contour  (freeformed  in  top  view).  For  more  information  see  Set
freeform segment.
The Min and Max values shown in the Settings area will be of the bounding
box of the segment  (for  X and Y).  The min and max Z  can  be  set  as  for  a
block segment.

In  case  the  operation  is  a  bitmap  operation  a  fourth  option  is  present:  Use
Bitmap size. Then the area to be machined will be the bitmap area, so it will
not depend on the 3D geometry that is (or is not) present.
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Borders parameters

As has been explained already, in DeskProto the toolpaths normally cover a
rectangular  area.  In  most  cases  this  area  needs  to  be  a  bit  larger  than  the
minimum and maximum values of the geometry,  allowing the tool to  move
down to  minimum Z-level  everywhere  round  the  geometry,  to  machine  the
outside surfaces. This extra area at the 4 sides of the rectangle is  called the
Border area,  and in this Tab you can influence the size of  the  border  area
(the  Z-level  used  for  the  border  area  is  set  at  the  Ambient  tab  of  the  Part
Parameters). Note that you can also use the segment to add extra area to be
machined.

The  default  option  is  Extra  for  cutter,  which  sets  the  border  area  size
exactly  to  the  size  that  is  needed  to  let  the  cutter  go  around  the  model,  in
order to machine all outside surfaces of the part. 

In the four edit boxes you can see that the value matches the Radius of your
cutter.  The  resulting  border  will  be  cut  at  the  full  diameter  of  the  cutter,
however  here  we consider  the  position  of  the  center  of  the  cutter.  And  for
this center the max distance to the geometry is the Radius of the cutter.

The  second  option,  No  extra,  keeps  the  cutter  positions  (that  is  the
centerpoint of the cutter) exactly inside the sub-segment. Using this option it
is still possible that the tool cuts away material that lies just outside the sub-
segment,  as  half  of  the  cutter  reaches  outside  this  segment.  DeskProto  will
anyway check that any geometry that belongs to the Part is not damaged. 

The  option  Cutter  stays  within  segment  means  that  the  whole  cutter  will
stay inside the  sub-segment.  This  option is  used by  the Two Sided  Milling
Wizard, to make sure that the area that is machined is exactly the same for all
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operations, no matter which cutter is used.

The last option, Custom, is to define the border sizes yourself, using the four
edit  boxes.  The  values  may   be  positive  values  as  well  as  negative.  For
negative  values  there  is  a  limit  though,  as  obviously  some  area  to  machine
has to remain. 
The use of the checkbox Uniform will be clear: it forces all four edit boxes
to have identical values.

Movement parameters

The Milling  direction is important for the surface quality of the prototype.
The  default  direction  is  Meander,  which  means  that  the  first  movement  is
from left to right, the second from right to left, etc. The tool keeps cutting all
the time, so meander is the fastest option. 

However, on the surface of the model you may see a difference between the
movements going from left to right (L-R) and the movements in the opposite
direction. The  surface will be smoother when all movements go in the same
direction.  Obviously  there  are  two  possibilities  here:  L-R  and  R-L.  The
words Climb and Conventional refer to the relation between the direction of
milling  and  the  rotation  direction  of  the  tool  (normally  clockwise):  see  the
small drawings in the dialog.
Do  note  that  choosing  the  option  Climb  or  Conventional  in  fact  does  not
guarantee  it  to  be  used  all  the  time:  when  machining  a  downward  sloping
surface it is possible that in fact the back of the tool cuts, thus reversing the
actual cutting direction.
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Meander  is  not  possible  for  all  strategies:  for  strategies  Block,  Offset,
Waterline  and  Contour  meandering  cannot  be  selected.  That  is,  unless  the
option Sort is active. When sorting it is possible that also for these strategies
the  toolpaths  in  some  area  can  be  optimized  by  making  them  meander.  In
these  cases  DeskProto  offers  the  Meander  direction  with  the  remark  "only
optimizes sorting".

The  Free  movement  height  is  the  Z-level  at  which  all  ‘non-cutting’  tool
movements will  be  executed.  This  is  for  rapid  positioning movements  over
the  part,  for  instance  from  the  home  position  to  a  position  above  the  first
point to be milled. The Z level you enter here is the number of units (mm or
inches) above the top of the geometry. Make sure to enter a positive value: in
case of a negative free movement height the model might be damaged.

This Free movement level (ZFree) value will be used in three ways:
· The first point and the last point of the toolpath for each operation are

located ZFree mm/inch above the top of the Part Segment. This is needed
to make sure that the cutter is high enough when moving to and from
these points, so instance to a next operation.

· The positioning moves during an operation are performed at ZFree mm/
inch above the top of the Operation segment, in order to speed up the
process when machining some detail area at a low level. These movement
are done in Rapid mode. When a Skin has been set (Roughing) the free
movement level will be the Skin-thickness higher.

· When the option Always stay low is checked, the positioning moves are
performed at ZFree mm/inch above the highest point of the geometry over
which the cutter moves. For machines with a slow Z-axis this will save a
lot of time. Also when on your machine switching between Rapid and
Normal movement is slow this will save time, as these movements below
the top of the segment are done at normal Feedrate.

Note that not  all  positioning movements  are done on Free movement level,
as  for  small  distances  this  is  not  needed.  The  following  situations  are
recognized:
1.  the  distance  to  be  traveled  is  less  than  1.41  times  the  Precision.  In  this
case the cutter can move in a straight line between the  two points (begin and
endpoint).
2.  the  distance  is  larger  than  the  Precision  but  smaller  than  the  Cutter-
diameter. Now the cutter will only rise a bit,  and travel  in a straight  line at
constant Z-level and at normal Feedrate (speed). 
3. the distance is larger than the Cutter-diameter. Now the cutter will rise to
Free  movement  height  for  a  positioning  move  at  Rapid  speed  (unless  of
course the option Always stay low has been checked).  The idea is that now
the distance is so large that a rapid move will gain time. 
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The  Dynamic  Feedrate  control  is  an  advanced  option  of  DeskProto:  even
many so-called  high-end  CAM  software  packages  do  not  offer  this  type  of
functionality.  It  means  that  DeskProto  is  able  to  reduce  the  feedrate  when
needed, thus making it possible to select a high overall  feedrate without the
danger of breaking your tool at  the critical  points  that  will  be  encountered.
Two separate options are offered.  In both  cases  you can  enter  a  percentage
for  the  maximum  feedrate  reduction  applied;  in  both  cases  DeskProto  will
choose  in-between  feedrates  whenever  possible,  thus  always  running  at
optimum feedrate. Do note that both options can be combined, in which case
for  certain  movements  both  reductions  will  apply,  resulting  in  a  very  low
feedrate.

Using  the  Feedrate  for  plunge-movements  it  is  possible  to  decrease  the
feedrate when the cutter moves downwards. This may be needed to machine
in  metals,  as  fast  plunge  movements  may  damage  the  cutter  (many  cutters
have  problems with  drilling).  It  is  expressed  as  a  percentage  of  the  normal
feedrate. 
The  rate  you  enter  here  will  be  used  most  downward  movements.  For
downward  movements  that  are  almost  horizontal  the  reduction  will  be
smaller: DeskProto will apply the rate as specified + 20.  So when you have
set the plunge rate to 40 %, these movements will be reduced by only 60 %.
 A line is  considered ‘almost  horizontal’  when the downward angle  (so the
angle with a horizontal line) is less than 30 degrees.

It’s also possible to decrease the Feedrate for high chip loads, that is when
the  cutter  has  to  remove  much  material.  Due  to  DeskProto’s  parallel
toolpaths approach, normally the cutter  only has to remove a small  slice  of
material:  a  thickness  of  only  the  distance  between  two  toolpaths  (the
stepover). However, in certain cases the cutter has to machine away material
over the full flute diameter, which is a much higher chip load. For instance
for  the  first  toolpath  (as  the  block  will  be  over-sized  in  most  cases);  also
when  for  the  first  time  entering  a  pocket  in  the  model  (so  when  the  tool
suddenly has to machine much lower than during the previous toolpath). The
chip load is even higher in such cases as the chips cannot  easily fall  out  of
the cut then, but will be stuck in the groove that is machined. 

In these cases the feedrate will be reduced, the actual reduction depending on
how much deeper  the  tool  has  to  cut  compared  to  the  previous  toolpath  at
that position. Reduction is applied according to the following rule, where D
is the cutter’s flute diameter and Rate is the percentage that was entered. The
column "Example"  shows the resulting actual  reductions  in  case  a  value  of
20 % resp 70 % has been entered. 

Difference in depth: Reduction percentage: Example:

For rates below 60 %:
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until 0.1*D 100 % 100 %
0.1*D - D Rate + ½ * (Rate)  30 %
D - 2D Rate + ¼ * (Rate)  25 %
more than D Rate  20 %

For rates of 60 % or higher:
until 0.1*D 100 % 100 %
0.1*D - D Rate + 2/3 * (100-Rate)  90 %
D - 2D Rate + 1/3 * (100-Rate)  80 %
more than D Rate  70 %

So  (explanation  of  the  table  above):  reduction  is  applied  only  in  case  the
cutter  machines  deeper  than  in  the  previous  toolpath,  with  a  margin  of
 0.1*D (10 % of the cutter diameter D). When between 0.1*D and D deeper
the first reduction step is applied, between D and 2D the second, and when
the difference is more than 2D the full reduction percentage is applied. In the
toolpath drawing on screen, the paths at reduced feedrate will be drawn in a
slightly different color.

The  option  Reduced  feedrate  for  high  chiploads  is  not  available  for  all
strategies.
An  all  Dynamic  Feedrate  options  are  of  course  only  possible  on  machines
that  can  set  the  Feedrate  from  the  PC,  which  is  determined  by  the
Postprocessor used.

DeskProto  is  able  to  Optimize  the  toolpaths  using  a  Sorting  algorithm.  It
will  then ignore the sequence as defined by the Strategy,  and instead try to
complete series of tool-movements that are located close to one another. For
instance when machining the Picture frame sample geometry with a parallel
to  X strategy, the cutter would normally travel from the left to the right side
of  the  frame  all  the  time.  Sorting  will  make  DeskProto  first  complete  one
side,  and  only  then  start  with  the  other  side:  preventing  much  positioning
movements.  Sorting  can  especially  save  much  time  in  case  many  roughing
layers are applied.

Here  is  some more  detailed  information  about  the  sorting  algorithm that  is
used.  In  DeskProto  each  toolpath  is  a  series  of  small  lines  (linear
interpolations,  or  G1  movements),  where  each  movement  is  a  straight  line
between two points. A series of connected movements (in fact a polyline) is
called a chain. A chain ends when a positioning movement (go up, position,
go down) is needed.
The third concept that is used is the tour: a tour is one complete path for the
chosen  strategy,  so  when  not  interrupted  for  some  reason.  For  strategy
parallel a tour is one complete path from left to right, for block one complete
path around all four sides, etc. Subsequent tours are more or less parallel to
one another.
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Sorting compares the start point and endpoint of each chain with all  chains
on the next  tour.  If  on  that  next  tour  a  adjacent  chain  (so  both  start  points
and end points close) can be found that is  closer  that  the next  chain on the
same tour, then DeskProto will jump to the chain on the next tour.

For  the  waterline  strategy  the  situation  is  more  complex.  Here  DeskProto
uses the bounding box of each chain. If the bounding box of a chain does not
overlap any other bounding box (on the same Z-level) then it is an isolated
chain.  After  machining  such  isolated  chain  DeskProto  will  jump  to  an
isolated  chain  on  the  next  Z-level  (and  on  the  same  location).  So  when
machining a city with church towers, sorting will make DeskProto complete
the towers one by one, instead of finishing a complete Z-level before starting
on the next Z-level.

For  the  Contour-only  strategy  sorting  can  change  the  sequence  of  the
contours  -  of  course  only  in  case  more  than  two  separate  contours  are
present.

Advanced parameters

Ambient  skipping  concerns  the  ambient  area.  Basically  DeskProto  always
machines  a  complete  rectangular  area  (the  segment),  due  to  its  parallel
toolpaths  approach.  In  case  the  model  only  takes  up  a  small  part  of  the
segment,  this  might  lead  to  many  superfluous  movements  and  unneeded
machining time.  Also when all  material  around the model already has been
removed in a previous roughing operation there is no need to again machine
the ambient area when finishing.
In  such  situations  you  can  optimize  the  toolpath  by  using  the  Ambient
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skipping option. 
· By default this option is set to None (no skipping): the complete segment

will be machined.
· Skipping the Hor. ambient means that all extra horizontal movements on

ambient  level,  from  the  model  to  the  segment  border  and  back,  will  be
skipped.  The tool  will  still  go  down to  ambient  level  around  the  model.
 You can for instance use this for finishing, when all ambient material has
already been removed by the roughing operation.

· Skipping the Hor. + Ver. ambient means that both horizontal movements
on ambient  level  and the vertical  movements  towards  ambient  level  will
be skipped.  For ballnose cutters then still a groove round the part will be
visible: when only a small part of the cutter is above the model the tip of
the ball will have a lower Z-value than the part geometry at that point.

· Skipping  the  Total  ambient  means  that  the  center  of  the  cutter  will
remain  above  the  geometry:  all  positions  with  the  center  of  the  cutter
above ambient area will be skipped.

The  icon  pictures  on  this  tab  page  illustrate  the  differences  between  these
four skipping options.

An extra option that can be checked here is called Ignore enclosed ambient.
When checked, only the ambient around (so on the outside of) the part will
be skipped. The enclosed ambient area, like for instance holes in the model,
then will be machined.

The  algorithm  used  by  DeskProto  to  calculate  toolpaths  does  not  really
support true Vertical surfaces. DeskProto calculates its toolpaths based on a
 Z-Grid,  connecting  the  points  of  the  grid  to  form  the  toolpath.  Each  tool-
movement  will  contain  both  a  horizontal  and  a  vertical  component,  the
horizontal component being the stepsize along the toolpath. So true vertical
movements  are  not  possible:  a  vertical  surface  in  the  geometry  will  have  a
small angle in the model. 

In case you do need a model with true vertical surfaces you can achieve this
by  using  and  fine-tuning  this  option.  You  can  let  DeskProto  assume  a
vertical surface in case the ‘toolpath-line’ is steeper than a certain angle. The
angle  is  defined  by  the  Ratio  between  the  height  and  horizontal  distance  (
stepsize) of one movement  in  the  toolpath,  and in  the  edit  box you can  set
the Height/step ratio to be used. See the illustration and examples below.

For  every  movement  DeskProto  will  check  this  ratio,  and  for  the  first
movement  it  exceeds  the  value  entered  here  (so  when  the  movement  is
steeper),  DeskProto  will  insert  an  intermediate  movement:  the  movement
will  be  split  into  a  horizontal  and  a  vertical  component,  to  be  executed
sequentially.  The  result  will  be  a  vertical  surface  in  the  model,  which
otherwise would have been angled. 
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The extra position will be added only for the first movement (or the last for
an  upward  toolpath),  meaning  that  this  will  only  happen  at  the  transition
point between a "horizontally oriented" section of the path and a "vertically
oriented"  section.  See  the  illustration  above  right,  showing  the  result  for  a
height/step ratio of 1.
A much simpler version of this algorithm can be chosen in the Roughing tab
page: with  a  fixed  ratio  of  1  and for  all   movements  (so for  all  lines  of  45
degrees or steeper): the illustration above, left.

For  freeform  surfaces  this  functionality  is  not  needed,  so  for  such  models
choose Do not check for vertical surfaces.

It may be needed to experiment a bit with this option in order to find the best
ratio for your geometry.  Do take care when creating prototypes with a  draft
angle:  in  case  this  option is  used  the  result  might  be  that  all  draft  surfaces
will be made vertical !

Example 1:  Vertical surface ratio = 8
In the image below you can see 2 toolpaths.  One is  drawn in black,  one  in
red.  The  black  one  is  the  one  that  is  first  calculated.  When  you  use  the
vertical  surface ratio option and set  it  to 8,  the toolpath  will  be  changed  to
the red one. So on the left the toolpath is corrected whereas on the right it is
not,  because on the left the height/step ratio is 8/1 whereas on the right the
height/step ratio is 4/1. On the left DeskProto assumes a vertical surface and
changes the toolpath, on the right side not. For a vertical surface DeskProto
will  add one  tool  movement,  splitting  the  original  angled  movement  into  a
vertical  and  a  horizontal  part.  These  two  movements  will  be  output  in  a
sequence that leaves extra material on the part.



DeskProto Reference

Page 102

Example 2: now with numbers.
Assume  that  you  have  set  the  Stepsize  to  be  1  mm.  Also  assume  that  a
toolpath  is  generated  that  you  want  to  be  vertical  -  which   however  (as
explained) in DeskProto will include a horizontal component of 1 mm (this
stepsize). The default height/step ratio of 20 then means that when this tool
movement  goes  up  or  down over  more  than  20  mm it  will  be  split  up  into
two  separate  movements  (horizontal  and  vertical),  milling  a  true  vertical
surface in the resulting part.
This will work for any Stepsize: when you have for instance selected 0.0262
inch,  then  the  height/step  ratio  of  20  means  that  when  the  tool  movement
will be split when it goes up or down over more than 20 x 0.0262 = 0.524
inch.

Note that this vertical surfaces check does not work for conical cutters as the
steepness of the toolpath is  analyzed (for conical  cutters  the  toolpath  never
can be steeper than the Angle of the cutter). 

Start  /  End  offers  the  option  to  add  extra  commands  to  the  NC  program
before  the  operation  toolpath  starts  and/or  after  it  has  ended.  These
commands can be movements, user defined commands or Chaining.
Chaining is an option originally created for the N-sided milling wizard. This
wizard  combines  Operations  in  separate  Parts  into  one  large  toolpath  file,
which normally is  not  possible  in DeskProto.  Chaining  means to  connect  a
next  Operation  to  the  end  of  this  current  Operation.  The  Settings  button
gives access to the Operation Start /  End Settings dialog where you can set
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all of the options just mentioned.

The Collet collision check is a very useful option for high models, especially
with high vertical or steep surfaces. The problem with such models is that in
case  the  vertical  wall  is  higher  than  the  free  length  of  the  tool,  the  milling
machine’s  collet  will  damage  the  model  (DeskProto  only  compensates  for
the geometry of the cutter). Checking this option means that DeskProto will
let the tool move away from the model in such case, preventing the collet to
collide  with  the  model.  Obviously  the  resulting  model  will  no  longer  be
correct,  as  material  that  cannot  be  reached by  the cutter  will  be  left  on  the
bottom  of  the  vertical  wall.  However  this  is  much  better  than  letting  the
collet damage the top of the model, as excess material can be removed with a
different cutter or by hand. 
The diameter of the collet can be defined at the Machine parameters dialog.
Do  note  that  when  using  this  option  the  border  area  will  be  enlarged,  to
enable the complete collet to move down on all sides of the model.

5th-axis parameters

The  5th  Axis  tab  is  visible  only  in  case  in  the  Part  parameters  the  option
"Use rotation axis tilt option" has been checked. It is also only meant for this
special type of 5th axis: the manually controlled B-axis  as present on some
small  wax  milling  machines  for  jewelers.  Like  on  the  Roland  JWX-10
"Jewela" machine, as shown in the illustration below:



DeskProto Reference

Page 104

In  the  bottom-left  corner  of  this  picture  you can  (just)  see  a  rotation  knob:
after  unlocking  the  rotation  mechanism you  can  use  this  knob  to  manually
tilt the complete rotation axis (A-axis) unit.  This machine supports locking
on fixed intervals of 15 degrees.
As this manual rotation is round an axis parallel to Y, this rotation is called a
B-axis.  The  total  number  of  axes  then  is  5  (X,  Y,  Z,  A  and  B),  hence  the
name 5th axis.

The Tilt Angle that you can enter here is the rotation value that will be used
for this Operation. As you can see in the illustration, this rotation offers you
the possibility to machine in places where the cutter normally cannot reach:
for instance the inside of a ring model.
In addition to these 15 degree intervals you can also enter a Custom rotation
value here.

Note that the position of the part after this rotation depends on the distance
between the part  and the actual  B-axis  (so  the  axis  of  rotation).  The  larger
this distance, the more Z-movement while rotating. This distance can be set
on the Translation tab of the Part parameters, as at angle 0 this distance is in
fact the X-translation. You will see that the Translation tab looks differently
when this 5th axis option has been selected.
Setting  the  correct  X-translation  here  is  important:  only  with  a  correct
translation  all  resulting  toolpaths  from  operations  with  different  tilt  angles
will be correctly positioned (all with the same Workpiece zero point).
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Simulation parameters

A  Simulation  is  a  drawing  on  screen  that  shows  you  what  the  resulting
machined  part  will  look  like.  This  can  be  used  to  check  things  like  the
resulting  surface  smoothness,  error  movements  (if  at  all  possible)  that
damage  the  part,  rest-material  where  the  cutter  cannot  reach,  etc.  In  this
dialog you can set the simulation parameters. You can calculate a simulation
by  using  the  Calculate  Simulation  command  in  the  Create  menu.  You  can
also switch the simulation on and off in the Subjects in view Dialog.

DeskProto will calculate a simulation in 3D, so you can rotate, pan and zoom
it  just  like any other subject  on screen.  Currently the DeskProto simulation
can do only one operation at a time, so each operation will  have a separate
simulation. Also see the description of the command Calculate Simulation in
the next chapter of this manual.

In this dialog you can set the simulation parameters, two groups are present:

The Level of Detail sets the accuracy of the simulation to be calculated. The
simulation is in fact a Z-grid like used in many other DeskProto calculations:
the level of accuracy sets the number of grid cells used. The size of one cell
is  the  simulation  precision,  which  is  the  same  as  or  smaller  than  the
calculation precision. 
Five preset options are available to determine how much smaller:
Lowest Sets this precision the same as the calculation precision
Low Sets this precision a factor 3 higher 
Medium Sets this precision a factor 5 higher 
High Sets this precision a factor 9 higher 
Highest Sets this precision a factor 13 higher 
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Note that this Detail factor is applied both on X and Y. So the factor 9 means
that per grid cell in the toolpath calculation, 9 x 9 = 81 cells will be used for
the simulation calculation. This means that calculating a simulation can take
much time, especially for higher levels of detail.

The  parameters  in  Compare  with  Geometry  offer  the  possibility  to  check
the difference between the resulting part and the original STL file geometry.
DeskProto  will  calculate  the  distance  between  the  simulation  and  the  STL
geometry,  and  will  apply  a  color  on  the  simulation  when  this  distance  is
above a certain tolerance value.

Check  if  removed  too  much  (RED)  will  show  it  in  case  DeskProto  has
removed too much material. Note that the red will only be visible when you
have  turned  off  the  rendered  geometry  in  the  Subjects  in  view  Dialog,
otherwise the geometry will hide the red.

Check if  rest material left (GREEN) will  show in case too little material
has been removed because the cutter could not reach a certain position. This
may happen on many occasions, like:
- toolpath distance too large (and a ballnose cutter)
- small hole where the cutter does not fit inside
- sharp inner corner, which will be machined with the Radius of the cutter

A Tolerance value decides whether or not to apply such color red or green.
By  default this tolerance equals the calculation precision, though when you
set it to Custom you can enter any value that you need in the edit box.

Note:  this  tab page will  not  always  be  visible.  DeskProto does  not  support
simulation when the 4th axis is used, so in that case the simulation tab page
will not be displayed. Also for 2D machining simulation is not yet possible.

3.4.8 Sampling Refinement

All DeskProto toolpath calculations are based on a Z-grid, and the size of the
grid cells sets the precision of the toolpaths.  For every cell  in the grid a Z-
value  will  be  calculated  for  the  geometry  (surface)  at  that  location:  the
surface  is  sampled.  In  other  words  the  DeskProto  algorithm  is  based  on
Surface Sampling.

In  the  operation  parameters  you  enter  the  Precision  as  “Distance  between
toolpaths”  and  “Stepsize  along  toolpath”.  The  smallest  of  the  two  will  be
used as Gridsize (cell size) of the Z-grid. While in most cases this works OK,
sometimes  it  is  needed  to  overrule  this  default  and  use  a  smaller  Gridsize.
This  is  called  subsampling  or  sampling  refinement,  as  per  toolpath  point
more than one geometry position will be sampled. This dialog can be used to
define the Refinement factor.
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You can reach this dialog by using the button Details on the Strategy tab of
the Operation parameter dialog.
Note that in previous version of DeskProto this dialog was called Calculation
Precision Details and had a different layout.

The Surface Sampling Refinement dialog allows you to fine-tune the gridsize
or  calculation  precision.  The  higher  the  Refinement  Factor,  the  more
accurate  the  toolpaths  and  the  longer  the  calculation  time  (quadratic).  A
refinement  factor  1  will  result  in  a  Z-grid  with  a  gridsize  that  equals  the
settings  for  Distance  between  toolpaths  and  Stepsize  along  toolpath.  A
Factor  2  will  double  the  Z-grid  resolution  for  both  X  and  Y,  so  will
subdivide each grid cell into 4 smaller cells, etc.

Note 1: This setting is in fact only meant for advanced users, to be applied in
special circumstances only !!
Note that higher factors will mean much longer calculation times !

Note  2:  The  default  factor  as  said  is  1  (None).  However,  for  strategies
Waterline  and  Contour  Only  the  default  factor  is  3  as  this  is  needed  to
achieve smooth toolpaths. This explains why the calculation times are longer
for those strategies.

3.4.9 Set Freeform Segment

The Freeform segment is meant to save machining time by exactly defining
the area that  needs  to  be  machined.  This  area  can  be  defined  by  drawing  a
freeform closed contour in the Top view of the part. For this contour you can
also set a Min and a Max Z-value, resulting in a freeform segment. You can
reach this dialog by using the button “Set Freeform” on the Segment tab of
the Operation parameters dialog.
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The  Set  Freeform  Segment  dialog  shows  a  new  drawing  of  your  part,  and
allows you to draw any closed freeform contour line in the Top view of your
Part.  The  orange  rectangle  shows  the  Part  segment:  the  freeform  segment
needs to be completely inside this rectangle.
 
The  buttons  on  the  right  can  be  used  to  create  and  change  the  segment's
contour  line.  Eleven  of  these  are  standard  DeskProto  buttons  of  which  the
use is known, and that need no explanation here. Note that mouse rotation is
not present: this dialog only used the six main views. The Cube buttons on
the  second  row  are  for  the  choice  between  rendered  view,  wireframe  view
and both views combined.

The eight buttons on the third row are new, these are the drawing tools used
to graphically draw and/or change the segment.  Note that these are “mouse
buttons” as well: of the eleven mouse buttons only one is active at any time.

Edit  Freeform contour:  you can  move the points  and the sides  of  the
contour  by  dragging  with  the  mouse.  Watch  the  cursor  to  see  if  you
will drag a point or a line.
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Add point to Freeform contour: click with your mouse to add a point.
The  closest  side  of  the  closest  polyline  will  be  split  up  into  two  new
sides.
Delete point from Freeform contour: click with your mouse to delete a
point.  Watch  the cursor  when moving the mouse:  when  a  minus  sign
shows you are on target.
Draw  an  Ellipse  as  new   Freeform  contour:  click  the  left  mouse
button, move the mouse and release.  The ellipse  (can  be  a  circle  too)
that  is  drawn  is  in  fact  a  polyline.  When  you  press  the  shift  button
during  this  input  DeskProto  will  lock  horizontal  and  vertical  1:1,
forcing a circle.
Draw  a  Rectangle  as  new  Freeform  contour:  click  the  left  mouse
button,  move  the  mouse  and  release.  This  function  is  in  fact  also
present  in the Block segment  dialog.  When you press the shift  button
during  this  input  DeskProto  will  lock  horizontal  and  vertical  1:1,
forcing a square.
Draw a Polyline as new  Freeform contour: each mouse click will add
one point. The polyline is always closed. End the function with a right
mouse-click.
Delete  Freeform  contour.  Two  clicks  are  needed:  one  to  select  the
contour line to be deleted, and a second to actually delete.
Move  Freeform  contour:  simply  pick  and  drag  the  complete  contour
line. 

These  buttons  are  only  available  in  the  Top  view  and  Bottom view.  In  the
other views only the Min Z and the Max Z level can be graphically set (these
are fixed values, just as for the Custom rectangular segment).  You can also
set  the  new  segment’s  Z-values  by  entering  them  in  the  Z  edit  boxes.  The
boundaries of the current part are shown to assist you, so are the coordinate
values of the current mouse position.

The freeform segment dialog is the only place in DeskProto that offers Undo
functionality, as while drawing this functionality is more needed than when
working with settings in dialogs.

Undo the last action using any of the drawing buttons. 

Redo the last action that was undone

Nine levels  of Undo are supported plus one level  of Redo,  so a  total  of  10
situations is stored.

So the freeform segment is defined by a 2D polyline. This polyline can also
be imported from a 2D DXF file. The button Import from File … will open
a  standard  File  Open  dialog  to  browse  the  correct  file.  This  can  be  very
handy in case you can export your 3D geometry and a 2D contour from the
same CAD program.
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A very powerful  option is  offered by  button Generate  contour:  DeskProto
then will automatically generate a freeform segment that follows the outside
contour of the current geometry. This will also work for multiple geometries,
and for geometries that contain holes.

The  Freeform segment  supports  multiple  contours:  so  you  can  draw  more
than one freeform area in this dialog. 
Nested segments are supported as well: The outer contour defines an area to
be machined, the inner contour defines an area to be skipped. And inside the
inner  contour  you can  again  draw a  new outer  contour,  and so on.  See  the
illustration below.

3.4.10 Set Centre graphically

In order to calculate toolpaths in a circular,  spiral or radial pattern a Center
point is needed. Changing the center point will also change the toolpaths. In
the  Operation  parameters  >  Strategy  tab  >  Detail  settings  for  these  three
strategies,  you  can  enter  the  X  and  Y  coordinates  for  this  center  point.  At
that  same  location  you  can  also  press  the  button  Set  in  order  to  open  this
dialog to graphically set the center.

The dialog is in fact almost identical to the other dialogs for graphical input:
Set Segment and Set Freeform segment.
Only the functionality is different, and is in fact very limited: click a point to
set the XY coordinates for the center  point.  This point  may also be located
outside the segment.
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Note that this only works correctly in Top View and in Bottom View: in any
of the other views only one of both coordinates is changed when clicking.

3.4.11 Operation Start/End commands

This dialog is meant for advanced users only, as you can conclude from the
warning in red text.
It enables you to add extra command lines to your NC program file, both at
the Start (so just before the calculated toolpath of this operation starts) and at
the  End.  For  instance  to  let  the  cutter  travel  to  some  safe  position  after
finishing the operation.  Or to let  the A-axis  rotate  to a certain angle  before
starting to machine the operation. 
In addition you can also specify chaining (see below) in this dialog.

You can reach this dialog by pressing the button "Settings" for start/end on
the Advanced tab of the Operation parameters dialog.

Up  to  seven  Before  Operation  commands  (or  Start  commands)  can  be
specified.  These  will  be  written  as  extra  lines  in  the  NC  program  file,  just
before  the  toolpath  of  this  operation  starts.  Each  line  is  optional,  and  will
only  be  written  when  checked  (so  checking  none  will  mean  that  no  Start
commands are inserted) :
· User defined  can be used to issue any  command, like for coolant  or for

some other device. Note that the line will be written exactly as defined in
this  edit  box:  so  take  care  what  you  enter  !  So  you  need  to  know  the
language that your machine needs: this line will  not  be translated by the
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postprocessor.
   We advise that this option be used only by advanced users !!
· Move Z-axis to adds a Z-movement command to the NC file: to the

specified position (in mm or inches) in workpiece coordinates. Note that
these lines are written to the file in the same sequence as present in the
dialog: first the Z-movement, and then the X, Y and A movement. 

Note: the five Move-to commands are not available for some machines. A
machine that always needs three coordinates per command without
specifying which is for X, Y or Z cannot accept a line with for instance only
a Z-axis coordinate: it won't know for which axis it is meant. For such
machines all Move commands will be grayed out.
· Move Y-axis to adds a Y-movement command to the NC file: to the

specified position (in mm or inches) in workpiece coordinates.
· Move X-axis to adds a X-movement command to the NC file: to the

specified position (in mm or inches) in workpiece coordinates.
· Move A-axis to adds a command to rotate the A rotation axis to Angle

degrees.. 
· Move B-axis to adds a command to rotate the B rotation axis to Angle

degrees. This option is being  used by the N-sided milling
Note: The A-axis and B-axis commands are available only when the machine
for this part has such rotation axis defined in its machine-definition, if not it
will be grayed out. So the illustration above is made with a four-axis
machine selected.
These two rotation commands are used for indexed machining: machining a
part from several sides, each side three-axis machining, with a rotation in-
between. For instance the N-sided milling wizard uses the A-axis start
command for this aim: milling from four sides will involve four operations,
each time with a 90 degree rotation in-between. This is called indexed
machining.
· User defined 2, see the explanation given above.

The  seven  After  Operation  commands  are  the  same  as  the  Before
commands just described, only these will be written to the NC file after the
toolpath of this operation.

In the  four  edit  boxes  for  User  defined  an  extra  feature  is  hidden:  you  can
enter new lines when needed, to create a multi-line command. Entering the
string “^\N” will start a new line.

Chaining  is  an  option meant  to  combine  Operations  in  different  Parts  into
one large NC Program file. 
Operations  in  the  same  Part  will  be  combined  into  one  NC  Program  file
anyway. This option is used for instance by the N-side milling wizard. 
Note  that  chaining  is  of  course  only  available  in  case  more  than  one
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Operation is present in the current project.

The Operation Chaining Settings dialog gives you the option to chain a Next
operation to the current one. As a result, when saving the toolpath file (NC
program file) for the current operation, when finishing it will continue with
the next chained operation , writing the toolpath to the same file. In order to
select  a  next  operation  you  have  to  select  both  a  Part  and  an  Operation
(from that part).  Note that operations that already belong to  a  chain  cannot
be selected. 

If the Operation is part of a Chain a new button will appear in the Operation
Parameters dialog:  Apply to Chain. Using this button you can apply a new
parameter setting (for instance a different precision) to all operations that are
in the chain. The alternative is  button Apply (or OK) that will  only change
the current Operation.

Creating a Chain can also be done in the Project  parameters,  tab  Chaining.
Here  the  complete  chain  can  be  seen  (and  edited)  as  a  list,  which  is  much
easier than using the chaining option of this dialog.

3.4.12 2D Operation Parameters dialog

The 2D Operation parameters are divided into 5 sections by tab pages. Note
that DeskProto includes three different types of Operations: this dialog is for
the   2D  Operation,  in  addition  also  dialogs  for  a  3D  Operation  and  for  a
Bitmap Operation are available.

This same dialog is used for the Default 2D Operation parameters, only with
an  extra  button  Restore  DeskProto  defaults  to  reset  the  original  default
parameters.
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General parameters

Name
The name of the  operation can be changed; use a meaningful name to easily
remember  the  purpose  of  each  specific  operation.  The  name  is  meant  for
your convenience only, it is not used in the NC program file. It will be used
for the file name though, in case the NC output is in more than one file.

2D File
With a 3D Operation the toolpaths are calculated using the 3D geometry that
has  been  loaded  for  the  project.  With  a  2D  Operation  the  situation  is
different:  DeskProto  lets  the  cutter  move  along  the  lines  of  a  2D  drawing.
The option 2D File allows you to select which drawing file to use. So every
2D Operation has its own set of  2D contours.
Use  the  Browse  button to  pop up  a  File-open  window that  you  can  use  to
select  the  2D  file  that  you  need.   The  Reload  button  can  be  used  to  later
reload this file if needed.

For 2D files DeskProto supports types DXF, AI and EPS (all a subset). All
of  these  subsets  include  points,  lines,  polylines  and  arcs.  Currently
DeskProto will convert arcs to polylines. A point in the 2D file will result in
drilling a hole on that location. 
While  AI  files  and  EPS  files  do  not  contain  Z-values,  in  DXF  files  a  Z-
coordinate may be present for each point.  The result  will  be a 3D polyline.
The DeskProto 2D Operation can handle such 3D polylines, which may be a
bit confusing. Still it can be very handy as well.
  
Cutter
You can  select  a  cutter  from  the  cutting  tool  library  using  the  small  arrow
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button at  the  right.  Adding  new cutters  to  the  library,  changing  an  existing
cutter or just retrieving information on a cutter can be done using Library of
cutters (Options menu).

Note: for 2D machining DeskProto currently does NOT compensate for the
radius of the cutter. The cutter will just follow the contours in the 2D file. So
the  2D  options  in  DeskProto  are  limited:  the  3D  options  are  DeskProto's
main feature, 2D is additional functionality.

The  Machining  level  is  the  Z-coordinate  for  the  actual  toolpath.  You  can
describe  this  as  the  pen-down  level  when  plotting  the  2D  file.  The  Z-
coordinate  that  you  enter  has  to  be  in  workpiece  coordinates,  so  in  the
coordinate system used on the milling machine. 
When the 2D contour is projected on the 3D geometry (see below) then this
machining level is taken relatively to the geometry at that point.  So a value
of –0.5 mm will create a groove of that depth over the 3D surface.
Also in case of a 3D polyline the machining level is taken relatively to the Z-
value in the DXF file.

The Speed settings are identical to the settings offered on the 3D Operation
Parameters  dialog:  see  the  explanation  on  Feedrate  and  Spindle  Speed
there.

XY Transform parameters

The Transform parameters for 2D are meant to correctly position the 2D plot
data over the 3D geometry. 
2D files are imported in workpiece coordinates, so in the coordinate system
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as  used  on  the  machine.  Importing  in  CAD  coordinates  would  not  make
sense, as for instance rotation around the X-axis is not allowed for 2D data.  

This  implies  that  3D  CAD  data  and  2D  CAD  data  from  the  same  CAD
system  are  not  automatically  aligned  in  DeskProto  !!   For  a  correct
alignment: 
- Do not use any scaling or other transformation for 3D nor 2D, and
- In the Part Parameters select “None” for the X and Y Translation settings.

Scale XY can be used to scale the 2D data. It is possible to scale in only one
direction, by un-checking the uniform option. 

Translate XY can be used to move the 2D contours along the X and/or the
Y-axis. Translation values have to be given in mm or inches.

Rotate XY can be used to rotate the 2D contours. Rotation is only possible
in the XY plane, and will be done round the zero point of the 2D Drawing.

For correctly positioning the 2D contours over the 3D geometry the  Apply
button proves to be very handy, as you then can see what you have done so
far.

Z Settings parameters

The Free movement height is the same as in the 3D Operation: it specifies
the  height  at  which  the  cutter  can  freely  move  without  touching  material.
This height is used to move the cutter from one position to another without



Menu and commands

Page 117

DeskProto Reference

machining (pen-up level). It is set as the height above the top of the segment
of the part (as a 2D operation does not have a subsegment). Negative values
are permitted here. As in the analogy with a pen plotter the machining level
is  the pen-down level,  the free movement height  can  be  seen as  the  pen-up
level.

The  option  Z-levels  relative  to  part  geometry  (not  available  in  the  Entry
edition of DeskProto) will  project  the 2D contour on the 3D part  geometry
(vertical  projection).  When  you  check  this  option,  the  Machining  level  as
specified on Tab 1 (pen-down level) is no longer interpreted as a standard Z-
level, however is taken relatively to the Z-level of the geometry at that point.
So a level of –1 mm results in a groove of that depth over the 3D part. This
option is ideal for instance to engrave a logo or text onto a 3D design: the 2D
contours will be converted into 3D toolpaths.
The projection is  vertical,  meaning that on curved surfaces the 2D drawing
will be distorted: a circle that is projected on a steep surface will change into
a long ellipse. 
For this projection DeskProto will take into account the shape of the cutter in
3D (new in DeskProto V6.1).

This option is  only  available  if  there  is  a  3D geometry  loaded,  and at  least
one  3D  Operation  is  present  before  this  2D  operation.  This  3D  Operation
makes sure that the material above the geometry has been removed.

In order to calculate such projected 2D toolpath DeskProto needs to make a
Z-grid.  The  option  Calculation  Precision  in  XY  allows  you  to  set  the
precision, so the grid-size) of this Z-grid. The smaller the value entered, the
more  accurate  the  toolpath  will  be,  and  the  more  calculation  time  needed.
This Z-grid will be calculated only for the area covered by the 2D file.
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Roughing parameters

The Roughing settings basically are the same as in the 3D Operation: going
down in layers because you do not want the cutter to go to full depth in one
go.  When  you  un-check  Use  Layers,  then  the  cutter  will  immediately  go
down to full depth.

The Layer  height  that  is  specified  determines  how deep the cutter  may go
into the full material. You can set this Layer height to the Cutting length of
the  cutter  or  to  a  Custom value.  The custom value  may  not  be  higher  than
this cutting length though.

Rise to free movement height in-between layers does exactly what it says.
After completing a layer the cutter will go up to Free movement height and
then go down to the next layer, also in case end-point and start-point are on
the same XY position. 
Un-checking this option saves machining time as the cutter will lower to the
next  layer  without  going  up  first.  For  open  contours  this  will  result  in
 meandering toolpaths: go from start to end, then go down to the next layer,
travel from ‘end’ to ‘start’ etc.

As said before: a point results in a drilling operation. Using layers for such
operation results in Peck drilling: at regular intervals the cutter will move up
to get rid of chips. Of course then you need to check the option Rise to free
movement height that was just mentioned.
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Advanced parameters

Most  of  the  Movement  parameters  and  Advanced  parameters  of  the  3D
Operation  do  not  apply  for  2D,  only  these  two  settings  are  useful.  The
meaning of each setting is the same as in a 3D Operation, so please read that
help information: 

For  Plunge  rate  (moving  slower  for  downward  movements)  see  the  3D
Movement parameters.

For  Start  /  End  (extra  command  and  chaining)  see  the  3D  Advanced
parameters.

3.4.13 Bitmap Operation Parameters dialog

The Bitmap Operation parameters are almost the same as the 3D Operation
parameters, as for both operations the toolpaths are made for a 3D geometry.
The Bitmap Operation uses the Bitmap relief, the 3D Operation uses the Part
geometry. The only differences are some extra options on tab page General,
and one extra option on the segment tab.

This Help page only explains the extra options for the General Tab page, for
all other options the Help can be found in the 3D Operation parameters help.

This same dialog is used for the Default Bitmap Operation parameters, only
with an extra button Restore DeskProto defaults to reset the original default
parameters.
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General parameters

Name, Cutter Precision and Speed
For more information see the 3D Operation parameters.

Bitmap File
With a 3D Operation the toolpaths are calculated using the 3D geometry that
has  been  loaded  for  the  project.  With  a  Bitmap  Operation  the  situation  is
different:  DeskProto  uses  a  bitmap  file  to  calculate  a  Relief:  the  Bitmap
geometry, and uses that relief to calculate the toolpaths.
Use  the  Browse  button to  pop up  a  File-open  window that  you  can  use  to
select the Bitmap file (bmp, gif, jpg, png or tiff) that you need.  The Reload
button can be used to later reload this file if needed.

The button Bitmap settings... will open the Bitmap Settings dialog, in which
you can set parameters for converting the 2D bitmap image to a 3D Relief.

Note:  the  Precision  chosen  in  this  dialog  may  influence  the  size  of  the
resulting relief.

3.4.14 Bitmap Settings dialog

In order to use a Bitmap image in DeskProto it needs to be transformed to a
3D Relief: the Bitmap Geometry. In this Bitmap Settings dialog you can set
the parameters for this transformation. The dialog can be reached via button
Bitmap Settings... in the Bitmap Operation parameters dialog. You can also
open it by double clicking the line of the Bitmap Operation in the Tree while
keeping the Control button pressed.
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This  same  dialog  is  used  for  the  Bitmap  Settings  of  the  Default  Bitmap
Operation  parameters,  only  with  an  extra  button  Restore  DeskProto
defaults to reset the original default parameters.

Bitmap XY

Bitmap dimensions
The  dimensions  are  in  fact  the  size  of  the  Relief  in  XY.  As  explained  in
paragraph Bitmap Geometry, DeskProto uses a Z-Grid to create the Relief. In
standard 3D Operations the size of one Z-Grid grid-cell is determined by the
Precision values  in  the  Operation  parameters.   In  choices  one  and  two  this
grid-cell size is also used to set the dimension of the relief.
Note:  For  options  1  and 2:  when you change the Precision,  the  size  of  the
Relief will change as well !

· Calculate from precision scale  1:1.  One  pixel  in  the  image will  be  one
grid-cell  in  the  Z-grid,  with  dimensions  as  set  in  the  Precision  for  this
Operation.

· Calculate  from  precision  on  scale  =.  One  pixel  will  be  converted  to
exactly ... , 1/4 , 1/3 ,  1/2 ,  1 ,  2 ,  3 ,  4 ,  ...  grid cells, as set by the ratio
Pixel  size  /  Cell  size.  The  higher  this  Ratio,  the  larger  the  relief
dimensions.  For  instance  a  Ratio  2:1  means  two  Grid  Cells  for  every
pixel, doubling the dimensions.

· Set  to  bitmap  DPI.  Some  bitmap  files  contain  information  about  their
size: the DPI value (bmp, jpg, png and tiff files may contain DPI info, gif
files do not).  DPI sets how many Dots  Per  Inch must  be  taken.  So  for  a
300  DPI  image,  the  size  of  one  pixel  will  be  set  to  1/300  inch.  The
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number  of  pixels  used  for  one  grid  cell  will  then  be  determined  by  the
Precision. 

   When the bitmap file does not contain DPI information this option will be
grayed out 
· Custom. Here you can enter any dimension as required.

Note: For options 3 and 4: the ratio between Pixel size and Grid cell size is
not necessarily a whole number. So it might be that some Grid cells 'contain'
more pixels than others. This may lead to a Moire pattern like a small ridge
every  few  mm.  When  this  happens  choose  option  2  and  approximate  the
requested dimension as close as possible.

The option Keep aspect ratio takes care that the ratio between X size and Y
size  is  not  changed:  same  ratio  for  both  image  and  relief.  So  when  you
change  the  X  size  with  this  option  checked,  you  will  see  that  the  Y  size
automatically changes too.

Translate XY
The position of the bitmap relief relative to the workpiece zero point can be
changed  here.  By  default  the  relief  is  located  with  it's  lower  left  corner
exactly at XY (0,0), so at the zero point (the Z depends on the settings of the
second  tab  page).  If  this  is  not  the  correct  location  you  can  change  it  by
entering Translation values for X and Y here.

The  button Align to...  leads  to  the  Align  dialog:  a  handy help  to  set  a  few
useful locations.

This  translation  is  valid  only  for  this  Bitmap  Operation.   Note  that  the
Translation and the Transformations is the Part parameters do not influence
the  Bitmap  relief.  So  if  you  want  to  align  the  Bitmap  relief  with  the  Part
geometry  it  might  be  easy  to  select  "None"  for  the  X  and  Y  Translation
settings in the Part parameters.
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Bitmap Z

Z calculation
As  explained  in  paragraph  Bitmap  Geometry,  the  3D  relief  is  created  by
calculating a Z-height for every pixel  in the bitmap image.  Minimum Z for
black pixels, maximum Z for white, and  for gray values the lighter the color
the higher the relief.
(or of course the other way round: white lowest and black highest). This can
be called grey-value to Z-height conversion.
In these two edit boxes you can enter the Min and Max Z-values, to be used
for black and white.

Z-levels relative to part geometry
When the option Project bitmap texture on 3D part geometry is checked,
the  Z-value  that  is  calculated  for  the  color  of  that  pixel  is  added  to  the  Z-
value  of  the  Part  at  that  location.  So  the  3D  relief  is  wrapped  around  the
underlying geometry, using a vertical projection. See the illustration below.
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Here  a  shell  relief  is  created  from  a  bitmap  image,  and  projected  on  the
perfume  bottle  that  you  have  seen  more  often  as  example  part.  This  is  of
course a great design tool to create embossed products. The picture shows a
positive relief: on top of the geometry.
Important  for  such  positive  relief  is  that  of  course  material  is  needed  to
create this relief, so the previous operations used to machine the bottle may
not machine the original bottle shape there. This can be achieved by making
each  operation  a  bitmap  operation,  using  the  same  bitmap  file  and  bitmap
settings  (use Copy Operation).

The  relief  to  be  projected  can  also  be  negative:  when  the  Z-values  range
from  0.0  to  a  negative  value,  the  relief  will  be  subtracted  from  the  part
geometry.
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3.4.15 Align Operation

This  dialog  is  used  for  2D  Operations  and  Bitmap  Operations,  and  can  be
reached  using  the  "Align  to..."  button  in  the  2D  Operation  parameters  and
the  Bitmap  Settings.  As  these  types  of  Operations  both  use  their  own
geometry file, it may be needed to align this geometry with the 3D Geometry
as defined by the Part. This dialog makes such alignment easier.
Only alignment by Translation for X and Y is supported, Z Translation and
rotation are not possible here.

The  thing  to  be  aligned  is  the  Bounding  box  of  the  2D  contours  (for  2D
Operations) respectively of the Bitmap image (for Bitmap Operations). 

This bounding box can be aligned with one of four entities:
· Workpiece zero point. Always possible.
· Part segment. Only available in case a geometry has been loaded.
· Geometry.  The bounding box of  the  geometry.  Only  available  in  case  a

geometry has been loaded.
· Operation segment. Only available if  the Part contains other operations.

In  case  more  than  one  you  need  to  choose  which  of  these  operations  to
use.

For X-Translation three options are present:
· Left means that the Left side of the Bounding box will be aligned with the

left side of the entity.
· Center  means  that  the  Center  side  of  the  Bounding  box  will  be  aligned

with the center of the entity.
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· Right means that the Right side of the Bounding box will be aligned with
the right side of the entity.

For Y-Translation the options are called Back, Center and Front, but are in
fact the same as for X.
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3.5 Create Menu

These  options  control  all  actions  for  calculating  and  saving  NC  toolpaths.
Note the submenu called Extra which offers some extra options. As these are
very  specific  and  not  important  for  most  users  these  commands  have  been
"hidden" in a submenu.

3.5.1 Calculate Toolpaths

With this option you can create the toolpaths for the current part.

In case all operations of the current part are visible (see Visible Operations),
all the toolpaths for the current part  will  be calculated and drawn. When at
least one operation of the current part is not visible, you will be asked if you
only want to use only the visible operations for calculations or if you want to
use all operations.

In case you choose No for ‘all operations’, they all will be made visible after
calculations.

It may be that you grow tired of this warning popping up all the time. Then
you can  disable  "Always  show"  by  removing  the  mark  from  the  checkbox:
the  warning  then  will  no  longer  be  displayed.  You  can  reset  it  on  the
Advanced tab of the Preferences.

In case you want to calculate all  toolpaths for ALL Parts,  then you can use
the command Calculate All Toolpaths in submenu Extra.
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Shortcut:

Toolbar:

3.5.2 Write NC program

With  this  option  you  can  create  an  NC-program-file  for  the  current  part,
which can be sent to the machine to mill a model.

First you will be asked to give a Name for the NC-program file, in a standard
Windows  Save-As  dialog,  in  which  the  correct  file-extension  for  your
machine has been already entered. The only thing you have to do are make
sure the file is being saved in the right place and choose a filename.

The name for the NC file that you enter here may be automatically changed.
When several Operations are involved and when different cutters are used in
these  Operations,  a  tool  change  is  needed.  In  case  your  postprocessor
specifies  to  start  a  new  NC file  at  each  tool  change,  two  or  more  NC files
will  be  written.  Names  for  these  subsequent  files  will  be  automatically
generated. In case you chose the name Test.nc and the two operations were
called  Roughing  and  Finishing,  then  the  first  file  will  be  called
Test#1_Roughing.nc and the second file Test#2_Finishing.nc 

In case all operations of the current part are visible (see Visible Operations),
all  the  toolpaths  of  the  current  part  will  be  calculated  (in  case  they  not
already  had  been).   When  at  least  one  operation  of  the  current  part  is  not
visible,  you  are  asked  if  you  only  want  to  use  the  visible  operations  for
calculations or if you want to use all operations.

In  case  you  choose  No  (so  choose  ‘all  operations’),  they  will  also  all  be
made visible after calculations. 

A next  message  box will  pop-up in  case  one  of  the  Operations  is  part  of  a
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Chain:

Normally  the  answer  will  be  Yes,  meaning  that  you  want  to  write  the
complete  toolpath,  including  all  Operations  that  belong  to  this  chain  of
Operations.

After that, the NC-program(s) will be created,  using the post-processor that
is configured for the machine you have selected in the current part.

Shortcut:

Toolbar:

3.5.3 Estimate machining time

With  this  option  you  let  DeskProto  give  a  rough  estimation  for  the
machining time that it will take to create your part. Do note that this is a very
rough estimation: the actual time will be influenced by many factors. 
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Theoretically  speaking this  time calculation  is  very  easy:  DeskProto  knows
both the length of the toolpath and the feedrate (machining speed), so length
divided by feedrate results in a theoretical machining time. However, the real
machining time is influenced by the answers to questions like:
· How long does the machine’s controller take for linear interpolation

calculations (calculating the separate speeds for each axis, a calculation
that is needed for every movement) ?

· Does the machine keep up its speed, or does it stop in between each two
movements ?

· How fast can the machine accelerate and decelerate ? (especially
important when stopping or slowing down after every movement).

· How fast is the data transfer from computer to machine ? (if you are using
a 9600 baud serial line this factor will seriously slow down the process).

· Does the toolpath consist of small movements or long straight lines ? (in
the first case it will in fact not even reach the desired feedrate as the
distance is too short to accelerate to full speed).

So the resulting real  machining time cannot  even be correctly predicted for
one  particular  machine,  as  it  will  vary  considerably  depending  on  the
characteristics of the geometry. 

DeskProto will convert the Theoretical machining time to an estimated Real
Machining Time by multiplying by a machine dependent  correction factor.
As previously noted, this results in a rough estimation since the actual time is
also dependent on the toolpath characteristics.  The correction factor  can  be
set  at  the  Machine  dialog  (Library  of  Machines).  In  order  to  fine-tune  you
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can time a few toolpaths and correct this factor accordingly.

3.5.4 Calculate Simulation

With this option you can create the Simulation for the current part.

In case all operations of the current part are visible (see Visible Operations)
in the active view, all the Simulations for the current part will be calculated.
When at least one operation of the current part is not visible you are asked if
you  only  want  to  use  only  the  visible  operations  for  calculations  or  if  you
want to use all operations.

In case you choose No for ‘all operations’, all simulations will also be made
visible after calculations.

3.5.5 Extra submenu commands

These  Extra  commands  also  are  options  for  calculating  and  saving  NC
toolpaths. As these Extra commands are very specific and not important for
most users these commands have been "hidden" in a submenu.
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3.5.6 Calculate Z-grids

With this option you can create the Z-grids for the current part.

In case all operations of the current part are visible (see Visible Operations)
in  the  active  view,  all  the  Z-grids  for  the  current  part  will  be  calculated.
When at least one operation of the current part is not visible you are asked if
you  only  want  to  use  only  the  visible  operations  for  calculations  or  if  you
want to use all operations.

In case you choose No for ‘all operations’, they all will be made visible after
calculations.

3.5.7 Calculate All Toolpaths

With this option you can create all Toolpaths for all Parts.

Where the other commands in the Create menu only concern the current part,
this one command influences all parts in the current project. 

All operations for all parts will be calculated, so also the invisible operations
(see Visible Operations).

3.5.8 Send NC program file to machine

For some CNC milling machines this option can be used to directly send the
NC  program  to  the  machine  from  DeskProto.  Most  machines  do  not
support  this,  so  by  default  this  option  is  not  available  (grayed  out).  The
option will become available after configuring an output device (or program)
to be used in the DeskProto Preferences:

In  the  Preferences  (Options  menu)  a  port  like  COM1:  or  LPT1:  can  be
configured as the output device, or a Windows Printer driver. DeskProto will
just copy the contents of your NC program file to the selected port or driver. 
Note:  this  is  possible  for  a  few machines  only,  like  the  machines  made  by
Roland.
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It is also possible to configure an external program to send the NC toolpath
file to. DeskProto will start this program, with the name of the NC-program
file  to  be  used  as  a  command  line  parameter.  The  idea  is  to  configure  the
control  software  of  your  CNC  milling  machine  here.  However  in  fact  you
can  select  any  program,  also  for  instance  a  milling  simulation  software,  or
(for the diehards) a plain text  editor like Notepad to change the NC-program
that DeskProto has just created.

In  DeskProto  the  NC program file  must  be  saved  first.  A  dialog  as  shown
above  will  be  displayed  to  ask  you  for  the  file  you  want  to  transfer.  After
selecting the correct NC program file and pressing Send DeskProto will start
sending. 
In order to send the current toolpaths without first saving an NC file you can
use the command Send current toolpaths to machine.

For  Roland machines  the  above  dialog will  also  remind  you  that  the  green
LED for "View" needs to be off before sending.

If  your  machine  does  not  support  this:  the  standard  route  to  get  the  NC
program  file  to  the  machine  is  to  exit  DeskProto  and  transfer  the  NC  file
using the machine’s own communication software. If this software  runs on a
different  computer  you  will  first  have  to  transfer  the  file  to  that  PC,  via  a
network or by USB stick or CD.

How to prepare the machine will be different for every machine. Still  some
general  guidelines  can  be  given.  Basically  the  following  steps  have  to  be
taken:
1. Fixture a fitting piece of  material  on  the  machine  (look in  the  Geometry

Information dialog for the correct dimensions).
2. Mount  the  correct  tool.  Note:  in  case  you  use  a  different  cutter  than

defined in DeskProto an incorrect part will be produced.
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3. Tell  the  machine  where  to  find  the  material.  In  other  words:  set  the
workpiece zero-point. By default DeskProto uses the left-front-top corner
of the material block as zero-point, you can change this at Translation tab
of the Part Parameters.

4. Send the NC-program file to the controller and start machining.

3.5.9 Send current toolpaths to machine

For some CNC milling machines this option can be used to directly send the
NC  toolpaths  to  the  machine  from  DeskProto.  Most  machines  do  not
support  this,  so  by  default  this  option  is  not  available  (grayed  out).  The
option will become available after configuring an output device (or program)
to be used in the DeskProto Preferences:

In  the  Preferences  (Options  menu)  a  port  like  COM1:  or  LPT1:  can  be
configured as the output device, or a Windows Printer driver. DeskProto will
just copy the contents of your NC program file to the selected port or driver.
Note:  this  is  possible  for  a  few machines  only,  like  the  machines  made  by
Roland.

It is also possible to configure an external program to send the toolpaths to.
DeskProto will then save the toolpaths to a file called TempNC.ext, and then
start  the  external  program  with  the  name  TempNC.ext  as  a  command  line
parameter. The idea is to configure the control software of your CNC milling
machine here. However in fact you can select any program, also for instance
a milling  simulation software,  or  (for  the  diehards)  a  plain  text   editor  like
Notepad to change the NC-program that DeskProto has just created.

A  dialog  as  shown  above  will  be  displayed  to  ask  you  if  the  machine  is
ready. After pressing Send DeskProto will start sending.

For  Roland machines  the  above  dialog will  also  remind  you  that  the  green
LED for "View" needs to be off before sending.

If  your  machine  does  not  support  this:  the  standard  route  to  get  the  NC
program  file  to  the  machine  is  to  exit  DeskProto  and  transfer  the  NC  file
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using the machine’s own communication software. If this software  runs on a
different  computer  you  will  first  have  to  transfer  the  file  to  that  PC,  via  a
network or by USB stick or CD.

How to prepare the machine will be different for every machine. Still  some
general  guidelines  can  be  given.  Basically  the  following  steps  have  to  be
taken:
1. Fixture a fitting piece of  material  on  the  machine  (look in  the  Geometry

Information dialog for the correct dimensions).
2. Mount  the  correct  tool.  Note:  in  case  you  use  a  different  cutter  than

entered in DeskProto an incorrect part will be produced.
3. Tell  the  machine  where  to  find  the  material.  In  other  words:  set  the

workpiece zero-point. By default DeskProto uses the left-front-top corner
of the material block as zero-point, you can change this at Translation tab
of the Part Parameters.

4. Send the NC-program file to the controller and start machining.

3.5.10 Export Z-grid / Simulation as

The Z-grid is a temporary representation of the geometry, used by DeskProto
to calculate the toolpaths.
The  Simulation  has  of  course  a  completely  different  aim,  still  the  internal
representation  in  DeskProto  is  the  same  as  for  the  rendered  Z-grid.  Both
subjects are represented by a large number of triangle on the outer  surface:
polygon data.

As for geometry files in DeskProto the same polygon data representation is
used, it is possible to export the Z-grid and/or the Simulation as a geometry
file.  For  standard  DeskProto  use  this  is  absolutely  not  needed,  however  it
might  be  useful  for  instance  to  use  external  software  to  compare  original
geometry and simulation.
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In the dialog box shown above you can choose how to export the Z-grid. For
exporting  the  Simulation  exactly  the  same  dialog  is  used.  The  following
options can be set:

The File type is either Geometry file, Bitmap file or XYZ file.
The use of a geometry file was described above.
For export as Bitmap file DeskProto will convert the 3D information to 2D
by translating Z-height to gray-value. For each point in the Z-grid one pixel
will  be  made.  The  highest  Z-value  will  be  given  a  white  pixel,  the  lowest
level a black pixel,  and all in-between values an according in-between grey
value. This is in fact the reverse procedure as used for the Bitmap Operation.
An XYZ file is a point cloud file: a number of points in 3D space, each point
represented by its 3 coordinates.

The Subtype sets the file format that has to be used.
For Bitmap files you can choose one of four  well  known bitmap file  types:
BMP. GIF, JPG, PNG and TIFF.
For  Geometry  files  you  can  choose  any  of  the  formats  that  DeskProto
supports for 3D, as described in 3D Geometry.
For XYZ files only one format is supported: ASCII text file, one point with
three coordinates per line.

The function of  File name  will  be clear,  you can either  enter  it  in the edit
box, to be save in the current directory, or browse the file using the button.

In the Operation  field you can select which of the operations will be used.
As each operation  has  one  Z-grid  and  one  Simulation,  you  can  only  select
one operation here.
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3.6 Options Menu

The  Options  menu  gives  access  to  all  configuration  options  of  DeskProto.
For normal use you will not need these options, they are present in case the
defaults set  by  the  installation program should  not  match your  wishes.  The
option used most will be the creation of a new cutter definition, as in many
cases the default cutters will not match your real cutters.

3.6.1 Library of Machines

For  every  NC  program  to  be  created  DeskProto  will  apply  a  machine-
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definition, which should be for the NC milling machine that you are going to
use.  A  number  of  predefined  machine-definitions  have  been  included  with
DeskProto. This is the Library of machines, which has been copied to your
computer during Setup. 
In most cases when you first start DeskProto you can simply select one of the
existing machines in DeskProto's  Welcome screen (only visible the first time
that your start DeskProto). After that you still can change this setting in the
(default) Part parameters. 
However, in case you have a special machine, not present in the list, you can
edit  an  existing  machine  definition  or  define  your  own  machine  in  the
Machine library. 

You can find the Library of machines in the Options menu. When you call
this library a warning message will be displayed that this option is meant for
advanced  users  only.  The  warning  is  optional:  when  you  remove  the  mark
from checkbox "Always show this message" it will no longer be given. You
can restore all warning messages on the Advanced tab of the Preferences (in
group Settings).

After this warning the dialog shown above will pop up. Here you can choose
the  machine  you  want  to  Edit  or  Copy,  and  also  Add  and  Remove
machines.  After  pressing  Add,  Copy  or  Edit  the  Machine  dialog  will  be
shown, containing all parameters to define a machine in DeskProto.

Before  you  start  defining  a  new  machine,  be  sure  a  postprocessor  for  the
machine is already available. If not, build one first with the function Library
of Postprocessors (see the next paragraph). 

A machine definition is stored as a file name .mch in the DeskProto drivers
folder (See Preferences). These files can be copied, for instance to a different
PC to  make the machine  available  on  that  PC as  well.  You can  easily  find
each driver file via command "Open file location" in the context menu: right
click on any driver name in the list for this menu.

The files are in Windows .ini format, and can be changed using a plain editor
like Notepad (changing in DeskProto is safer though).  When changing in an
editor,  it  is  possible  to add comments,  for  instance  on  the file  history.  Any
line that starts with a semicolon (;) is a comment.

note:
Selecting  a  machine  here  does  NOT  change  which  machine  is  selected  for
the  current  part.  To  select  a  machine  for  your  current  part  open  the  Part
Parameters dialog.
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3.6.2 Machine dialog

The Name is the name that will appear in any DeskProto dialog for selecting
a  machine. It needs not be the same as the filename: use a name that clearly
indicates which machine you mean. Each machine must have a unique name.

The  Filename  will  be  used  to  store  the   machine  definition,  using  the  file
extension  .MCH  .  When  editing  an  existing  machine  you  can  no  longer
change the Filename. You can also add and remove machines by adding and
removing MCH files to/from the DeskProto Drivers  directory  (as  set  in  the
Preferences).

The  Postprocessor  you  select  for  this  machine  will  be  used  to  make  the
actual NC programs: see the Postprocessor library.
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Most other values you enter in the Machine dialog are in fact less important
 as they will be used only to check whether the parameters  entered later  do
not  exceed the machines'  capabilities.  So  these  values  do  not  influence  the
resulting toolpath (only the collet diameter does).

The Working area  is  used for validation,  to see if  all  the toolpaths will  fit
within the reach of the machine. Also, when drawing the working area of the
machine, a box of these dimensions is drawn.
The  Collet  diameter  as  defined  at  the  Dimensions  section  is  used  for  the
Collet collision check: to prevent the collet from damaging the model.

The Feedrate  and Spindle speed  Min and Max values set  here are used to
validate  the  speed  settings  in  the  operation  parameters.  The  default  values
are  used  when  selecting  a  different  machine  for  a  part,  to  reset  the  speed
values for all its operations. In case your milling machine requires a feedrate
command  for  rapid  movements,  that  rapid  feedrate  is  determined  by  the
maximum feedrate that is set here.

The Machining time correction factor is exactly what its name suggests: a
factor that is used for this machine to multiply the theoretical machining time
  with in order to get an estimated real Machining time. This factor has to be
a value larger than 1.
The Number of tools is the number of tools that this machine can store and
select  automatically.  Only  machines  that  have  an  automatic  toolchanger
should use this. This option is also used for validation only.

The Advanced settings button leads to the Advanced settings.

3.6.3 Advanced machine settings

This  dialog  is  a  part  of  the  Machine  definition  of  DeskProto,  and  can  be
reached via the Advanced Settings button on the Machine definition dialog.
The  advanced  settings  configure  the  availability  and  dimensions  of  the
optional A and B rotation axes.
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The  option  to  indicate  the  presence  of  a  4th  axis  (rotation  axis)  has  to  be
checked in order to make rotation axis machining available for this machine.
If  not,  the  option "Use  rotation-axis"  in  the  Part  parameters  will  be  grayed
out.
The A-axis is a device that rotates  the part  during machining,  meaning that
you  can  machine  around  the  part.  Image  it  like  a  peace  of  meat  rotating
above a barbecue. This is a very common option on CNC milling machines.
In  DeskProto  only  an  A-axis  is  supported,  which  means  that  the  axis  of
rotation is parallel to the X-axis of the machine.

The  Distance  to  working  table  of  machine  is  the  distance  between  the
actual  rotation  axis  center  line  and  the  machine  table  below:  this  value
determines the maximum block diameter (or in fact  radius) that  still  can be
rotated on this machine.

On  most  machines  the  rotation  axis  can  only  revolve  a  limited  number  of
times,  and  has  to  then  rewind.  Either  because  of  mechanical  limitations  or
because of software limitations. Some machines  allow you to  keep rotating
in  one  direction:  you  then  can  use  the  option  A-values  may  exceed  360
degrees. Note that the angle value that is sent to the machine will then keep
growing (for instance after 100 rotations it will be A = 36000 degrees).

For the 5th axis DeskProto supports two different types.
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The first type of 5th axis is a CNC controlled B-axis: so an axis identical to
the 4th axis,  but  then parallel  to Y instead of parallel  to X.  When both  the
4th  axis  and  this  5th  axis  are  configured  the  result  is  a  five-axis  milling
machine. DeskProto only supports five-axis machines where the part rotates
(so  not  machines  where  the  cutter  rotates).  In  addition  this  5th  axis  can  be
used  only  for  indexed  machining,  using  Start  commands  in  the  Operation
parameters.

The  second  type  of  5th  axis  is  absolutely  not  common:  a  Fourth  axis  tilt
option.  Only a few machines support this. As the icon on the dialog shows
the complete 4th axis unit will be tilted, like a draw-bridge being opened. As
this  rotation  is  around  the  Y-axis,  technically  speaking  this  is  a  B-axis
rotation.  The  advantage  is  that  when  machining  a  ring  this  rotation  allows
you  to  also  machine  the  inside  of  the  ring.   Note  that  DeskProto  only
supports manually controlled 5th axis.
For a picture see the 5th axis tab of the Operation parameters.
If this option is not checked, the option "Use rotation-axis tilt option" in the
Part parameters will be grayed out.

One  extra  parameter  is  available  for  this  option:  the  distance  to  rotation
axis which sets a vertical distance between the A-axis and the B-axis (see the
illustration).   Note  that  for  most  machines  with  a  5th  axis  (like  the  Roland
JWX-10 and MDX-40) this distance is 0.00

The  third  advanced  machine  setting  is  an  optimization  for  the  toolpaths:
Strip curved movements at constant Z-level.  This optimization makes the
NC file shorter by deleting some intermediate points on the toolpath. 
Each toolpath is built using a large number of short straight lines, the length
on  each  line-segment  determined  by  the  Stepsize  along  toolpath.  A  long
straight toolpath will also have been calculated as a series of segments, and
for  such  straight  movement  in  fact  all  intermediate  points  can  be  skipped:
one long line will result in the same cutter movement. This optimization for
straight lines is done automatically in DeskProto.
This  easy  approach  is  not  possible  for  curved  toolpaths  like  Circular  and
Spiral,  as  DeskProto  does  not  support  arc  movements.  A  circular  toolpath
also  is  built  using  a  large  number  of  short  straight  lines,  however  here
deleting  a  point  slightly  changes  the  toolpath.  Still  when  machining  a  flat
horizontal surface such small changes do not matter at all. 
 
For some machines deleting points will make the movement faster and also
smoother, as the controller of that machine does not have enough calculation
power  to  calculate  each  small  movement  in  time  to  keep  the  machine  on
speed.  The result  will  be  a  non-smooth  movement.   For  such  machine  you
may check this option,  then DeskProto will  delete half of the points on the
circular toolpath. The result will be a faster and smoother movement of the
cutter.
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Note that for some other machines checking this option will have a contrary
result and make the movement slower. This will happen for machines with a
very  fast  controller,  that  checks  the  angle  between  two  consecutive  line
segments  on  the  toolpath  and  only  keeps  up  speed  in  case  almost  parallel.
Deleting intermediate  points  will  increase  the  angle  between  the  remaining
line  segments  and  force  the  machine  to  slow down.  So  for  these  machines
you should not check this option.

3.6.4 Library of Postprocessors

Every NC program created by DeskProto is made using a postprocessor. This
is the part of the DeskProto software that is machine-dependant: it creates an
NC program file  that  is  exactly  in  the  format  required  by  your  NC milling
machine. In Windows terminology this piece of software should be called the
device driver for a particular output device, however, in milling terminology
it  is  called  a  Postprocessor  and we will  use  that  name.  DeskProto makes it
possible  to  define  your  own  postprocessor  (which  is  not  possible  for
Windows  drivers  !).  CNC  machinists  call  this  a  '  Configurable
Postprocessor'.

Note that you can not explicitly select the postprocessor that you want to use
as  one  of  the  milling  parameters:  it  will  be  implicitly  selected  when  you
select  the  milling  machine.  Each  milling  machine’s  definition  has
information about the postprocessor to be used.

You can find the Library of postprocessors in the Options menu. When you
call this library a warning message will be displayed that this option is meant
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for advanced users only. The warning is optional: when you remove the mark
from checkbox "Always show this message" it will no longer be given. You
can restore all warning messages on the Advanced tab of the Preferences (in
group Settings).

After this warning the dialog shown above will pop up. In this Library you
can choose the postprocessor you want to Edit  or Copy,  and also Add  and
Remove  a  postprocessor.  After  pressing  Add,  Copy  or  Edit  the
Postprocessor  dialog  will  be  shown,  containing  all  parameters  to  define  a
postprocessor in DeskProto.
Note: as many parameters must be entered for a postprocessor definition, we
recommend not to use Add to create a new postprocessor,  but  to Copy one
that resembles the new one, and then Edit any changes needed. In most cases
the postprocessor “ISO plain G-codes” is a good one to use as a start.  Make
sure to save it using a proper new name.

A  postprocessor  definition  is  stored  as  a  file  name  .ppr  in  the  DeskProto
drivers folder (see Preferences). These files can be copied, for instance to a
different PC to make the postprocessor available on that PC as well. You can
easily find each driver file via command "Open file location" in the context
menu: right click on any driver name in the list for this menu.

The files are in Windows .ini format, and can be changed using a plain editor
like Notepad (changing in DeskProto is safer though).  When changing in an
editor,  it  is  possible  to add comments,  for  instance  on  the file  history.  Any
line that starts with a semicolon (;) is a comment.

Note:
Selecting  a  postprocessor  here  does  NOT  change  which  postprocessor  is
used  to  make  an  NC-program  of  the  current  part.  A  postprocessor
automatically  will  be  selected  by  selecting  a  machine.  To  use  a  particular
machine in your project open the Part Parameters dialog. 

3.6.5 Postprocessor dialog

The postprocessor dialog is divided into 7 tab pages.
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General settings

The Name is the name that will appear in any DeskProto dialog for selecting
a  postprocessor.  It  needs not  be the same as the filename: use a name that
clearly  indicates  which  postprocessor  you  mean.  Each  postprocessor  must
have a unique name.

The Filename  will  be used to store  the  postprocessor definition,  using the
file  extension  .PPR  .  When  editing  an  existing  postprocessor  you  can  no
longer change the Filename. You can also add and remove postprocessors by
adding and removing PPR files to/from the DeskProto Drivers directory (as
set in the Preferences).

When the output file needs Line-numbering, switch on the Use button in the
line numbering group. There you can also define at which line in the file the
numbering  should  start  (Start  at  line),  with  which commands  the  numbers
should Start and End. The Start value is the first number to be issued, and
the  Increment  is  the  difference  between  subsequent  numbers  (so  an
increment of 5 will result in line numbers 1, 6, 11 etc). Leading zeroes sets
the number of positions to be used for the  line-number:  a  value  0  (default)
will output the number only, like in N123, a value of 5 will make DeskProto
use 5 positions, resulting in N00123. Finally the option Stop at line makes it
possible to have one or more unnumbered lines at the end of each file. For a
0 entry all lines are numbered, for 1 the last line is without number, etc. Only
unnumbered End command lines (see next tab page) are possible, so the Stop
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value may not be larger than the number of End-commands on the next tab
page.

In  NC  Program  File,  setting  a  Maximum  size  is  needed  for  some  older
types  of  milling  machines,  like  for  instance  a  Deckel  Dialog  4.  These
machines need to completely read the NC file before they can start, while at
the same time they  have a  very  limited internal  memory  (say  256 Kb).  For
such a machine  the  NC program file  has  to  be  split  up  into  parts  no  larger
than 200 Kb or so. After applying this option DeskProto will  automatically
split the NC-program file into a series of files, which will be named like this:
name, name#2, name#3 etc.
The Extension  will  be used for every NC program file  that  will  be  created
using  this  postprocessor.  It  does  not  influence  the  contents  of  the  file,  just
the file’s name.

The  values  you  enter  at  the  New  line  decimal  values  group  will  be  put
behind  every  line  of  the  output  file.  Default  these  are  set  to  the  values
13,10,0,0  which  will  do  for  almost  any  machine.  The  value  13  stands  for
carriage-return, the value 10 stands for line-feed, and the values which are 0
will not be used by the postprocessor (unless followed by a non-zero value).
Do not touch these values unless you are absolutely sure what your are doing
!

The Decimal Character will be used for any real number in the NC program
files written. For instance the X-coordinate value 3½ will be output as either
3.50 or 3,50

Start / End Settings

This  page  contains  two  editing  windows  called  Start  commands  and  End
commands.  Here you can enter  the lines that  every NC-program must  start
with, and the lines it must end with. This may include things like turning on
the  spindle  motor,  setting  the  units  to  metric  or  imperial,  and  other  global
functions.  Please  look  at  an  existing  postprocessor  for  an  example.  Also
looking in  an  existing NC program file  that  works  OK on your  machine  is
helpful here. 

Movement settings

The Tab page Movement determines the format of all movement commands
in your NC program, which will be 99.99 % of its contents.
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Each movement  (so each  line  in  the  NC file)  is  built  by  a  Start  command,
some Coordinates and an End command. To see their effect: just look at the
Example line to see what will happen. 
The  Start  command  determines  that  this  is  a  linear  line  interpolation
command, the Coordinates determine where to. 
Most machines do not require an End command.
The option Only for first movement makes the Movement command 'modal
': after being given once it stays valid until a different command is given.  As
a result the Start command will not be repeated every line.

Each  of  the  Coordinate  values  for  X,  Y,  Z  (and  A,  B)  may  be  configured
separately. A and B are between brackets as these are not used for three-axis
machines.
A  Start  command  and  an  End  command  can  be  defined  for  each
coordinate. For instance a  character like X, Y or Z to determine the axis, or
a comma to sperate the coordinates..
Positions gives the minimum number of character positions to be used. So if
units is set to 7 and the output is 3.000 two spaces will be added, making the
result in this example  'X   3.000'   
Decimals  gives the number of units  to  be  written  behind  the decimal  point
(or comma), so this affects the precision of the output.
The  output  of  DeskProto  is  either  in  mm  or  inches  (whichever  you
configured). When your output should be in any other unit (like 1/100 mm)
you can change the Factor for the X, Y, Z coordinates. The factor can also
be used to reverse the direction of the axis: by entering -1.00 instead of 1.00
Last option for the coordinates is the Default: that value will be used when a
coordinate  is  Required  (see  below)  but  DeskProto  does  not  yet  know  a
coordinate  value.  A  Default  field  may  be  either  empty  (used  for  most
machines), a number (which will be interpreted as coordinate value, written
to the NC file  conform the specifications  in  the  column above),  or  a  string
enclosed  with  quotes  (which  will  be  literally  copied  to  the  NC  file,  for
instance "X6p", for Datron machines).. So note that 0 and "0" will be treated
differently.

Write only if changed means that coordinate values are only written in case
changed.  So  the  command  "G1  Y20.0"  means  that  the  values  for  X  and  Z
will remain the same for this movement.
Also sign positive values adds a "+" in front of every positive coordinate.
Skip  trailing  zeros  makes  the  file’s  size  smaller,  by  removing  any
insignificant zero in a coordinate value. For instance 3.400 becomes 3.4 and
3.000 becomes 3. Again also see the example line.

Using the Order/Required edit field you can change the order of the X,  Y,
Z, A and B coordinates in the output. Each of these five characters should be
present in this edit box, and all exactly one time.
In this same field you can make a coordinate value Required, by adding a +
in front of the character. So when you enter +X+Y+Z+AB this means that X,
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Y,  Z  and  A  are  required.  This  is  needed  for  machines  where  the  sequence
number on the line indicates the axis for which each coordinate is meant.
For  instance  "G1  X10  Z10  A  180"  on  such  machine  without  the  required
field would become "MOVE 10, 10, 180", which would send the Y to 10 and
the Z to 180. With the required field the result is "MOVE 10, , 10, 180" (note
the extra comma).

In  the  Units  group  you  can  choose  between  mm  and  inches  for  the
coordinate values to be converted to. Make sure that your machine uses the
same units:  for some machines you need to  explicitly  give  the  command G
70  (inches)  or  G71  (mm).  You  can  do  so  at  the  "Start  commands'  of  the
Start/End  tab  page.  This  postprocessor  setting  is  independent  for  the  Units
setting  in  the  DeskProto  Preferences.    This  makes  sure  that  inch  workers
still can use a metric machine, and the other way round.
The Angle units are only used for rotation axis machining, so do not apply if
your machine does not have a rotation axis.

Do note that the (A) and (B) columns and the Angle units  are only used in
case  a  4th  axis  /  5th  axis  is  both  present  and  selected.  For  three  axis
machines you can just ignore the values entered here.

Rapid Settings

Rapid  movements  are  used  to  save  milling  time  by  moving  as  fast  as  the
machine  can  travel.  These  are  used  by  DeskProto  for  positioning  moves
above the top of the material block. Rapid movements can be achieved either
by using a special Rapid Start command,  or by first  changing the feedrate
and then using the normal Movement command, at the maximum feedrate
of  the  machine.  This  maximum  feedrate  value  can  be  changed  at  the
Machine dialog.
The  option  Only  for  first  movement  makes  the  Rapid  command  modal:
after been given once it stays valid until a different command is given.

Feedrate settings:

Feedrate commands will only be output if the option Use is switched on.
The option Write only if changed will be on for most machines: if  not the
feedrate will be output on every movement line.
The effect of using the Start-command and End-command can best be seen
by looking at the example line at the bottom of this tab page.
Positions stands for the minimum number of positions that are occupied by
the value of the feedrate.
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Decimals stands for the number of characters behind the point (or comma).
The Method setting is self-explanatory.
The settings of Units are only used to be able to show the correct units in the
dialogs,  whenever  you  have  to  enter  a  feedrate.  DeskProto  does  not
"understand" them, it just copies the number in the Operation parameters to
the NC program file.

Note that an invisible special option is available in the fields Start command
and End command: you can enter new lines when needed to create a multi-
line Feedrate command. Entering the string “^\N” will start a new line,  and
entering the string “^\V” will again output the actual feedrate value.

For  Instance:  entering  the string  “  F  ^\V^\N G”  in  the  Start  command  edit
box will cause DeskProto to write a two-line Feedrate command as follows:
 F 500
 G 500
(given that the actual Feedrate value to be output is 500).

Spindle speed settings

Spindle commands will only be output if the option Use is switched on.
The option Write only if changed will be on for most machines: if  not the
spindle speed will be output on every movement line.
The effect of using the Start-command and End-command can best be seen
by looking at the example line at the bottom of this tab page.
Positions stands for the minimum number of positions that are occupied by
the value of the spindle speed.
Decimals stands for the number of characters behind the point (or comma).
The Method setting is self-explanatory.

Note that an invisible special option is available in the fields Start command
and End command: you can enter new lines when needed to create a multi-
line Spindle speed command. Entering the string “^\N” will start a new line,
and entering the string “^\V” will again output the actual feedrate value.

For  Instance:  entering  the  string  “  S  ^\V^\N R”  in  the  Start  command  edit
box  will  cause  DeskProto  to  write  a  two-line  Spindle  speed  command  as
follows:
 S 8000
 R 8000
Given that the actual Spindle speed value to be output is 8000.

Toolchange settings
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DeskProto will create one NC program file for one part. However, for every
operation  a  different  cutter  can  be  used,  so  in  case  you  are  using  different
cutters  in  one  part  (which  would  mean  in  one  NC  program)  you  have  to
define  what  should  happen  at  a  tool  change.  Just  choose  one  of  the  three
options. 

Use  change-command  in  NC  program  can  be  used  in  case  the  milling
machine is equipped with an automatic tool change (ATC = Automatic Tool
Changer). To define the actual command you can use one, two or three lines,
as  some  controllers  require  separate  lines  to  select  the  next  cutter  and  to
actually  load  it.  For  each  of  these  lines  you  can  select  whether  or  not  the
Tool Nr has to be present on the line. See the Example line on the bottom of
this dialog for an example. In the illustration above note the space just before
the “M6”. This is just an example command: actual commands will differ per
machine.
The  same  special  options  ^\V  and  ^\N  as  just  described  for  Feedrate  are
available here as well, so if needed you can use more than three lines.

Note:
For  this  method  be  sure  that  the  ‘number  of  tools’  of  the  machine  is  set
correctly.  You  can  do  that  at  the  Machine  dialog.  Also  be  sure  that  the
cutters  that  you  use  in  DeskProto  have  the  correct  ‘number  in  machine’
parameter.  You can set  that  at  the Cutter  dialog.  You also have to  check  if
the  correct  cutter  is  indeed  loaded  on  this  position  of  the  machine’s  tool
changer: DeskProto just loads Tool No “N” without knowing if it is indeed
the right cutter.

Use pause-command in NC program  lets  you change the cutter  manually,
however within the same NC program. The Pause command has to stop the
machine for this purpose. You must define the pause command in the pause
field. For most machines such command is not available though.

Use new NC program  will  cause a new NC program to be started. If  your
machine does not support a tool change or if  you do not know, it is best to
choose new NC program file. After ending the first file you can then change
the cutter, correct the zero position for the length of the new cutter, and start
the second NC program file.
When writing such multiple NC program file, names for the subsequent files
will be automatically generated. In case you chose the name Test.nc and the
two operations were called Roughing and Finishing, then the first file will be
called Test#1_Roughing.nc and the second file Test#2_Finishing.nc 

Note:
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Use new NC program is  the  safest,  and thus  the  DeskProto default  for  this
option

3.6.6 Library of Cutters

For  every  NC program to  be  created  (more  accurately  for  every  operation)
you  will  need  to  select  a  cutter.  Obviously  the  cutter  that  you  select  for
DeskProto’s calculations must be available for the actual milling process. A
number of predefined cutter-definitions have been included with DeskProto.
This  is  the  Library  of  cutters,  which  has  been  copied  to  your  computer
during  Setup.  In  many cases  you can  just  select  one  of  the  existing  cutters
when editing the operation-parameters. However in case you need a special
cutter  you  can  change  an  existing  cutter  or  define  your  own  with  this
function 'Cutter Library'.

You can find the Library of cutters in the Options menu. When you call this
library  a  warning  message  will  be  displayed  that  this  option  is  meant  for
advanced  users  only.  The  warning  is  optional:  when  you  remove  the  mark
from checkbox "Always show this message" it will no longer be given. You
can restore all warning messages on the Advanced tab of the Preferences (in
group Settings).

After this warning the dialog shown above will pop up. Here you can choose
the  cutting  tool  you  want  to  Edit  or  Copy,  and  also  Add  and  Remove
cutters.  After  pressing  Add,  Copy or  Edit  the  Cutter  dialog  will  be  shown,
containing all parameters to define a cutter in DeskProto.

A  cutter  definition  is  stored  as  a  file  name  .ctr  in  the  DeskProto  drivers
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folder (see Preferences). These files can be copied, for instance to a different
PC to make the cutter available on that PC as well. You can easily find each
driver file via command "Open file location" in the context menu: right click
on any driver name in the list for this menu.

The files are in Windows .ini format, and can be changed using a plain editor
like Notepad (changing in DeskProto is safer though).  When changing in an
editor,  it  is  possible  to add comments,  for  instance  on  the file  history.  Any
line that starts with a semicolon (;) is a comment.

Note:
Selecting  a  cutter  here  does  NOT  change  which  cutter  is  selected  for  the
operations. To select a cutter to machine with open the Operation Parameters
dialog.

3.6.7 Cutter dialog
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The Name is the name that will appear in any DeskProto dialog for selecting
a   cutter.  It  need  not  be  the  same  as  the  filename:  use  a  name  that  clearly
indicates  which  cutter  you  mean.  Show  in  this  Name  whether  you  mean
radius  or  diameter  for  any  number  (you  will  forget  if   'Ball6'  means  R6  or
D6). Each cutter must have a unique name.
The  Filename  will  be  used  to  store  the   cutter  definition,  using  the  file
extension .CTR . When editing an existing cutter you can no longer change
the Filename. You can also add and remove cutters by adding and removing
CTR files to/from the DeskProto Drivers directory (as set in the Preferences).

DeskProto offers  six Types of cutter,  that  are  variants  of  three  basic  types:
flat (square cutter), conic (sharp point), and ball (ballnose cutter). Both conic
and ball can be given a flat tool-tip, conic can be given a ballnose tooltip as
well.  Depending on the type you choose some of the Dimensions  might  be
disabled. For example a flat cutter does not have a tip-angle.
For each type you can also check the option Multiple diameter, to define a
tool of which the shaft (the part that fits in the collet chuck) is thicker than
the  flute  (the  part  that  actually  cuts).  This  is  a  commonly  used  model  for
small  cutters.  When  correctly  defined,  DeskProto  will  make  sure  that  the
thick shaft does not damage your model at vertical surfaces.

Just  look  at  the  drawing  in  the  Preview  to  see  the  cutter  that  you  have
defined.
The  image  below  gives  an  explanation  of  most  terms  used  for  the
Dimensions.
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The Free length is the length of the part of the tool below the collet. So this
is  not  the  total  length  of  the  cutter.  The  free  length  is  not  constant,  as  it
depends  on  how far  you insert  the  cutter  in  the  collet.  DeskProto  uses  this
parameter only for the collet collision check.
The meaning of Shaft diameter  will be clear. For single diameter tools  the
Flute diameter is identical to this value.

The  Slope  Angle  is  available  only  for  multiple  diameter  cutters.  It  defines
the  transition  between  the thick  shaft  and the thinner  flute,  which  for  most
cutter has a conical shape.

The  Flute  length  is  only  available  for  multiple  diameter  tools,  as  it  is  the
length of the small diameter part which is called the flute of the cutter..
The Flute diameter (or flute diameter) is the nominal diameter of the cutter,
used for  the  calculations  (do  not  confuse  with  Radius).  It  is  only  available
for multiple diameter tools, as otherwise it is the same as the shaft diameter.

The Cutting length is the length of that part of the tool that actually cuts: it
will  be used to calculate Layers  as  the  tool  may not   sink  into the  material
deeper than this value.  In case you do not  select  Roughing  then  DeskProto
will automatically do so for the first Operation.
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The Tip diameter  is  the diameter of the  flat  tip  for  cutter  types  with  a  flat
tip,  and  the  diameter  of  the  ballnose  tip  for  Ball/Conic  cutters.  So  for
instance a Ball/Flat cutter with diameter 6 and tip 4 will have a radius 1 left
(this type of cutter sometimes is called bull nose).
A  special  cutter  type  can  be  defined  by  choosing  “Ball  with  flat  tip”  and
setting  the  Tip  diameter  larger  than  the  Shaft  diameter  (which  normally  is
nonsense).  This  creates  a  special  cutter  type  “Curved   tip”  as  a  result.  The
preview drawing shows what will happen.

The Tip angle  is  for  conic  cutters  only:  it  is  the  angle  between  the cutting
edge  and  the  center-line  of  the  tool  (so  the  ‘grinding  angle’,  not  the
‘included  angle’).  Here  as  well:  just  try  and  look  what  happens  in  the
Preview.  You  can  also  use  this  parameter  to  define  special  tapered  cutters
having a draft angle of say 3 degrees.

The Preview shows you the currently defined cutter-definition in a drawing,
which is a very convenient help when setting the parameters in this dialog. A
preview  can  of  course  only  be  drawn  when  correct  dimensions  have  been
entered  first  (for  invalid  setting  a  red  cross  will  be  drawn).  The  dashed
horizontal  line  shows  the  cutting  length,  the  two  horizontal  lines  at  top
indicate the collet and show the free length.

The Number in machine indicates on which position of the Automatic Tool
Changer this cutter needs to be loaded. So this is useful only when you are
using  a  machine  that  supports  automatic  toolchange.  The  number  will  be
used for any toolchange command written in the NC-program file.
Important:
This number can be different for each machine and even for each situation,
as the operator has to load the correct cutter in the correct location.

The  Maximum  spindlespeed  is  used  only  for  validation  of  your  projects
(some  larger  cutters  may  not  rotate  at  high  rpm  as  these  are  insufficiently
balanced).

The  option  Automatically  set  speeds  when  selecting  this  cutter  may  be
very handy when  you  have  standard  milling  conditions.  For  instance  when
you always machine in wax (jewelry wax models) you may want  to  always
use  the  same  low feedrate  and  high  spindle  speed  for  a  certain  thin  cutter.
 Then you can define these two speeds here, and in the Operation parameters
DeskProto  will  automatically  set  these  values  for  Feedrate  and
Spindlespeed when this cutter is selected.

Note  that  for  the  Feedrate  DeskProto  will  just  copy  the  number  that  you
enter in this dialog to the NC file, without understanding it's units. So when
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enter "10" and use this cutter on a m/min machine the feedrate will be 10 m/
min,  on  a  mm/sec  machine  it  will  be  10  mm/sec.  A  large  difference  !!!
 DeskProto could show the units used by your current machine, however that
would give a false sense of security as they would be valid for that machine
only.

3.6.8 Default project

After  choosing  this  option,  first  you  will  be  warned  that  whatever  you
change  here  will  influence  all  new  projects  that  you  create  later.   The
warning  is  optional:  when  you  remove  the  mark  from  checkbox  "Always
show this message" it  will  no longer be given.  You can restore all  warning
messages on the Advanced tab of the Preferences (in group Settings).

The dialog that pops up is equal to the Project Parameters dialog, it will thus
not be explained here. The difference is that this function adjusts the default
project settings, that will be used for every new Project that is created.

The functionality offered in this dialog is  very  limited:  it  is  not  possible  to
define  a  default  geometry,  nor  more  than  one  part.  Only  the  options  Flip
normals and Skip backfaces are allowed, which are very useful as default in
case your CAD system always produces incorrect STL files. The DeskProto
default is that both Flip Normals and Skip Backfaces are off.

Creating  two  or  more  Parts  as  default  is  not  possible  as  that  would  make
things way too complicated (for instance which of the operations then would
be the actual default one...)
A default project file specification is not possible as that would conflict with
the default Part and the default Operations.
Note  that  for  repeating  jobs  can  also  achieve  much  using  Command  line
parameters,  by Scripting,  and by auto-loading  a  template  project  file  which
may have more Parts. For instance for automation of two sided machining.

Note:
The default project parameters  are stored in the registry.  Each user  has his/
her own default settings stored there.
As it is possible to completely mess up these settings, making it very hard to
use  DeskProto,  an  extra  button is  supplied  here  to  Restore  the  DeskProto
defaults for all parameters.

3.6.9 Default part

After  choosing  this  option,  first  you  will  be  warned  that  whatever  you
change here will influence all new parts that you create later. The warning is
optional:  when  you  remove  the  mark  from  checkbox  "Always  show  this
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message" it will no longer be given. You can restore all warning messages on
the Advanced tab of the Preferences (in group Settings).

The dialog that  then  pops up  is  equal  to  the  Part  Parameters  dialog,  it  will
thus  not  be  explained  here.  The  difference  is  that  this  function  adjusts  the
default part settings, that will be used for every new Part. This is the option
to  use  for  instance  to  have  your  milling  machine  automatically  selected,
when you want to use more than one operation for all your parts, when you
have a machine that needs a specific translation method, etc, etc.

These default parameters will be stored in the Windows registry, and will be
different  for  every  user.  As  it  is  possible  to  completely  mess  up  these
settings,  making  it  very  hard  to  use  DeskProto,  an  extra  button  is  supplied
here to Restore the DeskProto defaults  for all  parameters.  After using this
button you will have to again choose your machine as the default machine.

3.6.10 Default Operation (3D)

After  choosing  this  option,  first  you  will  be  warned  that  whatever  you
change  here  will  influence  all  new  operations  that  you  create  later.  The
warning  is  optional:  when  you  remove  the  mark  from  checkbox  "Always
show this message" it  will  no longer be given.  You can restore all  warning
messages on the Advanced tab of the Preferences (in group Settings).

The dialog that then pops up is equal to the Operation Parameters dialog, it
will  thus  not  be  explained here.  The difference  is  that  this  function  adjusts
the  default  operation  settings,  that  will  be  used  for  every  new  Operation.
This  is  the  option  to  use  for  instance  in  case  you  want  a  specific  cutter
automatically selected, need a specific feedrate or spindle speed, etc, etc.

In case more than one default operation has been defined in the default part,
first  a  dialog  is  displayed  in  which  you  can  select  one  of  the  default
operations.
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These default parameters will be stored in the Windows registry, and will be
different  for  every  user.  As  it  is  possible  to  completely  mess  up  these
settings,  making  it  very  hard  to  use  DeskProto,  an  extra  button  is  supplied
here to Restore the DeskProto defaults for all parameters.

3.6.11 Default 2D Operation

After  choosing  this  option,  first  you  will  be  warned  that  whatever  you
change here will  influence all  new 2D operations that you create later.  The
warning  is  optional:  when  you  remove  the  mark  from  checkbox  "Always
show this message" it  will  no longer be given.  You can restore all  warning
messages on the Advanced tab of the Preferences (in group Settings).

The dialog that then pops up is equal to the 2D Operation Parameters dialog,
it will thus not be explained here. The difference is that this function adjusts
the  default  2D  operation  settings,  that  will  be  used  for  every  new  2D
Operation. This is the option to use for instance in case you want a specific
cutter  automatically selected,  need a specific feedrate  or  spindle  speed,  etc,
etc. It is not possible to set a default 2D file.

In case more than one default 2D Operation has been defined in the default
part,  first  a  dialog  is  displayed  in  which  you  can  select  one  of  the  default
operations.
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These default parameters will be stored in the Windows registry, and will be
different for every user. 
As it is possible to completely mess up these settings, making it very hard to
use  DeskProto,  an  extra  button is  supplied  here  to  Restore  the  DeskProto
defaults for all parameters.

3.6.12 Default Bitmap Operation

After  choosing  this  option,  first  you  will  be  warned  that  whatever  you
change here  will  influence  all  new Bitmap operations  that  you  create  later.
The warning is optional: when you remove the mark from checkbox "Always
show this message" it  will  no longer be given.  You can restore all  warning
messages on the Advanced tab of the Preferences (in group Settings).

The  dialog  that  then  pops  up  is  equal  to  the  Bitmap  Operation  Parameters
dialog, it will thus not be explained here. The difference is that this function
adjusts the default  bitmap operation parameters,  that  will  be used for  every
new  Bitmap  Operation.  This  is  the  option  to  use  for  instance  in  case  you
want  a  specific  cutter  automatically  selected,  need  a  specific  feedrate  or
spindle speed, etc, etc. It is not possible to set a default Bitmap file.

In  the  Default  Bitmap  Operation  dialog  you  can  also  open  the  Default
Bitmap settings: a dialog that is equal to the Bitmap Settings dialog,

In  case  more  than  one  default  Bitmap  Operation  has  been  defined  in  the
default  part,  first  a  dialog  is  displayed  in  which  you  can  select  one  of  the
default operations.
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These default parameters will be stored in the Windows registry, and will be
different for every user. 
As it is possible to completely mess up these settings, making it very hard to
use  DeskProto,  an  extra  button is  supplied  here  to  Restore  the  DeskProto
defaults for all parameters.
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3.6.13 Default View dialog

The default view settings are used for any new project and any new part. 
They are also used for the command and button Use Default View.

After choosing this option, first you will be warned that this option will only
influence the defaults. The warning is optional: when you remove the mark
from checkbox "Always show this message" it will no longer be given. You
can restore all warning messages on the Advanced tab of the Preferences (in
group Settings).

To edit  the parameters  of the default  view a  special  dialog is  used,  as  both
the dialogs to change the Subjects and the Viewpoint contain parameters that
are not suitable as default parameters. 
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Subjects
Here it’s possible to set what will be shown initially. For an explanation of
the subjects see Subjects dialog. Displaying Z-grids, toolpaths or simulations
is  not  possible  in  the  default  view,  as  these  subjects  have  to  be  calculated
first.

Viewpoint
Only the rotation can be set here. Zooming of the default view will always be
100%, panning will be set to zero. 
After  changing  the  default  rotation  you  can  restore  the  original  DeskProto
defaults  (which  are  stored  internally  in  DeskProto  and  which  can  not  be
changed) by pressing the appropriate button. 
Finally:  instead  of  typing  three  values  for  X,  Y  and  Z  rotation,  you  can
manually adjust the rotation in your current view until you like it, and then
copy the settings, by pressing the button Copy from Active View.

Note:
The default view settings are stored in the registry. Each user has his/her own
default settings stored there.

3.6.14 Preferences dialog

This is  a  dialog in  which you can  edit  DeskProto's  preferences.  The dialog
consists of 5 Tab pages.
These  preferences  are  stored  in  the  registry.  Each  user  has  its  own
preferences stored there.

General tab page
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The File-locations  listed here are the directories (folders)  where DeskProto
looks for the specified file types. These directories can be changed by typing
the  new directory’s  complete  path-specification (i.e.:  C:\DeskProto\  )  or  by
using the Browse button. 

Data is the location where DeskProto will initiate the Load and Save dialog
boxes.  The  default  setting  for  this  option  is  the  Documents  (or  My
Documents) folder: a standard location in Windows. In this default location
no sample files and projects are present: quickest way to load a sample is via
the DeskProto Start Screen (check "Use samples folder"). 

The Data directory comes with the extra option Save last used directory on
exit, making DeskProto remember which directory you were working in the
last time you used DeskProto.  While working with DeskProto,  so until  you
exit, it will remember this directory (the "current directory") anyway.

Drivers  is  the  location  from  which  DeskProto  will  load  the  drivers
(machines, postprocessors and cutters) while starting up the application. Any
valid new files that you copy to this directory will be automatically available
after  (re)starting  DeskProto.  Changing  this  location  will  make  DeskProto
unload all drivers (not delete them from disk though) and load drivers from
the  new location (if  available).  Because  the  open  project  uses  drivers  from
that  library,  the  open  project  will  be  closed  before  making  this  change.  A
new empty project  will  be  created after  the  new library  has  been loaded  or
created at the new location.

The default  setting for the folder  Drivers  is  in  the  \ProgramData\   folder:  a
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standard  location  in  Windows  meant  for  this  type  of  files  (as  in  recent
Windows versions users without administrative privileges cannot access any
folders in \Program Files\ ).
The actual location of this folder differs per Windows version:
In Windows XP this folder is called: C:\Documents  and  Settings\All
Users\Application Data\
In Windows Vista, Win7 and Win8 the folder is located in the root:  C:
\ProgramData\
For some reason this had been made a hidden directory: to make it visible in
File Explorer ('My Computer”) open Tools >> Folder Options >> tab View
and select the option “Show hidden files and directories”).
In Win Vista Win7 and Win8 this tab View can be  found via  Organize  >>
Folder Options.

As  this  is  a  rather  confusing  situation  it  may  be  difficult  to  restore  the
DeskProto  default  after  a  change.  So  we  have  added  the  button  Use
DeskProto defaults to make resetting the file locations easy.

Using  the  Measurement  unit  you  can  choose  between   metric  (mm)  and
 imperial  (inches)  for  your  DeskProto  configuration.  As  the  STL  files  that
you use do not state the units used, DeskProto has to assume that they are in
the same unit as the one you define here. 

Note:  also check your milling machine’s  documentation  to  see  which units
are  needed  for  the  machine,  as  that  setting  is  independent  from  this
preferences setting. Some machines expect NC files in mm, some will expect
files  to  be  in  inches.  Make  sure  to  configure  your  postprocessor  to  use  the
correct units: this is completely independent of the choice that you make in
these Preferences. 
A few places that you can check in case of problems:
This Measurement unit in Options> Preferences> General tab, mm or inch.
The Distance unit in Options> Postproc> Movement tab, mm or inch.
The Feedrate units in Options> Postproc> Feedrate tab (many more options)
When your machine uses G-codes you can also check the Start commands of
your Postprocessor: 
If working in mm:  use "G21 or G71 mm" to set the machine to use mm.
If working in inch:  use "G20 or G70 inch" to set the machine to use inches.

Other  Available  languages  than  English  are  only  present  in  case  you have
copied the appropriate files  for a certain language to the  Lang subdirectory
of  the  DeskProto  installation  directory  (for  instance  C:\Program  Files
\DeskProto  6.1\Lang).  Normally  this  will  be  done  automatically  by  the
translated Setup.
For  each  language  at  least  the  following  file  is  needed  (containing  the
 translated  resources):  ResourcesName.dll  in  which  “name”  stands  for  the
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language.  For  instance  “Deutsch”  for  German  needs  the  file
ResourcesDeutsch.dll 
In addition translated Help files and cutter files are needed.
Do contact your local dealer to see if a translated version for your language
is available.

Colors tab page

The  tab  page  Colors  makes  it  possible  to  customize  all  colors  used  on  the
DeskProto screen: just use a [...] button to change any color shown. As you
can see different operations can be assigned different colors. In case of many
operations: the color  for operation No. 1 will  also be used for No. 5,  9,  13
etc. 

Checking  the  option  Use  fog  applies  fog  to  all  drawings  using  lines.  This
technique,  also  called  'depth  cueing',  improves  the  perception  of  depth  on
your  two-dimensional  screen  by  making  distant  lines  more  vague  (as  if
obscured by a light fog). 
On  Black  and  White  printers  this  may  cause  the  lines  to  be  printed  like
dotted  lines,  resulting  in  a  blurry  print.  Therefore  you  might  want  to
temporarily  switch  off  the  fog  when  printing.  On  computers  with  a  video
card which does not support OpenGL this option might not have effect.

In case you have made a giant mess of your color settings you can press Use
DeskProto defaults to restore the default settings of DeskProto for all colors
(which are stored internally in DeskProto and which can not be changed).
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NC Output tab page

These preferences are meant to configure the NC-output, so the exporting of
NC files by DeskProto.

With  the  first  preference  you  can  fine-tune  the  output  path.  Normally
DeskProto exports the NC files to the same directory from where the project
and/or the geometry file  were opened (the 'current'  directory).  This is  when
the option Use data path is checked.
After unchecking this option you can type or Browse a fixed directory to be
used for writing the NC files to. This is handy in case you want all NC files
to be stored on the same place (for instance a directory of the PC next to the
milling machine).

The  second  preference  refers  to  the  commands  Send  NC-program  to
Machine  and  Send  current  toolpaths  to  Machine  in  the  Create  menu.  By
default  these  two  commands  are  disabled,  here  you  can   enable  them  by
determining which process has to be started after giving the command.

Send to
This  combo  box  shows  four  types  of  choices:  Printer  Driver,  a  Hardware
Output port, an External program or None. Each option comes with it's own
sub-settings:

- In case you configure None, the commands Send NC-program To Machine
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and Send current  toolpaths  to  Machine   will  not  be  available  (grayed  out).
No sub-settings are available.

- Selecting a Hardware Port (either serial COM.. or parallel LPT..) means
that  the  NC-program  will  just  be  copied  to  that  port  after  the  command  is
given.  This  can  be  for  example  LPT1  or  COM2.  For  a  Centronics  Printer
port  (LPT1  or  LPT2)  no  settings  are  needed.  In  case  of  a  COM-port  you
need  to  configure  this  port  according  to  the  specifications  of  the  milling
machine  Use  the  button  Setup  for  the  standard  Windows  COM  port
settings  dialog (setting values like ‘Baud Rate’,  ‘Data Bits’,  ‘Parity’,  ‘Stop
Bits’ & ‘Flow Control’).

- Selecting “Use Printer Driver” can be used for machines that are accessed
via their own printer drivers (for instance most Roland machines). This also
works for USB machines that cannot be accessed via a Port. Here you have
to use the Setup button to select the correct printer driver.  Take care not to
select  a  ‘normal’  printer  as  this  will  results  in  hundreds  of  pages  to  be
printed on paper.
After  sending  the  NC-file  to  the  machine  this  way,  the  job  status  can  be
followed using the standard Windows Printer Properties tools.
On some PC's it might be needed to select  “Print  directly to printer” in the
Advanced Printer properties of the selected printer driver.

-  After  selecting  the  option  External  program,  you  can  use  the  Browse
button to define which program has to be used. Here you can browse to any
program file (EXE of COM) on your computer. After the command Send NC
Program to machine, DeskProto will start this program, with the name of the
NC-program file to be used as command line parameter. 
The idea is to configure the control software of your CNC milling machine
here. However in fact you can select any program, also for instance a milling
simulation software, or (for the diehards) a plain text editor like Notepad to
change the NC-program that DeskProto has just created.
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Wizard tab page

The  tab  page  Wizard  contains  a  preference  that  you  can  set  for  the   Two-
Sided  Milling  Wizard:  the  size  of  the  material  block.  This  tab  page  is  not
available in the Entry Edition. Two options are available:

· Floating size. The block size needed of course depends on the size of the
part  that  you  want  to  create.  DeskProto  offers  a  flexible  solution  here,
called Floating size: around the part (including support blocks) a frame is
added of a certain thickness. In the edit boxes for X and Y you can enter
which  frame thickness to use. 

· Fixed size is useful in case all your parts have almost the same size: you
then can use standard blocks of a certain size, to be defined in the X and
Y edit box.

Only the X and Y block size can be set  here,  the Z dimension is  set  in the
wizard.
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Advanced tab page

This tab page of the Preferences contains two different sub-pages, which you
can select by making active (blue background) either the line Graphics or the
line Settings in the list on the left.
First  the  Graphics  preferences  will  be  explained,  shown  in  the  picture
above.

Dynamic drawing
Dynamic drawing is the drawing that is done while the left mouse button is
pressed inside the view window or while using the thumb-wheels. Choosing
the  option  Draw  limited  number  of  entities  will  decrease  the  number  of
entities that is dynamically drawn, and so will increase the speed with which
you can  move the geometry  and other  subjects  (the  term entities  used  here
stands  for  points,  lines  and  facets).  If  several  Subjects  are  drawn,  the
maximum number that you enter is split up over all visible subjects. In case
you set the number of entities to zero only the bounding box of the geometry
will be displayed during dynamic drawing. 
The optimum number of entities depends on the capabilities of your graphics
card:  an  OpenGL  card  featuring  hardware  rotation  etc.  can  handle  a  large
number of entities at high speed. For a simple graphics card the number must
be set lower to achieve real time results.

Graphics options are in fact OpenGL options:

Drawings  on  the  screen  are  displayed  using  pixels,  for  instance  a  line  is
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drawn as a series of black pixels on a white screen. As the pixels are located
in  a  rectangular  grid,  a  curved  line  will  be  displayed  as  a  staircase.  Anti-
Aliasing is a technique to make these staircases less visible using pixels with
an  intermediate  color  value:  in  the  example  just  mentioned  this  will  be  in
various grades of grey. This shade of grey to be used for a pixel is calculated
using multi-sampling: multiple grey values are calculated (for locations close
to the actual pixel) and the average resulting grey value is used. 

The more samples are used,  the better  the resulting quality,  however it  will
be slower too. You can set  this  Sample  rate  as  a  detail  setting:  the  combo
box will show only the rates supported by your graphics card.  We advise a
rate  of  four:  higher  rates  will  cost  much  time  where  the  difference  will  be
marginal.
In  case  your  graphics  card  does  not  support  anti-aliasing  at  all,  this  option
will have been grayed out.

A  simulation  in  DeskProto  is  calculated  and  drawn  as  a  large  set  of  small
triangles (defining it's outer surface). This is the same type of entity as used
to  draw  the  geometry.  Only  the  number  of  triangles  in  most  cases  is  way
larger, making the drawing quite slow.
The option Use buffering  is  meant to optimize the  drawing  speed  for  your
typical simulations.

Normally (so without buffering) the simulation's triangles are generated "on
the  fly"  (so  while  drawing),  based  on  a  grid-type  model  of  the  simulation.
The graphics card then just makes the 2D picture, and does not keep the 3D
data in it's video memory. This does of course cost much time: for each new
view all  triangles  have to  again  be  generated and  sent  over  to  the  graphics
card.

Using  Buffering  means  that  all  triangles  are  stored  in  RAM  as  a  sort  of
"geometry model", and for drawing are sent to the 3D video memory of the
graphics card (a 'buffer'). Changing the view then can be completely handled
by  the  graphics  card:  no  need  to  again  send  all  data  from  the  application.
Which is of course MUCH quicker.
The  drawback  however  is  that  much  more  memory  is  needed  for  this
buffered method. When more memory is needed than available  (either RAM
or video memory), then Windows needs to swap to hard disk. And that will
make  this  nice  new  method  even  slower  than  the  un-buffered  method.  So
buffering is advised only in case you have small simulations: where "small"
needs to be considered relative to the amount  of RAM memory in your PC
and video memory on your graphics card.
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The picture above shows the Settings sub-page of the Preferences
 
In  DeskProto  many  warning  messages  contain  a  checkbox  called  "Always
show this message".
These are optional warnings: when you remove the mark from the checkbox
and  press  OK,  the  warning  will  no  longer  be  issued  each  time  the  same
situation occurs. However what to do when you want the warning restored ?
Using  button  Restore  the  'always  show'  settings   you  can  restore  all
warnings (so replace the mark in all these checkboxes).

All  DeskProto defaults  and preferences  are  stored  in  the  Registry,  conform
the specifications for Windows applications as made by Microsoft. This use
of  the  Registry  makes  it  difficult  to  extract  these  settings,  for  instance  for
backup purposes, or in order to give DeskProto exactly the same workspace
on a number of PC’s.

This  is  where  the  options  Export  settings  and  Import  settings  come  in:
these  tool  allow  you  to  export  DeskProto’s  Registry  settings  to  a  file,  and
also to import all  these settings from a file that has been created previously
or on a different PC.
The  file  format  used is  an  XML file,  default  filename  is  deskproto_export.
xml

The  use  of  these  commands  is  straightforward:  button  Export  settings  will
export an xml file, button Import settings will import one.
The export option will write the current settings, so for the current version of
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DeskProto.
The import option will also accept files written by other DeskProto versions.
Which is not yet useful right now, however it will be for the next DeskProto
versions.

Note:  the  File  locations  (Data  location,  Drivers  location,  NC-File  location)
will not be included in this Settings file. Reason is that these will be different
per user: like 
C:\Documents and Settings\Jones\My Documents\
and 
C:\Documents and Settings\Smith\My Documents\
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3.7 Help Menu

Finally  the  Help  menu  which  gives  access  to  the  Help  system  and  to  the
About box. 
For  the  DeskProto  Editions  Entry  and  Expert   an  extra  option  is  present:
Upgrading...  (to a higher edition).

3.7.1 DeskProto Help

The  Contents  page  of  the  DeskProto  Help  System,  shown  at  the  Contents
tab on the left of the Help Window, offers an overview of all available Help
topics, organized in 'books'. Each book can be opened by double-clicking its
line  or  by  clicking  on  the  +  icon  in  front  of  the  line.  Seven  books  are
available:
· Introducing DeskProto
· Screen Layout
· Menu and Commands
· Concepts
· Troubleshooting
· How to...
· Various
The same seven books can be found as Chapters in the DeskProto Reference
Manual (available as PDF for download), which contains almost exactly the
same information as the Help file.

In addition to the Contents tab page two more tabs are available: 
the Index page can be used to find help on a specific subject, and 
the Search page to locate any word or phrase in the Help system.

While  reading  the  Help  text,  additional  related  information  can  easily  be
accessed  by  clicking  on  the  active  items  (Hyperlinks)  in  the  text.  Active
words are printed in blue and underlined, while the cursor will turn to a hand
when moved over an active item.

The online Help system that has been installed with DeskProto can be started
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from  the  Help  menu.  In  addition  some  other  methods  to  open  Help  are
available as well:

· The Help button on the Toolbar: 

· The button for Context Sensitive Help on the Toolbar: 
· Pressing the F1 Function key on the keyboard
· All dialogs also have a Help button, providing Help information about the

use of that particular dialog.
· The Help system can also be started independently from DeskProto using

the Windows Start button (start menu option 'Programs', group 'DeskProto
6.1') and finally you can define a shortcut on your Desktop to access the
DeskProto Help.

3.7.2 Quick Start

DeskProto  is  delivered  with  a  printed  Tutorial,  meant  to  step  by  step
introduce you to  the  functions  that  DeskProto offers.  It  is  recommended  to
read and execute at least lessons number one and two of this Tutorial before
starting to make prototypes with your own geometry.

However,  if  you  are  not  a  great  manual  reader  and  want  to  start  at  once
exploring DeskProto, at least read this Quick Start first. It is meant to explain
the basic ideas of DeskProto, and you will need this information to be able to
understand what is happening. After that, novel users are advised to first use
the Wizards, that will guide them through all steps needed to generate an NC
program file.



Menu and commands

Page 175

DeskProto Reference

The  DeskProto  screen  contains  standard  items  like  the  title  bar  (top  line),
menu  bar,  toolbar  (the  row  of  buttons  below  the  menu)  and  status  bar
(bottom  line).  The  center  area  is  divided  into  three  tiles:  the  large  View
window on the right, and the windows Project Tree and NC files on the left.
Follow the links for more information on any item.

For  now  it  is  important  to  know  within  this  screen  two  different  user-
interfaces exist: the wizard-based interface and the dialog-based interface.
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[1] Wizard-based interface.
New users  are  advised  to  use  the  DeskProto  Wizards,  that  will  guide  them
through all the steps needed to generate an NC toolpath file using their own
geometry. The illustration above shows a typical wizard page. A wizard will
set  the  same  parameters  as  available  in  the  dialogs,  only  now  they  are
presented  in  a  sequential  series  of  screens,  and  only  the  most  important
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parameters are available. You can find the wizards via the Start Screen or via
the File menu.

[2] Dialog-based interface.
When using the Dialog-based interface you need to know where to find the
parameters. 
In this interface you can define parameters on three levels:
1. Project parameters include the name of the geometry file and the number
of Parts that you want to use to create this prototype.
2. Part parameters define What will be milled. These set size, orientation,
position and alike.
Within each Part you can use one or more milling Operations.
3. Operation parameters define How it will be milled.
These are in fact the only real 'milling parameters'.  Three different types of
operation  are  available:  in  addition  to  the  standard  (3D)  Operation,  a  2D
Operation and a Bitmap Operation are available as well.

The   Project  is  the  central  concept  of  DeskProto.  All  information  about  a
prototype is stored in a Project-file (name.dpj), which is the file to be opened
when starting  and to  be  saved  when  finishing.  The  project  file  contains  all
milling parameters and viewing parameters, and also contains a reference to
the geometry file (it does not contain the geometry itself). 

You can imagine the tree-like structure of a project, which is displayed in the
 Project  Tree  at  the  left  side  of  the  DeskProto  screen:  see  the  illustration
above. This sample Project “Bottle” consists of one Part called “Half bottle”
and  three  Operations  called  “Roughing”,  “Finishing”  and  “Contour”.  Each
operation line includes a lamp icon that you can switch on and off to make
the  operation  (in)visible.  The project  will  be  named  when  saving  it  for  the
first time, until then the tree displays the name “untitled”.
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Note 1:  three  different  Editions  of  DeskProto are  available:  Entry,  Expert
and Multi-axis. The Entry edition and the Expert edition contains subsets of
the  available  Part  and  Operation  parameters.  For  the  rest  all  editions  are
equal.

Note 2: to open a new STL file in DeskProto you must use NEW to start a
new project. After that you have to choose Load Geometry in the File menu
to  import  the  STL  file.  You  cannot  use  Open,  as  you  do  not  yet  have  a
DeskProto project file for this new project.
To  load  a  2D  file  create  a  2D  Operation  and  edit  it’s  2D  Operation
parameters
To load a bitmap file create a Bitmap Operation and edit it’s parameters.

The  functions  of  DeskProto can  be  reached using the pull-down menus,  or
using the button-bar. The most important menus are described below:

* The View Menu offers the opportunity to change the way you look at the
geometry.  Also  try  changing  your  view  by  rotating  the  six  colored
thumbwheels  on  the  screen,  and  by  using  your  mouse  inside  the  view
window.  In  fact  most  of  the  functions  in  the  View  menu  can  be  activated
most easily by using the button bar.

* In the Parameters Menu you can edit all geometry and milling parameters.
For  simple  prototyping  it  is  sufficient  to  edit  only  the  front  Tab  screen  for
both  Part  and  Operation  parameters:  the  other  Tabs  can  come  later  as  all
parameters have suitable default values.

*  The  Create  Menu  is  the  most  important;  this  is  where  you  can  start  the
milling calculations and write the NC program file. 

We do hope you will enjoy using this software, it certainly can help you to
make your prototyping really rapid.

3.7.3 Create Problem Report

When  asking  for  support,  DeskProto  users  often  send  us  the  DeskProto
project  file  (DPJ  file),  intended  to  make  us  see  what  they  are  doing.
Unfortunately this is not sufficient: this DPJ file only contains the parameters
that they have set. And in order to reproduce the problem also the geometry
file  is  needed.  For  many  projects  even  more  files  are  needed:  bitmap,  2D,
special cutters, machines and/or postprocessors. The Create Problem Report
option automatically bundles all these files in one ZIP file, that you then can
send to us.
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Creating a problem report is done in four steps:

Step  1  asks  you  to  enter  your  Contact  details:  information  about  how  we
can reach you (we ask only the bare minimum).

In  Step  2  you  are  asked  to  describe  the  problem,  in  plain  text.  The  more
clear  you  describe  the  problem,  the  more  chance  that  we  can  indeed
reproduce it. And that is absolutely needed in order to start looking for a fix.
Note  that  you  cannot  actually  use  DeskProto  when  this  Problem  Report
dialog is opened, so you cannot walk through all steps and type them during
the  process.  If  that  is  what  you  want  you  need  to  open  Notepad,  and  after
finishing copy the text from Notepad to this dialog.

In  Step  3  DeskProto  will  collect  all  information  needed  to  reproduce  the



DeskProto Reference

Page 180

problem: all files as just mentioned, and in addition some basic information
about the Windows version and the graphics card that you are using.
Step 3 can only be started after you have entered the information asked for in
steps 1 and 2.
As one of the files to be collected is the DPJ file, DeskProto will ask you to
fist save this file (in case needed).

Step for finally saves the report file: a ZIP file that you can email to us.
Default  name  for  this  file  is  DpReport_Name.ZIP   in  which  Name  is  the
Name that you just entered.
Default  location  is  your  current  directory,  so  the  folder  where  you  just
loaded or saved your geometry and/or project.
You are however free to change file name and file location.

This  same  ZIP  file  can  of  course  be  used  for  other  purposes  as  well,  like
sending  a  complete  project  to  some  other  DeskProto  user,  or  for  archiving
purposes.

3.7.4 Register

A free  DeskProto  license  can  be  obtained  by  downloading  the  DeskProto
Setup  file  from  the  our  website  www.deskproto.com  and  installing
DeskProto on your computer.

The resulting 30 days trial license  is fully functional,  however after  the 30
days trial period the saving functions will be disabled. The trial  license can
be  converted  to  a  real  license  any  moment  (so  both  during  the  trial  period
and after) by entering a valid combination of Name and Registration code in
this dialog. 

When you buy DeskProto you will  receive a  Name/Code combination,  that
you can use to unlock your trial version. Buying is possible via a DeskProto
reseller or via our Internet Webshop.

Only one DeskProto Setup file exists, which is the same for the trial version
and  for  all  three  Editions  of  DeskProto   (apart  from  the  Setup  files  for
translated versions of DeskProto). Which edition of DeskProto actually starts
depends on the unlocking code that has been entered in this dialog. The code
also  defines  the  type  of  license:  commercial,  educational,  hobby  or  dealer
license.

http://www.deskproto.com
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As said: after  buying DeskProto you will  receive a Name  and a  Code,  that
you  can  enter  in  this  dialog.  After  that  use  the  button  Register  to  convert
your trial version into a registered license. Both the Name and the Code have
to  be  entered  exactly  as  given,  including  case  (upper  or  lower),  spaces,
commas, points, etc.

Make sure to carefully store the Name and Code supplied to you:
you may again need them when (for instance) you buy a new computer.

A registered version of DeskProto will clearly show the Name of it's owner:
in case that is not you then you are running an illegal copy!

After  buying  DeskProto  via  a  webshop  you  may  first  receive  a  temporary
Name/Code  combination,  allowing  you  to  enjoy  14  more  trial  days.  That
makes sure that you can use your new license immediately after buying, also
in case the delivery of the definitive license takes a few days.

After  registering  it  is  also  possible  to  Unregister,  allowing  you  to  again
convert  the  program  from  registered  license  to  a  trial  version.   Important:
unregistering  is  possible  only  when  you  enter  the  same  Name/Code
combination as used when registering !

3.7.5 Upgrade

Displays  a  dialog  screen  that  lists  the  advantages  of  the  higher  DeskProto
Editions. 

The  difference  between  the  Entry  Edition  and  the  Expert  Edition  is  the
number of parameters that you can set (both Part parameters and Operation
parameters).
The difference between the Expert Edition and the Multi-Axis edition is that
(of  course)  more  axes  are  available  in  the  latter:  the  A-axis  and  B-axes
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rotation axes.

Of  course  for  registered  users  of  DeskProto  such  upgrade  is  available  at  a
special upgrade price.

3.7.6 Check for Update

This  command  will  make  your  DeskProto  contact  the  website  www.
deskproto.com  (internet  connection  required)  to  see  if  a  newer  Service
Release (bugfix build) is available for download.

Once every few months a newer build of the program is released, containing
a number of bugfixes.
You can find the Revision number of your DeskProto in the About box.
'And you can  find  information  about  the  Revisions  that  have been released
on 
www.deskproto.com/support/buildhistory.htm

The  command  Check  for  Updates  will  automatically  compare  the  Revision
number  of  your  DeskProto  with  the  Revision  number  of  the  latest  release,
and will tell you when a newer release is available for download. The dialog
then will open the page on the DeskProto website where you can download
the Updater Setup.

Running  the  update  will  recognize  your  DeskProto  license  and  keep  that
active.
Only  the  program  will  be  updated:  drivers,  scripts,  language  files  etc  will
remain as they were.

When  no  internet  connection  is  available  DeskProto  will  tell  you  that  it
"Could not perform the Update check".

http://www.deskproto.com
http://www.deskproto.com
http://www.deskproto.com/support/buildhistory.htm
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3.7.7 About

The  DeskProto  About  Box  will  display  information  about  the  DeskProto
version that you are running:

Version number, like 6.1

Edition - so either Entry, Expert or Multi-Axis

Build date - the format of the build date is “yyyy-mm-dd”, and it show that
date on which your file DeskProto.exe has been built.
and Revision number - each build of the file  DeskProto.exe receives a new
revision number.

Serial  number  -  Each  new  license  gets  a  new  number,  so  the  Serial  Nr  of
your license is unique (empty when in trial mode).

License  information  -  the  Name  on  which  this  license  has  been  registered
(empty when in trial mode)

Copyright notice - all rights reserved. You do not own the software: you own
a license to use the software

Contact  information  -  DeskProto  is  made  by  Delft  Spline  Systems  in  the
Netherlands

Short program description.

3.7.8 Context Sensitive Help

Use  Context  Sensitive  Help  to  obtain  help  on  any  specific  DeskProto  user
interface item.  When you choose the  Context  Help  button on  the Toolbar,
the  mouse  pointer  will  change to  an  arrow  and  question  mark.   Then  click
somewhere in the DeskProto window, and the Help will be started showing
the topic for the item you clicked.

Shortcut
Keys: SHIFT+F1
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IV Concepts

4.1 Project

A project can be compared with a document in applications like MS Word. It
is the main object you work with in DeskProto. Unlike Word, where you can
open several  documents  at  the  same time,  in  DeskProto you can  have  only
one project opened.  A Project can be saved and opened in the File Menu, as
a DeskProto ProJect file with the file-extension DPJ.

Structure
A project ‘contains’ a few other objects. One of the objects is the geometry.
Each project can have either none or one geometry (which is in fact a link to
a  separate  geometry-file).  In  case  a  project  has  no  link  to  a  geometry  it  is
called a template project.

A  second  object  is  the  part.  A  project  can  contain  one  or  more  parts  (no
limit). It is called part because it defines the shape of  the part to be milled.
You can for instance create a prototype by combining two separate parts, like
left and right halve of a hand drill. This part definition consists of a number
of parameters, like scaling values (relative to the original geometry), rotation
values etc. So the part parameters are in fact the geometry parameters.

The  third  object  is  called  the  operation.  A  part  can  contain  one  or  more
operations  (no  limit).  It  is  called  operation  because  it  defines  how  a  part
should be made, how the material should be machined. This definition also
consists of a number of parameters,  like milling direction,  precision values,
feedrate etc. Many times you will use more than one operation for one part.
For  example  you  may  want  to  quickly  remove  most  of  the  material
(roughing)  before  you  want  to  mill  precisely  (finishing).   So  the  operation
parameters are in fact the milling parameters. 
Three  different  types  of  operation  are  available:  standard  (3D)  operations,
and additional 2D Operations and bitmap operations.

In DeskProto the structure of the project is shown in the project tree, which
is placed on the left of the screen and looks like this:
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Besides geometry, parts and operations a project also contains a few project
parameters: see the Project Parameters dialog for a description.

How to create a project
You can create a new project by choosing the New option of the File menu.
When you create  a  new project  the  currently  opened file  will  be  closed.  In
case you start DeskProto a new project will be created automatically. 

Default project
When a  new  project  is  created,  the  parameters  are  copied  from  the  default
project.  This  default  project  is  saved  somewhere  in  the  computer  (in  the
registry); every user has a separate set of defaults.

You can use the default project to enter parameters that you want to use as a
standard.  A  default  geometry  file  cannot  be  set,  so  these  are  only  the
checkboxes “Flip  normals”  and “Skip  backfaces”.  This  will  for  instance  be
useful in case most of your STL files show backfaces..

To  edit  the  parameters  of  the  default  project,  go  to  the  Options  menu  and
select  the  option  Default  Project  Parameters.  This  opens  the  Project
Parameters dialog. 

How to open a project
You  can  open  a  project  by  choosing  the  Open...  option  of  the  File  menu.
When you open a project the currently opened file will be closed.

The  current  ‘Look  in’  folder  in  the  Open  File  dialog,  will  be  initiated
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conform the file  location  ‘Data’,  which  can  be  changed  at  the   general  tab
page of the Preferences dialog.

How to save a project
You can save a project by choosing the Save option of the File menu. Using
this option it will be saved under the same name you have saved it before. If
you want  to save it  with another  name,  choose  the  option Save  As...  under
the File menu.

The current ‘Save in’ folder in the Save As dialog, will be initiated conform
the file location ‘Data’, which can be changed at the general tab page of the
Preferences dialog.

The DPJ file
The project information is stored in a DeskProto ProJect file (file extension .
DPJ), containing all Parameter settings and also all View settings. Note that
the  project  file  does  not  contain  the  geometry,  only  a  link  to  the  geometry
file.

Three different types of DPJ files are used:
1 - a project file with only the settings (default)
2 - a project file with both settings and calculated toolpaths.
3 - a project file that is compatible with DeskProto V6.0 and older.
Both files have the same file extension .DPJ

2 -  The second type can be used in case  many Operations  are  combined  in
one  NC  program  file,  and  the  toolpath  calculations  take  very  long.  Then
when  the  settings  are  changed  for  only  one  operation,  it  is  not  needed  to
again calculate all operations to write the new NC program file.
You can choose between both types in the "Save as type" field of the Save
As dialog.
When  opening  a  project  file  it  is  not  needed  to  distinguish  between  both
types of DPJ file.

Note that in fact the toolpaths will be stored in a separate file: the DeskProto
ToolPath  file  (file  extension  .DTP),  which  will  be  much  larger  than  the
(small) DPJ file.
For a project file called test.dpj  the toolpath filename be test.dpj.dtp
The difference between such Toolpaths  file  and an  NC program file  is  that
the first is in a machine-independent format.

3  -  In  DeskProto  V6.1  we  have  changed  the  'encoding'  of  all  text  strings.
DeskProto  V6.0  and  older  use  ANSI  encoding,  which  is  OK  for  western
languages  but  will  give  problems  with  non-western  scripts  like  used  in
Chinese  and  Russian.  DeskProto  V6.1  uses  UTF,  which  is  the  current
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standard for encoding, and supports all scripts (character sets).
So in V6.0  and older project  files  (*.DPJ) are  ANSI encoded,  in  V6.1  and
newer they are UTF encoded.
DeskProto  V6.1  can  read  both  types  of  DPJ  file,  however  older  versions
cannot  always  correctly  open  the  new  UTF  encoded  files.  A  problem  is
present only when names (part name, operation name, cutter name) are used
that contain special characters. Like for instance the ä in the German cutter
name "Kugelfräser 6": V6.0 will see this as "KugelfrÃ¤ser 6"
The solution is  to use the "Save As" function when saving  a  project  file  in
DeskProto V6.1 that needs to be opened in V6.0 (or older).  In the Save As
dialog  you can  select  a  file  type  in  "Save as  type",  and  one  of  the  types  is
"DeskProto 6.0 project files (*.DPJ)". The new project file then can be read
by the old DeskProto version.
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4.2 Geometry

A project  contains  none  or  one  geometry,  or  in  other  words  it  may  link  to
one external geometry file.

Geometry type
DeskProto only recognizes geometry defined with triangles: the outer surface
of the geometry described using a (large)  number  of  triangles.  This  type  of
geometry  is  also  called  Polygon  data.  It  is  not  the  most  efficient  way  of
storing 3D data, still it has the large advantage that it always works: the level
of definition is so low that no incompatibilities between systems exist.

This 3D geometry has to be distinguished from the optional 2D files that can
be imported in a 2D Operation and a Bitmap Operation. 2D Contour data is a
flat  vector-drawing  and  does  by  definition  not  contain  any  3D  Geometry.
Bitmap data  is  a  flat  drawing  defined  using pixels,  so  does  not  contain  3D
data either.

How to load a geometry
You can load the geometry file  using the Load Geometry command in  the  
File menu. 
Although  DeskProto  can  only  deal  with  one  geometry  per  project,  it  is
possible to load more than one geometry, using the same command: after you
have loaded a geometry the Load Geometry option will  be changed to Add
Geometry.  This is  possible  as DeskProto combines  all  the  loaded  geometry
files to one new geometry.
You can also load a geometry using one of the wizards.

How to save a geometry
Choosing  the  Save  Geometry  As  option  in  the  File,  saves  all  the  loaded
geometries as one geometry file.

File types
DeskProto  supports  three  geometry  file  types:  STL,  DXF and  VRML.  The
only  type  that  is  fully  supported  is  STL,  as  that  file  can  only  contain
triangles. The other types may also contain other shapes (entities), which are
not supported. 

STL
STereoLithography  file.  Only  contains  triangles.  An  STL  file  may  be  a
binary file or a ASCII file, the only difference being the storage method: the
contents of both files (the series of triangles) is identical. DeskProto supports
both types. 
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In an STL file for every triangle also one normal-vector is saved in order to
define  the  inside  and  the  outside  of  the  part.  This  is  in  fact  double
information, as also the order of the three points can be used to define inside
and outside.

DXF
AutoCAD Drawing Interchange File. A DXF file may contain many different
entities, both 2D and 3D.
Of all  these  entities  only  two are  recognized  by  DeskProto:   3D-Faces  and
Polyface Meshes:
3D-Face
With  3D-faces  for  every  triangle  3  points  are  stored.  No  normal-vector  is
stored, the three points are stored in counter-clockwise order.
Polyface Mesh
With polyface meshes first a long list of points is stored, and then for every
triangle  3  indices  that  each  lead  to  a  point  in  that  list.  In  this  way  all  the
points only have to be saved once, thus saving disk-space.

Other  entities  in  the  DXF  file  will  be  skipped  when  importing  the  file.  In
practice many DXF-files will only contain other entities, and thus can not be
read by DeskProto.

Note  that  DeskProto also  supports  2D DXF files,  for  2D contour  data  in  a
2D Operation.

VRML
Virtual  Reality  Modeling  Language  file.  A  VRML  file  may  also  contain
many  different  entities  and  other  objects.  Only  polygons  and  boxes  are
supported  by  DeskProto  at  this  moment.  All  will  be  stored  internally  (and
can be saved) as triangles. VRML files have the file extension .WRL (short
for "world")

Corrupt geometries
Unfortunately  not  all  3D  CAD  systems  will  export  perfect  geometry  files,
which  may  result  in  geometries  that  do  not  look  right  on  the  DeskProto
screen.  Note  that  with  an  up-to-date  CAD  program  this  is  not  likely  to
happen: most current CAD systems do have correct STL export functions.



DeskProto Reference

Page 190

A  known  problem  with  the  STL  files  of  some  surface  modeling  CAD
programs is incorrect normal-vectors. The normal-vector of a triangle defines
which  side  of  the  triangle  is  the  outside,  so  incorrect  normals  result  in  a
geometry  with  the  backfaces  on  the  outside,  drawn  in  black.  This  can  be
solved  by  switching  the  option  Flip  normals  on  in  the  Project  Parameters
dialog. 
You  can  also  save  your  geometry  with  these  flipped  normals:  choose  the
Save Geometry As option in the File menu. 
STL-files do store the normal-vectors.
DXF files do not  store  the normals,  when importing  a  DXF file  DeskProto
calculates the normal based on the three points of the triangle being stored in
a counter-clockwise order.

When some of the normals are OK and some are incorrect, then only some of
the triangles are drawn in black.. This can also be solved by DeskProto. You
have to uncheck the option Skip backfaces with calculations in the Project
Parameters dialog. This causes all the triangles to be treated as if they don’t
have backfaces but 2 frontfaces so they will be rendered from both sides, and
both sides will be used for toolpath calculations as well.

Obviously  files  can  be  corrupt  in  many  more  ways.  DeskProto  is  very
tolerant  here:  it  will  just  accept  files  containing  cracks,  holes,  orphan
surfaces and many more inconsistencies. Files that would be rejected by any
other RP-system.

How to transform the geometry
For each part in your project you can set some transformations, like rotation,
scale etc. These transformations can be set in the  Part Parameters dialog at
the Transform tab page.
Note:
The  translation  which  may  be  needed  to  position  the  part  on  the  milling
machine  can  be  set  at  the  Translate  tab  page  of  the  same  dialog.  These
translation settings only effect the coordinates saved in the NC-program and
the  coordinates  in  the  Geometry  Information  dialog  under  the  Part  section.
All  calculations  are  done  using  the  untranslated  coordinates,  translation  is
applied when writing the NC file.
Note:
When  you  choose  the  Save  Geometry  As  command  in  the  File  menu,  you
may select which of the transformations have to be applied for the exported
STL file. You can do so in the Save Geometry Options dialog.

Viewing the geometry
You can view the geometry in different ways. As a wireframe, as a wireframe
with  hidden  lines  removed,  as  a  rendered  geometry  or  as  points.  To
determine how to view the geometry you should check or uncheck the items
in the Subjects dialog.
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4.3 Part

A  part  is  the  thing  that  you  will  machine  using  one  setup  (a  block  being
fixtured on the machine). Many models for instance can easiest be created by
milling  two separate  Parts,  for  instance  the  left  side  and the right  side  of  a
hand drilling machine, to be glued together later. Also in case you machine
one block of material from two (or more) sides, DeskProto will see each side
as a separate Part.

The  description  of  a  part  consists  of  a  number  of  parameters,  like  scaling
values (applied to the original geometry), rotation values and the name of the
milling machine that will be used to produce the part. For a complete list of
parameters see Part Parameters dialog.
How  the  part  should  be  milled  is  described  in  its  operations.  A  part  can
contain one or more operations.

To edit a part go to the Parameters menu and select the item Part Parameters.
This opens the Part Parameters dialog.
A much quicker  way to  open  the  Part  parameters  dialog  is  double-clicking
on the part's name in the Tree.

Current part
To view a particular part you need to make it current.  There is always one
part  that’s  current.  No  more  (you  cannot  display  two  different  geometries
through one  another),  no  less.  The lightbulb  icon  in  the  project-tree  shows
which part is current: for only part the light burns (yellow) for the other parts
(if any) the light is off (grey).
You can make a part current by clicking on the grey lightbulb icon for that
particular part. Clicking on a yellow lightbulb does not have any effect. You
can  also  make  a  part  current  by  right-clicking  on  a  part  in  the  project-tree
and then  mark  the  option  ‘Make  Current’  in  the  context-menu  that  will  be
shown.  Another  way to make a  part  current  is  in  the  dialog where  you can
choose which part you want to edit after selecting the option Part Parameters
in the Parameters menu

Default part
When a new project is created, one part is added. The parameters of that part
are  copied  from  the  ones  set  at  the  default  part.  The  default  part  is  saved
somewhere in the computer (in the registry), this is done for every user who
uses the computer.

You can use the default part to enter geometry parameters  that  you want  to
use  as  a  standard.  For  instance  the  machine  that  you  use,  the  translation
method and the number of operations.
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To edit the parameters of the default part, go to the Options menu and select
the  option  Default  Part  Parameters.  This  opens  the  Part  Parameters  dialog.
The parameters of the default part are also used when you add a new part to
the project.
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4.4 Operation

An operation  gives  a  description  of  how a  part  should  be  created,  how the
material  should  be  machined.  This  Help  page  concerns  DeskProto's  main
operation  type,  which  is  the  (3D)  Operation.  In  addition  an  optional  2D
Operation and Bitmap Operation are present.
The  description  of  an  operation  consists  of  a  number  of  parameters,  like
milling  direction,  precision  values,  feedrate  etc.  For  a  complete  list  of
parameters see Operation Parameters dialog.

To  edit  an  operation  go  to  the  Parameters  menu  and  select  the  item
Operation Parameters. This opens the Operation Parameters dialog. A much
quicker way to open the Operation  parameters  dialog is  double-clicking  on
the operation's name in the Tree.

Visible operations
To view the toolpaths (or segment, Z-grid etc) of a particular operation you
need  to  make it  visible.  Of  all  operations  of  the  current   part  0,  1  or  more
operations may be visible at the same time. The lightbulb icon in the project-
tree shows if an operation is visible: the light burns (yellow) means visible,
the light is off (grey) means invisible.
You can make an operation visible by clicking on the grey lightbulb icon for
that  particular  operation,  and  make  it  invisible  by  clicking  on  it's  yellow
lamp icon.  You can  also  make an  operation  visible  by  right-clicking  on  an
operation  in  the  project-tree  and  then  mark  the  option  ‘Visible’  in  the
context-menu that will be shown. Another way to make an operation visible
is when you check an operation in the operation-list of the Subjects dialog.

To actually see one of the items (Toolpath, Segment, Z-grid or other) of the
operation you have made visible, you also should check the item you want to
see in the Subjects dialog. 

Default operation
When a new project is created, one part is added and one or more operations
(depending on the number of operations in the default part) are added to that
part. The parameters of the operations are copied from the ones set as default
operations. The parameters of the first  default operation are also used when
you add a new operation to a part. The default  operations have been stored
somewhere in the computer (in the registry); this is done for every user who
uses the computer.

You  can  use  the  default  operation(s)  to  enter  milling  parameters  that  you
want to use as a standard. For instance a specific tool, the accuracy and the
strategy.
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To edit the parameters of the default operations, go to the Options menu and
select the option Default Operation Parameters. This will open the Operation
Parameters dialog.
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4.5 2D Data

2D versus 3D
DeskProto  is  aimed  at  working  with  a  3D  Geometry,  and  most  milling
strategies  and  other  parameters  are  only  suited  for  3D  applications.  Still
many users also will need simple 2D machining, either for simple parts or for
some special detail in a 3D project.  Thus DeskProto also offers  options for
simple  2D  machining.  These  are  clearly  additional  functions:  DeskProto
does not aim to be a true 2D CAM system.

A DeskProto project contains a link to one 3D geometry file, which is used
for  all  parts  and  all  operations  in  the  project.  In  contrast  a  2D  file  can  be
used only for one operation. It contains 2D Contour data, which is a flat line
drawing, and the cutter will just  follow these 2D lines on a certain Z-level.
This use should be seen as an (old) pen plotter: the lines in the plot file are
plotted on pen-down Z-level, with in-between positioning moves on pen-up
Z-level. Note that the center of the cutter follows the line: for 2D DeskProto
does not apply cutter compensation (compensate for the radius of the cutter).
So a DeskProto project contains (links to) none, one or more 2D files.

To  support  2D  machining  a  special  2D  Operation  has  been  added.  A  Part
may  contain  both  2D  Operations  and  3D  Operations:  each  2D  operation
having its own 2D file, and each 3D Operation using the projects geometry. 
So  in  order  to  use  2D machining  you will  have  to  add  a  2D  Operation
first.

How to load a 2D File
After  having  created  a  2D  Operation,  you  can  load  a  2D  file  in  the  2D
Operation Parameters using the [Browse…] button for a standard Windows
File-Open dialog.
You can also load a 2D file in the 2D wizard.

2D File types
For 2D DeskProto supports two file types: 
DXF as this is the most widely used format for engineering, and
Postscript  (EPS  and  AI  files)  as  that  is  the  most  widely  used  format  for
Graphics design. 

DXF
AutoCAD Drawing Interchange File. 
Can contain many different entities, both 2D and 3D, DeskProto supports a
small subset only. 
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Supported DXF entities for 2D in DeskProto:
Point
A point in the DXF file will result in a drilling operation on that location.
Line
A line contains  a  begin-  and end-point,  and will  result  in  a  tool  movement
from begin to end (linear interpolation).
Polyline and LW polyline
A polyline is  in fact  a series  of lines connected to each other.  This is  more
efficient (endpoint line 1 = startpoint line 2) and gives more control over the
toolpath sequence. A polyline may contain arc segments as well.
Arc
An arc entity contains the centerpoint coordinates, the radius of the arc, and
angles  for start  and stop.  Currently DeskProto will  convert  the arc to many
small line segments, as the toolpath part (postprocessor) does not yet support
arcs.
Circle and Ellipse
Same as the Arc: stored in DXF as Centerpoint(s) and radius, converted by
DeskProto to polylines.

Very special  for a 2D Operation is  that  it  even supports  3D Polylines.  The
entities  mentioned  above  normally  do  not  contain  any  Z-coordinates:  you
will  add Z-values  in  the  2D Operation  parameters.  A 3D Polyline  however
does contain  Z-values,  and  DeskProto  will  import  them.  The  toolpath  then
will follow this 3D Polyline, and the Z-values as entered in the 2D Operation
parameters will be taken relatively to the Z as defined in the file.
When  you  open  a  DXF  file  containing  Z-coordinates  then  DeskProto  will
report that is has detected Z-values in the file, and will ask you if you want to
use them.

In  practice  many  DXF-files  will  also  contain  other  entities,  which  will  be
skipped by DeskProto. A Line, Arc or Circle can for instance also be stored
in the DXF as a spline curve: DeskProto will fail to read that entity. This is
for  instance  critical  for  text  as  most  fonts  are  defined  with  splines.  Try  to
find an export option that converts the splines to polylines. Also text that is
stored  as  ASCII  character  with  a  font  definition  cannot  be  read  by
DeskProto.

Note that DeskProto also supports 3D DXF files, for 3D Geometry.

Postscript
In fact the correct name is Encapsulated Postscript, file extension .EPS or .
AI  (short  for  Adobe  Illustrator).  For  Postscript  files  as  well  DeskProto
supports a subset only.

Supported Postscript entities for 2D in DeskProto:
Point
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A  point  in  the  Postscript  file  will  result  in  a  drilling  operation  on  that
location.
Lineto
A  line  in  Postscript  contains  only  an  end-point,  and  will  result  in  a  tool
movement from the current position to that end (linear interpolation).
Curveto
Also a tool movement to the defined end-point, however now a Bezier curve.
Used much in font definitions.
Moveto
As  the  above  commands  specify  the  end-point  but  not  the  start-point,  a
method needs to be supplied to move to  a  new start-point  without  drawing
(milling) a line. The Moveto command makes such positioning move.

Postscript  also  may  contain  many  other  entities,  like  colors  and  bitmaps,
which will be skipped by DeskProto.

How to transform the 2D File data
The  2D contour  data  from  the  2D file  will  be  interpreted  by  DeskProto  in
machine coordinates, so relative to the workpiece zero point as used on the
machine.  The  milling  machine  will  indeed  be  used  as  a  plotter  and  let  the
cutter move to the coordinate values exactly as specified in the 2D file. 

The  machine  coordinates  are  shown  on  the  Part  tab  of  the  Geometry
Information dialog. This means that any transformations (rotation, scale,…)
and translations that you have set in the 3D Part Parameters do NOT  apply
on  the  2D  contour  data.  The  logic  is  that  some  transformations,  like  3D
rotation and inverse milling, do not make sense for 2D plot data.

You can transform the 2D contour data on the XY transform Tab of the 2D
Operation  parameters.  This  dialog  offers  options  to  scale,  translate  and
rotate,  all  in  2D.  Using  the  apply  button  you  can  easily  position  the  2D
contour data as needed, using a step-by-step approach.  As an alternative an
Align dialog is available for your convenience.

Note:
This  different  treatment  of  a  3D  geometry  file  and  a  2D  file  might  give  a
problem when you want to combine both file types for a part. This problem
can easily be solved, by not applying any Transformation to the 3D part, and
by  setting  the  3D  Translation  to  None  for  all  axes.  Also  no  2D
transformations may be applied. Then the 3D and the 2D file (in case written
in the same coordinate system, will nicely match.

A different  type of Transform is  offered on  the Z-settings  Tab page,  which
allows you to transform the Z-values  by  projecting  the 2D contour  data  on
the 3D geometry.
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Viewing the 2D File data
You can see the 2D contour data on your graphics screen. In case you do not
see the plotfile, check:
- does the 2D operation contain a (link to a) 2D file.
- is the 2D operation visible 
- is the entry “2D contours” checked in the Subjects dialog.
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4.6 2D Operation

An operation  gives  a  description  of  how  the  material  should  be  machined.
This Help page concerns one of DeskProto’s additional operation types: the
2D Operation. The main operation type is the (3D) Operation.

You  have  to  be  aware  that  DeskProto  only  supports  very  basic  2D
functionality: for more advanced 2D options a specialized 2D CAM software
is needed. Basically in 2D mode DeskProto acts like a plotter. The cutter will
exactly  follow  the  lines  as  defined  in  the  2D  file,  at  a  certain  machining
depth (pen-down level). For positioning moves in-between the cutter rises to
Z-free height (pen-up level).
In 2D mode DeskProto does not  compensate for the cutter  radius:  so  when
you machine a square of 100 mm using a cutter of 10 mm diameter (R 5), the
result  will  be  a  square  of  100  –  (2  x  5)  –  90  mm  large.  Also  options  like
pocketing and start/stop sequences are not available.

The description of a 2D operation  consists  of  a  number  of  parameters,  like
milling  direction,  precision  values,  feedrate  etc.  For  a  complete  list  of
parameters see 2D Operation Parameters  dialog.

To  edit  a  2D  Operation  go  to  the  Parameters  menu  and  select  the  item
Operation Parameters. This opens a dialog to select which Operation to edit.
After  selecting  a  2D  Operation,  DeskProto  will  show  the  2D  Operation
Parameters dialog. Of course a 2D Operation must have been added already.
A much quicker way to open the 2D Operation parameters dialog is double-
clicking on that operation's name in the Tree.

Visible operations
To view the data  or  the  toolpaths  of  a  particular  2D operation  you need to
make it visible. Of all operations of the current part 0, 1 or more operations
may be visible at the same time. The lightbulb icon in the project-tree shows
if an operation is visible: the light burns (yellow) means visible, the light is
off (grey) means invisible.
You can make an operation visible by clicking on the grey lightbulb icon for
that  particular  operation,  and  make  it  invisible  by  clicking  on  it's  yellow
lamp icon.  You can  also  make an  operation  visible  by  right-clicking  on  an
operation  in  the  project-tree  and  then  mark  the  option  ‘Visible’  in  the
context-menu that will be shown. Another way to make an operation visible
is when you check an operation in the operation-list of the Subjects dialog.

To actually see one of the items (2D contours, Toolpath) of the 2D operation
you have made visible, you also should check the item you want to see in the
 Subjects dialog. 
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Default 2D operation
When a new 2D Operation is created, the parameters of the new operations
are  copied  from  the  ones  set  as  default  2D  operation.  This  default  2D
Operation has been stored somewhere in the computer (in the registry),  this
is done for every user who uses the computer.
DeskProto also contains a default project and a default part. The default part
may also contain a 2D Operation: in that case the default 2D Operation will
also be used when creating a new Project and/or a new Part. 
You can use the default 2D operation(s) to enter milling parameters that you
want  to  use  as  a  standard.  For  instance  a  specific  tool  and/or  machining
depth.

To edit the parameters of the default 2D operation, go to the Options menu
and select  the  option Default  2D Operation  Parameters.  This  will  open  the
2D Operation Parameters dialog.
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4.7 Bitmap Data

Bitmap versus 2D and 3D

A bitmap file contains a 2D picture by storing the color value of each pixel
on  the  screen.  So  a  line  is  stored  as  a  series  of  black  pixels  on  a  white
background.  This in contrast  to a vector file,  where the line is  stored  using
the coordinates of both the start point and the end point of the line. As many
different  colors  can  be  used,  in  a  bitmap  complex  pictures  are  possible.
Digital photos for instance are stored in bitmap files.

A  bitmap  file  is  a  2D  file:  a  pixel  only  has  an  X-coordinate  and  a  Y-
coordinate,  plus of course a color.  DeskProto converts  this 2D file  to  a  3D
geometry by translating the color to a Z-value, resulting in XYZ information
for  each  pixel.  The  result  is  a  3D  Relief.  This  is  called  Gray  scale  to  Z-
height  conversion,  or  Bitmap  to  Relief  conversion  The  colors  range
between  black  and  white,  defining  the  extreme  Z-values  to  be  used.  Color
pictures are automatically converted to Black & White (conversion formula:
Grey-value = 0.30 * red + 0.59 * green + 0.11 * blue). The extreme Z-values
(for  pure  black  and  pure  white)  can  be  set  in  the  Bitmap  Settings  dialog.
Internally DeskProto converts the bitmap into a Z-grid, that can be used for
toolpath calculations.

This  is  an  exception  to  the  basic  DeskProto  method  of  working  with  a  3D
Geometry,  when  the  geometry  is  created  using  a  CAD  program  or  a  3D
scanner and then imported by DeskProto. Bitmap geometries in contrast are
created in DeskProto. The toolpath options for bitmaps are roughly the same
as for a standard 3D Operation.
The  approach  also  differs  from  a  2D  Operation  as  there  both  data  and
toolpaths are in 2D.

A DeskProto project contains (a link to) one 3D geometry file, which is used
for all parts and all operations in the project. In contrast the link to a bitmap
file  is  set  at  operation  level,  so  several  bitmaps  can  be  used  in  the  same
project.

To support bitmap machining a special Bitmap Operation has been added. A
Part may contain 3D Operations, 2D Operations and/or Bitmap Operations:
each 3D Operation using the projects geometry, each 2D Operation using its
own 2D file and each  Bitmap Operation using its own Bitmap file. 
So  in  order  to  use  Bitmap  machining  you  will  have  to  add  a  Bitmap
Operation first.
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The two pictures above show the original  bitmap image of  a  shell  left,  and
right a simulation of the resulting 3D Relief. Minimum Z has been assigned
to black, and Maximum Z to white. DeskProto does not display the resulting
Bitmap geometry, you can only see it by displaying the Z-grid, the Toolpaths
or the Simulation.
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Important  to  know  is  that  for  large  bitmaps  DeskProto  will  display  a
simplified  version  (256x256  pixels)  of  the  bitmap,  in  order  to  speed  up
drawing. The actual toolpath calculations will nevertheless be done with the
original bitmap data.

How to load a Bitmap File
After having created a Bitmap Operation, you can load a Bitmap file  in the
Bitmap  Operation  Parameters  using  the  [Browse…]  button  for  a  standard
Windows File-Open dialog.
You can also load a Bitmap file in the Bitmap wizard.

Bitmap File types
DeskProto supports the four most popular file types for bitmap files:
BMP File  format  defined  by  Microsoft  for  BitMaP  files.  Not  very

efficient (large files), widely accepted.
GIF the Graphic Interchange Format is an efficient format without

data loss, though only max 256 colors are possible.
JPG or  JPEG  File  format  defined  by  the  ISO  (International

Standards  Org)  Joint  Photographic  Experts  Group.  Various
levels  of  compression  are  possible,  all  resulting in  some  loss
of information.

PNG the Portable Network Graphics is the best bitmap format: with
compression,  no  data  loss,  not  patented  (like  GIF).  Designed
for Internet use.

TIFF Tagged  Image  File  Format,  originally  made  by  Aldus,  since
2009 controlled by Adobe. TIFF files tend to be very large.

How to transform the Bitmap File data
The  Bitmap  geometry  will  be  created  from  the  Bitmap  file  in  machine
coordinates, so relative to the workpiece zero point as used on the machine.
So  Part  transformations  and  Translations  do  not  influence  the  Bitmap
geometry.  The  default  XY  position  of  the   bitmap  will  be  with  the  left
bottom corner on point (0,0), Z-positions as specified in the Bitmap settings.
In these same Bitmap settings the XY size is defined, and a Translation for X
and Y may be specified in case needed. Using the apply button and looking
on  the  graphics  screen  you  can  easily  position  the  bitmap  geometry  as
needed, using a step-by-step approach.
As an alternative an Align dialog is available for your convenience.

A different  type  of  Transform is  offered on  the Bitmap Z  Tab  page,  which
allows you to transform the Z-values  by  projecting  the 2D contour  data  on
the 3D geometry.

Grid complications
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In a DeskProto bitmap operation two grids are used: the bitmap is a grid, and
for calculating the toolpath the Z-grid is used. And combining two grids that
are not equally spaced may lead to ripples in the resulting relief, caused by a
Moiré effect.

The bitmap grid is the grid of pixels, the size of each grid cell in mm being
set in the Bitmap Settings.
The Z-grid is the rectangular grid of XY positions, with a Z-value calculated
for each position, the size of each grid-cell in mm set by the Precision.
The Z-grid will be filled with Z-values as calculated in the bitmap grid.
When the dimensions of these grid cells are not equal this conversion cannot
be done one to one.  So for instance when most  Z-grid  cells  are  filled  from
one  bitmap  cell  each,  once  every  say  10  cells  one  will  be  filled  from  two
bitmap cells. And this may cause a visible ripple in the relief.

In order to prevent  such Moiré problems you can  select  a  pixel  size  that  is
dependant  from  the  precision.  This  can  be  accomplished  using  one  of  the
two  options  “Calculate  from  precision...”.  The  edit  fields  for  Custom  will
show the resulting relief size. Note that when you later change the precision
this will automatically also change the size of the resulting relief.

Viewing the Bitmap File data
You  can  see  the  Bitmap  image  on  your  graphics  screen.  Note  that  a  color
image is shown in black & white. In case you do not see any image, please
check:
- does the bitmap operation contain a (link to a) bitmap file.
- is the bitmap operation visible 
- is the entry “Bitmaps” checked in the Subjects dialog.
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4.8 Bitmap Operation

An operation  gives  a  description  of  how  the  material  should  be  machined.
This  Help  page  concerns  DeskProto’s  additional  operation  type  called  the
Bitmap  Operation.  The  main  operation  type  is  the  (3D)  Operation,  and  a
second additional  one  is  the  2D Operation.  The Bitmap operation  does  not
use the Part geometry, but uses a Bitmap geometry instead.

The  description  of  a  Bitmap  operation  consists  of  a  number  of  parameters,
like  milling  direction,  precision  values,  feedrate  etc.  For  a  complete  list  of
parameters  see  Bitmap  Operation  Parameters  dialog.  You  can  find  this  via
Operation  Parameters  in   the  Parameters  menu.  Of  course  a  Bitmap
Operation must have been added first.
A  much  quicker  way  to  open  the  Bitmap  Operation  parameters  dialog  is
double-clicking on that operation's name in the Tree.

As  for  a  bitmap  operation  also  parameters  are  needed  for  the  conversion
from  bitmap  image  to  bitmap  geometry,  an  extra  dialog  has  been  added
called the Bitmap Settings dialog.

Visible operations
To view the data or the toolpaths of a particular Bitmap operation you need
to  make  it  visible.  Of  all  operations  of  the  current  part  0,  1  or  more
operations may be visible at the same time. The lightbulb icon in the project-
tree shows if an operation is visible: the light burns (yellow) means visible,
the light is off (grey) means invisible.
You can make an operation visible by clicking on the grey lightbulb icon for
that  particular  operation,  and  make  it  invisible  by  clicking  on  it's  yellow
lamp icon.  You can  also  make an  operation  visible  by  right-clicking  on  an
operation  in  the  project-tree  and  then  mark  the  option  ‘Visible’  in  the
context-menu that will be shown. Another way to make an operation visible
is when you check an operation in the operation-list of the Subjects dialog.

To  actually  see  one  of  the  items  (bitmap,  Z-grid,  Toolpath)  of  the  bitmap
operation you have made visible, you also should check the item you want to
see in the Subjects dialog. 

Default Bitmap operation
When  a  new  Bitmap  Operation  is  created,  the  parameters  of  the  new
operations  are  copied  from  the  ones  set  as  default  Bitmap  operation.  This
default Present Operation has been stored somewhere in the computer (in the
registry), this is done for every user who uses the computer.
DeskProto also contains a default project and a default part. The default part
may  also  contain  a  Bitmap  Operation:  in  that  case  the  default  Bitmap
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Operation will also be used when creating a new Project and/or a new Part. 
You can use the default Bitmap operation(s) to enter milling parameters that
you want to use as a standard. For instance a specific tool and/or machining
depth.

To  edit  the  parameters  of  the  default  Bitmap  operation,  go  to  the  Options
menu and select the option Default Bitmap Operation Parameters. This will
open the Default Bitmap Operation Parameters dialog. One of the options in
this dialog leads to the Default Bitmap Settings dialog.
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4.9 Z-Grid

The Z-grid is an intermediate result, in-between the geometry and a toolpath.
The Z-grid is a sort of height-map of the geometry: a 3D bar graph, with a Z-
value for each XY position. The size of the grid-cells is set by the toolpath
distance  and  the  stepsize  along  the  toolpath.  Normally  you  should  not  be
bothered by this representation of the geometry, however it might be useful
to see what is really happening. For instance in case a hole in the geometry
was  missing  in  the  toolpath,  you  could  check  the  Z-grid.  In  case  present
there, the cause will be that the cutter is too large to fit in the hole. In case
not present in the Z-grid, some error is present is the geometry file. Besides
that  it  can  also  give  an  idea  of  how  the  final  result  will  look:  a  rough
simulation  of  the  part  to  be  created.  Especially  when  you  view  it  as  a
rendered Z-grid.

Here’s an image with a Z-grid and the rendered one (do note that a rendered
Z-grid for an accurate toolpath takes some time to draw on your screen). 

The  pictures  show  a  line-drawing  and  a  rendered  Z-grid  (to  be  displayed
using the "Subjects in View" dialog) The grid-structure is clearly visible. It is
in fact a simulation of the part that will be actually machined.  Do note that
any  undercuts  present  that  are  present  will  become  solid.  Especially  for
inverse milling this rendered Z-grid is useful as a  simulation to show what
will be created. Do also note that a very strong staircase effect is visible.  In
the actual model the stairs will be partially smoothed away due to the size of
the cutter (as it cannot create sharp inner corners).

How to calculate it
You  can  let  the  Z-grids  be  calculated  by  selecting  the  option  Calculate  Z-
grids under the Create - Extra menu. Another way of doing it is checking the
Z-Grids checkbox or the Rendered Z-Grids checkbox in the Subjects dialog.
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4.10 Toolpath

The Toolpath is the path that the cutter will follow to create a model on the
milling machine. More specific, it is the series of positions for the tip of the
cutting tool (in XY the center of the tool, in Z the lowest point of the tool).
The start of the toolpath is drawn as a small red cone pointing downward, the
end by a similar cone pointing upward. These cones are NOT the workpiece
zero  point:  in  the  Subjects  dialog  an  option  is  present  to  display  an  extra
orientator at the workpiece zero point.

The  toolpath  is  a  very  important  representation  for  a  visual  check  before
starting  the  milling  machine:  any  possible  errors  should  be  found  before
milling. Here’s an image of a toolpath.

Most lines are drawn as solid lines (default in red), indicating a normal speed
(Feedrate). 
Lines drawn in purple indicate that the feedrate is  reduced by  DeskProto's  
Dynamic Feedrate Control.
Some  lines  are  dashed  in  grey,  indicating  that  they  are  Rapid  movements
(moving as fast as possible). 
The  toolpath  depends  on  the  settings  made  in  the  Operation  Parameters
dialog. 

After  calculating  a  toolpath  using  the  command  Calculate  toolpaths  the
toolpath will automatically be switched on in the scene (made visible in the
Subjects  dialog).  To  send  this  toolpath  to  the  machine  it  should  be  post-
processed to an NC-program, which is done using the command Write NC-
program  file.  How  it  will  be  post-processed  is  determined  by  the
postprocessor which is linked to the milling machine you use.
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How to calculate it
You  can  let  the  toolpaths  be  calculated  by  selecting  the  option  Calculate
Toolpaths under the Create - Extra menu. 

As a shortcut this convenient button is present. 
Another way of doing it is checking the Toolpaths checkbox in the Subjects
dialog.
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4.11 Simulation

The NC program file is in fact the final result of DeskProto: sending it to the
machine will produce the desired model. It may be useful though to preview
this resulting model on screen, in a machining Simulation.

The Simulation is a drawing on screen that shows you what the resulting part
will  be.  This  can  be  used  to  check  things  like  the  resulting  surface
smoothness,  error  movements  (if  any)  that  damage  the  part,  rest  material
where the cutter cannot  reach,  etc.  DeskProto will  calculate a simulation in
3D, so you can rotate, pan and zoom it just like any other subject on screen.
The speed of this 3D drawing can be optimized using the Graphics option for
the simulation in the Advanced Preferences.

Currently the DeskProto simulation can do one operation at a time, and only
for  3  axis  machining.  Simulations  for  rotation  axis  machining  and  for  2D
Operations are not possible. 
You  can  set  the  accuracy  of  the  simulation  on  the  Simulation  tab  of  the
Operation parameters.
You can calculate a simulation by using the Calculate Simulation command
in  the  Create  menu.  You  can  also  switch  the  simulation  on  and  off  in  the
Subjects Dialog to have a simulation calculated and shown.

The  example  drawing  above  of  a  Bottle  Toolpath  clearly  shows  the  rest
material in-between the ballnose toolpaths (such ridge is called cusp).

The  DeskProto  simulation  allows  you  to  compare  the  simulation  with  the
original geometry, and indicate any differences with a color. Rest material in
green,  too  much  material  machined  in  red.  On  the  Simulation  tab  of  the
Operation parameters the user can select whether or not to use these colors,
and also the tolerance to be used. 
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In the example drawing above you can for instance see that the cutter is too
thick for the small inner radius at the neck of the bottle (just below the cap).
At that location rest  material  is  left  over,  indicated  in  green.   Note  that  the
red color is only visible in case the geometry is switched off in the Subjects
dialog.

How to calculate it
You can let the Simulations be calculated by selecting the option Calculate
Simulation under the Create menu. Another way of doing it is checking the
Simulations checkbox in the Subjects dialog.
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4.12 NC-program

NC stands for Numerical  Control  (we will  also  use  CNC,  which stands  for
Computerized  Numerical  Control).  An  NC-program  file  contains  an  NC
program:  a  series  of  instructions  for  a  CNC milling  machine  to  execute.  It
can  be  sent  to  a  machine  to  make  it  execute  the  NC  program.  Each  file
contains  commands  for  a  specific  machine  (or  machine-type).  So  an  NC-
program is  machine-dependent:  its  format  will  be  different  per  machine.  In
general it is a file which can control an NC-machine.
Almost any NC program file is in plain ASCII: you can read and edit it using
a plain text editor like Notepad.

How to create it
The  toolpaths  calculated  by  DeskProto  can  be  saved  to  an  NC-program
choosing the option Write NC-program from the Create - Extra menu.

As a shortcut a convenient button is present.

DeskProto  will  try  to  combine  the  toolpaths  of  all  Operations  of  one  Part
into one combined NC program file.
Or,  if  Chaining  has  been  applied,  even  toolpaths  of  Operations  in  several
Parts can be combined.

NC Files list
DeskProto can show you a list of all NC files that have been written for the
current  project.  This  is  shown  in  the  NC  Files  window,  below  the  Project
Tree. If this window is not visible you can check it in the View menu.

Selecting machine and postprocessor
The  format  of  the  NC-program  you  produce  will  be  determined  by  the
postprocessor  which  is  linked  to  the  machine  you  use.  You  can  select  this
machine at the Part Parameters dialog.

Sending NC-program to machine
For some machines it’s possible to send an NC-program to the machine from
within  DeskProto.  How  to  do  this  see  the  option  Send  NC-program  To
Machine from the Create menu.
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4.13 Libraries

There are three libraries. One for machines, one for postprocessors and one
for cutters.
Each library is displayed in a dialog like this:

A library is just a collection of definitions. You can either add, copy, remove
or edit an item. The definitions are saved to disk in the file location Drivers,
which can be set at the General tab page of the Preferences dialog box. They
are saved to disk when you click the OK-button of the library-dialog.

When  you  add  or  copy  an  item,  you  can  set  all  the  values  including  the
filename. When you edit an item you can set all values except the filename.
If  you  do  want  to  change  a  filename  of  a  cutter,  postprocessor  or  machine
you  can  use  Windows  Explorer  to  do  so.  Preferably  you  do  this  when
DeskProto  is  not  running  (so  close  DeskProto  first)  because  otherwise  the
old filename will be saved again when closing the library. The file with the
new name will be automatically loaded when you restart DeskProto.

See Library Of Machines, Library Of Postprocessors and Library Of Cutters.

All  these  definitions  are  stored  in  files  (machines  in  .mch  files,
postprocessors  in  .ppr  files  and  cutters  in  .ctr  files),  to  be  stored  in  the
Drivers directory of DeskProto. All these files are plain ASCII text files, that
can also be edited using a plain text editor.
For editing no help information is present, so only do so if you are sure what
you are doing.
With DeskProto Version 4.1 or newer it is possible to use comments in these
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files:  any line that starts  with a semicolon (“;”) is  considered comment and
thus ignored by DeskProto.
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4.14 Editions

DeskProto is available in three different Editions:
· Entry Edition
· Expert  Edition
· Multi-Axis Edition

The  Entry  Edition  is  the  lowcost  version  of  DeskProto,  offering  limited
options, at a very low price.
In this edition only a few tab pages are present in the Part parameters and the
Operation  parameters:  most  of  the  parameters  as  described  in  the  Help  file
are not available. Still the most important parameters are there: so even this
extremely cheap CAM program allows you to do very complex 3D jobs.

The  Expert  Edition  includes  all  parameters,  except  for  the  rotation  axis
options. So the fourth axis and the fifth axis are not available in this edition.

The  Multi-Axis  Edition  is  the  most  complete  version:  all  parameters  are
present, and so are the A-axis and B-axes rotation axes.

More information in the Upgrade dialog. A full edition comparison table can
be found on www.deskproto.com 

When  in  Trial  Mode,  DeskProto  will  start  with  a  special  dialog:  the  Trial
screen. This dialog reminds you how many trial days are left, and gives you
the option to start one of these three Editions.  That way you can really  test
which edition is best suited for your application.

When  the  trial  period  has  expired,  DeskProto  still  can  be  started  (in  Trial
mode), only it will no longer be possible to save NC program files. Note that
you still can save project files (DPJ files), so you can use the free trial license
to prepare a project and then use the paid license to calculate the NC file. For
schools  this  makes  a  very  lowcost  classroom  license  possible:  one  paid
educational license plus many free (expired) trial licenses.

After registering your license only the Edition that you have bought can be
started:  the  registration  code  includes  information  about  the  Edition  you
have bought a license for.

http://www.deskproto.com
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4.15 Indexed machining

A rotation axis or 4th axis on a CNC milling machine can be applied in two
different ways:
- the part can be rotated during machining (continuous rotation)
- the part can be machined from one side (three axis machining), then rotated
and machined from a second side, etc.

The first method is in fact 'real' rotation axis machining, the second method
is called indexed machining.

DeskProto  supports  both  methods:  the  first  by  checking  box  "Use  rotation
axis" in the Part parameters, the second using the wizard Two or more sides,
automatic rotation, commonly called the N-Sided Milling wizard.
Obviously  these  options  are  available  only  in  the  Multi-Axis  edition  of
DeskProto.

The N-sided wizard  makes it very easy to achieve indexed machining on a
four-axis machine:
You can choose any number for N, from 2 up to 99.
The wizard then will  automatically generate N parts  for  you,  and apply the
correct  rotation  for  the  geometry  in  each  Part.  The  rotations  are  evenly
spread (360 /  N),  if  needed you can select  a  higher  N and then  later  delete
some of the parts.
Support blocks (a cylinder shaped block left and right) are optional.
In each part one or two operations (finishing, and optionally roughing first):
the wizard will link all these operations into one large Chain in order to write
one combined NC file for the complete indexed milling process.
The required A-axis rotation commands for the rotation axis (in-between the
operations) are entered in the operation's Start/End commands.

DeskProto  also  supports  indexed  machining  on  five-axis  milling  machines
(five-axis continuous rotation is not supported). This works exactly the same
as with four axes: you create a series of parts, specify the correct rotation for
each  part,  and  specify  that  same  rotation  in  the  Start  commands  of  each
Operation. Only now both an A-axis rotation command and a B-axis rotation
command need to be specified.

The process however is much more complex than for four axis, as five-axis
machines  are  available  in  many  configurations.  That  is  why  DeskProto
cannot offer a wizard to automatically create such project for you. A detailed
instruction for five-axis indexed machining can be found in Lesson 7 of the
DeskProto  Tutorial  book  (can  be  downloaded  as  PDF).  Including  a  nice
sample project.
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4.16 Two-sided machining

Some models can be completely machined form one side,  like the relief  on
DeskProto's  DpPictureFrame sample geometry.
For  other  models,  like  the  perfume  bottle  sample  geometry,  this  is  not
sufficient.
A complete bottle can be created in three ways:

1. Machine  two  separate  halves  and  glue  these  to  one  another  to  make  a
complete  model.  This  is  the  easiest  way,  which  works  great  for  many
types of models. For instance for an electric hand-drill or similar tool.

2. Use  a  rotation  axis  to  rotate  the  model  during  machining.  This  is  called
rotation axis machining.

3. Machine the model from two sides, so flip the block upside-down halfway
through  process.  This  flipping  can  be  done  either  manually  or
automatically using a rotation axis device. 

This  help  page  concerns  Two-Sided  machining  using  the  manual  flip,  for
the automatic one see the page on indexed machining.

Machining from two sides comes with some extra issues:
- how to hold the part after turning it upside down
- how to make sure that both sides are perfectly aligned
- how to correctly set the WorkPiece zero point for the second side, making
it match the first side.

The  Two-Sided  milling  wizard  (manual  flip)  will  help  you  to  create  a
complete  model  in  one  piece,  by  machining  it  from  two  sides.  The  total
block of material to be used is larger than the model, leaving a frame around
the  model.  This  frame permits  you (after  machining  the  first  side)  to  again
clamp the model in order to machine the second side as well (turned upside
down). See the illustration below, where the yellow part  is  the  block,  or  in
fact what has remained after milling (top view).
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Obviously  the  model  needs  to  remain  connected  to  the  block  when  the
second side is machined. This is done by the so called Support Blocks: four
small  rectangular  blocks  that  function  as  Bridges  of  Tabs  to  connect  the
model  to the  remaining  part  of  the  block.  In  the  illustration  above  the four
red rectangles are the Support Blocks.
At this point  DeskProto will  also  lock  the Operation’s  sub-segment  (so the
area to be machined) to the current geometry (including the Support Blocks)
by setting it to Custom, and DeskProto will switch off the borders to prevent
the tool from cutting the outside surface of each support block (as the would
disconnect it from the main block).

DeskProto will  set  the block’s  width and depth (X and Y).  For X both  left
and  right  25  mm  (or  1  inch)  is  added,  permitting  you  to  clamp  down  the
block on the machining table at that spot. For Y both front and back 10 mm
(or  ½ inch)  is  added to  end up  with  a  block that  is  sufficiently  stable  after
machining.  These  dimensions  need  not  be  very  accurate.  A  bit  oversize  is
advised,  making  sure  that  you  can  machine  a  reference  plane  later  in  the
process.

In contrast, the height of the block (Z) needs to be very accurate as otherwise
the  second  side  will  not  be  correctly  positioned  relative  to  the  first.  In
practice  you  can  easily  satisfy  this  requirement,  as  you  can  buy  most
materials  in  slabs  at  an  exact  thickness.  Of  these  slabs  also  both  sides  are
exactly parallel to one another. 
The size of the total block is defined in the Part segment.

Note  that  DeskProto  can  be  configured  for  two  different  block  types:
floating  size  and  fixed  size.  The  first  type  is  default,  and  determines  the
block  size  by  adding  a  certain  frame  thickness  on  all  four  sides  (see  the
illustration below). The second type uses, as its name indicates, a fixed block
size.  In this case it  is  possible  that  the  part  does  not  fit  in  the  block (some
minimum margin is needed as a frame): in such cases a warning message will
be  issued  and  you  need  to  scale  down  the  part.  The  choice  between  both
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types of block, and the actual dimensions, can be set in the preferences page.

DeskProto makes it easy for you to correctly position the two sides relative
to one another. Or in other words: to set the correct workpiece zero point to
machine a second side that exactly fits the first.  For this aim DeskProto uses
two  rulers  (stop-bars)  that  are  exactly  parallel  to  the  machine’s  axes,  and
have a known position. See the illustration below: the long ‘horizontal’ bar
is parallel to X, at a known Y position, the short ‘vertical’ bar has a known
X-position  (as  it  is  short  being  parallel  is  less  important  here).  The
workpiece  zero  point  for  both  NC  program  files  has  to  be  set  at  the  exact
point  where  both  rulers  meet,  with  the  Z=0  set  with  the  tip  of  the  tool
touching the top of the block. This zero point remains the same after turning
the block upside down for the second side. Also see the illustration below.

After machining the first side, you have to machine two reference planes, on
the  block’s  back  and  left  side:  see  the  blue  line  in  the  illustration.  The
reference plane on the left is on position X = 0 and needs not  be along the
complete  side  (which  would  not  be  possible  because  of  a  clamp).  The
reference plane on  the back is  on  a  Y-position  specified  in  the  Report  file,
and  needs  to  be  machined  along  the  complete  back.  After  turning  upside-
down these two reference  planes  will  exactly  touch the rulers,  making  sure
that the block is exactly lined up with the machine, and exactly at the correct
position.

Note: 
The Ruler /Reference plane method just described is just one method: more
methods  are  available  to  correctly  position  the  block  after  turning  upside-
down. For instance using reference pins on the machining table, and drilling
holes  to  exactly  fit  these  positioning  pins.  The  Two-Sided  Milling  Wizard
can be used with any of these positioning methods, as long as they result in
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the block having the same position before and after turning upside-down.

The  Report  file  just  mentioned  will  be  generated  upon  pressing  the  Create
button, and gives all  information needed for the machining from two sides.
The file is opened in Notepad, making it easy to print the file and/or to save
it.  Default  filename  is  Wizardlog.txt:  do  save  it  using  a  different  name  to
prevent it from being written over by a next wizard.

Of  course  you  are  free  to  still  fine-tune  the  results  of  the  wizard  before
starting on the machine.  You can  still  change any parameter  after  finishing
the wizard:  also parameters  that  have not  been set  by the  wizard.  You may
also  add operations,  for  instance  some extra  finishing with  a  small  tool  for
some specific detail. In case of using more operations make sure to create the
new  operations  by  Copying  an  operation  set  by  the  Wizard,  not  by  just
Adding a (default) operation. That way all settings made by the wizard will
be copied as well.
After changing any parameter  you will  have to  again  save  the  NC program
file that was written by the wizard.

A  wealth  of  information  on  two-sided  machining  is  available  in  the
DeskProto  Tutorial  book  (can  also  be  downloaded  as  PDF):  Lesson  4  is
about  two-sided  machining,  and  shows  you  how to  machine  a  nice  sample
geometry:  a  cellphone's  front  cover.  This  STL  file  is  a  free  download  on
www.deskproto.com

http://www.deskproto.com
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4.17 Rotation axis machining

A rotation axis or 4th axis on a CNC milling machine can be applied in two
different ways:
- the part can be rotated during machining (continuous rotation)
- the part can be machined from one side (three axis machining), then rotated
and machined from a second side, etc.

The first method is in fact 'real' rotation axis machining, the second method
is called indexed machining.
DeskProto supports both methods, obviously only in the Multi-Axis edition
of DeskProto.

Rotation axis machining can be selected by checking the box "Use rotation
axis" in the Part parameters.
An easier way is to use the Rotary machining wizard. 

Rotation  axis  machining  in  DeskProto  in  fact  still  is  a  type  of  three  axis
machining: instead of moving X, Y and Z at the same time, now X, Z and A
are moved. In a DeskProto NC program file for Rotation axis machining no
Y-coordinate value is present.
This  can  cause  a  problem,  as  then  before  starting  the  cutter  needs  to  be
positioned along Y exactly above the rotation axis, so at Y = 0.0.   In order
to make sure that you do not forget this you can enter this command Move to
Y  =  0.0  as  one  of  the  Start  commands  for  a  rotation  axis  operation.
 DeskProto  does  not  do  this  automatically,  as  this  is  not  possible  on  all
machines  (moving only  one  axis  as  first  movement  command)  and  as  such
movement may damage your machine in case the current Z is too low.

A  wealth  of  information  on  rotation  axis  machining  is  available  in  the
DeskProto  Tutorial  book  (can  also  be  downloaded  as  PDF):  Lesson  3  is
about  rotation  axis  machining,  and  shows  you  how  to  machine  a  great
sample  geometry:  the  head  of  the  famous  Venus  de  Milo  statue.  This  STL
file is a free download on www.deskproto.com

http://www.deskproto.com
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V Troubleshooting

5.1 Trial period problems

After the trial period of 30 days has expired, DeskProto will run with limited
functionality.  NC-program files  can  no  longer  be  saved.  Note  that  you still
can  save  project  files  (DPJ  files),  so  you  can  use  the  free  trial  license  to
prepare a project and then use the paid license to calculate the NC file.  You
also still can use the trial program as free STL file viewer, and also as format
converter (DXF to STL and more).
In some cases though DeskProto runs with limited functionality while your
30 days trial period has not been passed. In most cases this will be the result
of tampering with your PC's system date. A few situations that may lead to
problems:

1.  The system date has been set to some future date after installation of the
DeskProto  Trial  version  (later  than  the  end  of  the  trial  period).  DeskProto
now thinks  your  30  days  already  have  past.  The  trial  period  can  not  (!)  be
reset again.
Warning:
Be sure that the date is set correctly both before you install DeskProto Trial
version and before you run the DeskProto Trial version.

2.  The system date or time has been set  backwards after  installation of  the
DeskProto Trial version. DeskProto will detect  this, making it impossible to
increase your trial period by doing that.
Warning:
In  case  the  system  date  or  time  has  been  set  backwards  in  time,  reset  the
correct date before you run the DeskProto Trial version.

3.  The  system  date  was  wrong  when  you  installed  the  trial  version  (for
instance an empty CMOS battery on the PC's motherboard).
Warning:
Make  sure  the  system  date  is  correct  before  installing  the  DeskProto  trial
version.

As  the  30  days  trial  protection  has  been  implemented  using  a  third  party
Software Development Kit, we have no tools to reset or prolong the 30 days.



Troubleshooting

Page 223

DeskProto Reference

5.2 Support

If  you  encounter  problems  while  working  with  DeskProto,  please  try  the
following:

1. Search for a solution in the on-line Help system.

2.  Look  in  the  FAQ  (Frequently  Asked  Questions)  on  the  DeskProto
website.

3. Look in the Forum on the same website

4. Carefully read the appropriate sections in the printed Manuals.

5. In case no solution found: ask the Dealer who supplied DeskProto to you.

In case of any other problem: contact Delft Spline Systems.
When you send us  a  project  please  do  so  using  the  option  Create  Problem
Report.

http://www.deskproto.com/support/faq.htm
http://www.deskproto.com/support/forum.php
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VI Various

6.1 Initial Personal Settings dialog

This dialog will be shown only once: when DeskProto is started for the first
time after it has been installed.

You have to select the Machine  that  will  be used as the machine for every
new project and for every new part. Click on the arrow to show the list that
you can choose from.
For advanced users: in DeskProto the Postprocessor is one of the settings in
the  machine  definition.  So  you  select  a  postprocessor  when  selecting  a
machine.
You  also  have  to  set  the  Measurement  unit  you  want  to  use  within
DeskProto:  mm  or  inch.  All  user-interaction  will  show  this  unit,  and
geometry files will be loaded using this unit.
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What to do when your machine is not listed ?
This is a very common situation (as the number of machine builders and the
models that they produce is almost infinite), and in most cases easy to solve.
Please follow the three instructions given below.

1.  Look  if  you  can  find  a  different  model  made  by  the  same  machine
builder. In most cases a machine builder uses the same NC file format for all
machines, so you may expect that the resulting NC files will be OK for your
machine  as  well.  Try  to  run  an  NC  file,  and  if  positive  proceed  to  "Add
machine" below.
Important: when you look for your machine in the alphabetical list you also
need  to  look  under  the  Manufacturer's  name.  For  instance  the  Magic7
machine is listed as "REDT - MAGIC-7", and the High-Z machines are listed
as "Heiz High-Z"

2.  Look if  you can  find  a  generic  machine  definition  for  the  controller  or
control software that you use. Like for the Mach3 control software one of the
machines  called  "Mach2  /  Mach3  based  machine",  or  for  the  USBCNC
controller the machine called "USBCNC based machine". Try to run an NC
file, and if positive proceed to "Add machine" below.

3. Most machines will run on NC files written in standard G-codes. G-code
is the official standard for NC files, defined by ISO (International Standards
Organization).  Unfortunately  each  machine  builder  has  developed  his  own
flavor  of  this  standard,  and  not  all  G-code  files  are  compatible.  Still  when
your  machine  runs  on  G-code,  you  have  a  good  chance  that  it  will  work
when you select the machine called "ISO plain G-codes".  Try to run an NC
file, and if positive proceed to "Add machine" below.

Add machine. When a test is positive then you can add your own machine to
the list as follows:
Options > Library of machines > OK on warning > Select the machine that
you  tested  with  and  press  button  Copy.  Now  give  the  new  copy  a  proper
name  and  filename.  Make  sure  that  you  do  not  change  the  postprocessor.
Enter the correct dimensions and speeds, if needed add a rotation axis in de
Advanced machine settings. For more information use the Help button of the
Machine dialog.

When  your  machine  has  an  optional  rotation  axis  it  is  possible  that  the
machine-definition  in  DeskProto  does  not  have  that  option  checked.  It  is
easy to add it in the machine definition (see the previous paragraph), on the
Advanced settings page.

The default Machine is stored in the Default Part,  and can be changed later
by choosing the option Default Part Parameters from the Options menu.
The measurement unit will be saved in the Preferences. You can later change
this setting in the Preferences dialog (Options menu).
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These initial settings will be stored per user of the computer, so any new user
will see this dialog when he/she starts DeskProto for the first time.
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6.2 Migrate Settings dialog

DeskProto stores many of the user's defaults and preferences in the Registry,
conform Microsoft's  guidelines  for  Windows programs.  When you install  a
newer DeskProto you can choose whether or not you want to keep using the
settings of your old DeskProto, so whether or not to migrate them to the new
version.

Two different situations are possible:
1. You have reinstalled the same version  (for instance you have installed a
new DeskProto  V  6.1   over  an  existing  DeskProto  V  6.1).  Then  the  Keep
Settings dialog will be shown.
2.  You have reinstalled  a newer version  of  DeskProto  next  to  an  old  one.
For  instance  you  have  installed  a  new  DeskProto  V  6.1  on  a  PC  where  a
DeskProto V 5.0 was already present.
Then DeskProto will pop up the Migrate Settings dialog as shown above.

Your  personal  settings  for  each  DeskProto  version  will  be  stored  on  a
different location in the registry, so you have the option to migrate your old
settings to V6.

When  you  answer  Migrate,  DeskProto  will  read  all  settings  of  the  old
DeskProto and save them as settings for the new version..
When  you  answer  No  thank  you,  nothing  will  happen,  and  the  new
DeskProto will start with system default values.
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Special  attention  is  needed  for  the  drivers:  Machines,  Postprocessors  and
Cutters.
These  are  not  stored  in  the  Registry,  but  as  files  in  the  DeskProto  Drivers
directory.
DeskProto  cannot  just  copy  all  old  files,  as  then  any  improved  versions  in
the new Setup would be overwritten and thus deleted.
So  the  new  drivers  that  you  added  in  your  old  DeskProto  are  not
automatically copied:  you will  need to do that by hand. For the location of
these folders see the link above.

One  exception  is  present  though:  in  case  your  default  cutter  or  default
machine  is  NOT  in  the  list  of  drivers  installed  by  the  new  Setup,  then
DeskProto will copy that file from the previous version to the drivers folder
of the new version. So this is done ONLY for the cutter(s) that are selected
in one of the default Operations, and for the machine that is selected in the
default  Part  (plus  its  postprocessor).  This  way  you  can  indeed  keep  your
default settings.
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6.3 Keep settings dialog

DeskProto stores many of the user's defaults and preferences in the Registry,
conform  Microsoft's  guidelines  for  Windows  programs.  When  you  again
install  DeskProto  you  can  choose  whether  or  not  you  want  to  keep  using
these settings.

Two different situations are possible:
1. You have reinstalled the same version  (for instance you have installed a
new DeskProto V 6.1  over  an  existing  DeskProto  V  6.1).  Then  this  Keep
Settings dialog will be shown, further see below.
2.  You have reinstalled  a newer version  of  DeskProto  next  to  an  old  one.
For  instance  you  have  installed  a  new  DeskProto  V  6.1  on  a  PC  where  a
DeskProto V 5.0 was already present.
Then DeskProto the Migrate Settings dialog will be shown.

This Keep Setting dialog offers you two options:

- when you answer Keep settings, nothing will happen: 
DeskProto will keep using the settings as they were.

- when you answer Reset settings, DeskProto will delete the old settings,
causing the DeskProto system defaults to replace them.
So when you have made a giant mess of your settings this is an easy way to
delete them all.
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6.4 OpenGL driver warning

DeskProto  uses  a  graphics  language  called  OpenGL  to  display  graphics
information (a drawing) in its View Window. All information on your screen
is generated by the Windows display driver, a piece of software that comes
with  the  graphics  card  in  your  PC.  DeskProto  needs  a  display  driver  that
supports OpenGL.

Almost  all  current  Windows  display  drivers  support  OpenGL  graphics,  so
the chance of seeing this warning dialog is small. If you still get is then we
strongly advise you to update your display driver. You then need to find out
the  brand  and  type  of  your  graphics  card,  visit  the  website  of  the  card
manufacturer  and  there  look  for  a  driver  for  your  type  card.  In  most  cases
you can download drivers in a section called Support or Download.

In case you have a choice, select the driver that supports OpenGL.
Like  for  all  AMD  Graphics  cards  (formerly  ATI),  where  you  can  choose
between downloading
1- the Catalyst Software Suite
2- the WDM Integrated Driver
Here  you  need  to  select  the  Catalyst  suite,  as  the  obsolete  WDM  driver
(Windows Driver Model) does not support OpenGL. Windows then will fall
back  on  its  old  software  renderer  (OpenGL  V1.0)  to  create  the  graphics,
which misses some features and will also make DeskProto very slow.

Important to know is that using the button "Update Driver" in the Windows
Device Manager does not always find the latest driver ! So you need to check



Various

Page 231

DeskProto Reference

the card manufacturer's website.

A  big  advantage  of  OpenGL  is  that  it  makes  hardware  implementation
possible:  let  specialized  hardware  on  the  card  do  graphics  calculations,
making  it  much  faster  than  using  software.  The  more  expensive  your
graphics card, the more can be done by hardware, and the faster all graphics
will be displayed.
An important  feature  is  the  Retained mode  rendering,  as  mentioned  in  the
warning text. This means that the complete 3D scene is  stored in the card's
graphics  memory,  using  a  vertex  buffer.  So  in  order  to  change  the
viewpoint,  the  software  only  needs  to  send  the  new camera  position  to  the
card, the rest will all be done in hardware. You can imagine that this is much
quicker than again sending the complete scene to the graphics card for each
change (which is called immediate mode).
Vertex buffers are available from OpenGL V 1.5

A few OpenGL related setting can be found in the Preferences. In case of a
limited driver not all functions will be available.

Other  DeskProto  functions  that  may  be  disabled  when  using  this  limited
driver:

-  In  order  to  print  graphics  the  OpenGL  driver  needs  to  support  a  pixel
buffer: a sort of invisible graphics screen on which the drawing can be made
before sending it to the printer.
Pixel buffers are available from OpenGL V 2.1

-  The  option  to  automatically  generate  a  freeform  segment  around  the
geometry  (button  "Generate  Contour"  in  the  Set  Freeform Segment  dialog)
also needs a pixel buffer.

-  For  drawing  points  on  the  toolpath  (option  Show  points  in  the  Subjects
dialog)  one  small  sphere  drawing  is  repeated  many  times.  This  uses  a
function that is available from OpenGL V 2.1

This  warning  is  optional:  when  you  remove  the  mark  from  checkbox
"Always show this message" it will no longer be given. You can restore all
warning  messages  on  the  Advanced  tab  of  the  Preferences  (in  group
Settings).
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6.5 File not found warning

When  opening  a  project  file,  the  geometry  file  that  was  used  will  be  read
again:  the  DPJ  files  does  not  store  the  geometry  but  only  a  link  to  the
Geometry  file.  The  geometry  file  must  thus  be  found  at  the  same  place  as
where it was when the project file was saved. 

If  the  geometry  file  cannot  be  found  (for  instance  when  the  DPJ  file  was
copied  from  a  different  computer  system)  then  DeskProto  will  check  if  a
geometry  file  with  the  correct  name  can  be  found  in  the  current  directory
(same as the DPJ file) or in the default Data directory. If yes, DeskProto will
ask you if it can use that file instead, using a dialog as shown above.
You then can choose to either use that file at the alternative location, 
or browse to use a file on some other location.

The option Apply to all files is useful in case your project file contains more
references to external files, like 2D files in 2D Operations, and Bitmap files
in Bitmap operations. This option makes it possible to use the now location
for all file references in the project.
If the option is not checked then this same dialog may be shown a number of
times, one for every file that could not be found.

If the file also cannot be found on any of these alternative locations, then this
error-message will be displayed:
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After  pressing  the  OK  button  the  Project  Parameters  dialog  will  appear,
giving you the opportunity to browse the correct geometry file. 
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6.6 Template Project

Sometimes you deal with a series of projects that very much look like each
other:  all  settings  equal,  however  with  slightly  different  geometries.  In  that
case you don’t want to define the parameters for each project from the start. 

A first  possible  solution is  to then enter  all  parameters  as Defaults  (default
Part  and  default  Operation).  When  you  then  start  DeskProto  and  load  a
geometry,  all  parameters  have  already  been  set  and  you  can  immediately
calculate  the  toolpaths.  This  even  makes  it  possible  to  fully  automate
DeskProto: see the paragraph on Command Line Parameters.  However, this
solution only is useful if all your projects need these same parameters.

In case you have several types of projects, then the alternative solution is to
create a project without a geometry, which is called a template project.
In  DeskProto  you  can  set  most  parameters  without  loading  a  geometry.
When  saving  such  project  DeskProto  will  warn  you  that  no  geometry  is
present: in order to create a template project continue on that point.
When  you  later  open  a  template  project,  then  DeskProto  will  immediately
show a File-Open dialog to load a geometry file into the project.

Template projects are possible only for the 3D geometry file.
It is not possible to create a template project  that  asks the user  to browse a
2D file or a bitmap file.

Here some examples:
· You  might  want  to  define  a  project-template  you  can  use  for  a  certain

material.  For  instance  when  you  always  machine  dental  models  your
settings are always the same. However some models are in zirconium and
some in wax, needing different settings.

· You  might  want  to  define  a  project-template  for  moulds,  using  inverse
milling.

· You might want to define a project-template with one part defined as top
part,  another  defined  as  bottom part  (with  correct  transformations),  each
containing one operation for roughing, and one for finishing.

To use such a template project, open the project which serves as a template,
and load the geometry file that you want to use. Save it directly after loading
under a different name. After that you can safely edit the new project without
changing the template project.

A third option for automation is writing a Script.
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6.7 Command Line Parameters

It is possible to run DeskProto with one or two command line parameters. 
This  feature  is  not  meant  for  ‘normal’  users,  but  rather  for  application
builders  who  need  to  include  toolpath  calculations  in  their  application.  So
when you do not know what a command line parameter is please ignore this
paragraph.
Other ways to automate DeskProto are Template projects and Scripts.

Important information for upgraders from older DeskProto versions:
Previously, for starting DeskProto you needed to call the file dp.exe
From V 6.1 it is needed to call the file DeskProto.exe

The easiest Command line parameter is to use the name of the geometry file
(STL file). 
In the Run dialog of the Windows Start button you can for instance enter the
following command:
"C:\Program  Files\DeskProto  6.1\deskproto.exe"  "C:\User\STLdata
\medaillon.stl"
This  will  start  DeskProto  and  automatically  load  the  Medaillon  geometry.
The STL file needs of course be present in the directory as specified.

It is also possible to automatically load a DeskProto project file  (DPJ file)
on start. For instance:
"C:\Program Files\DeskProto 6.1\deskproto.exe"  C:\torso.dpj
This project may also be a Template project.

It  is  also  possible  to  automatically  load  a  DeskProto  script  wizard  file
(DPW file) on start. For instance:
"C:\Program  Files\DeskProto  6.1\deskproto.exe"   "C:\Program  Files
\DeskProto 6.1\Wizard\123waxRing.dpw"

It is also possible to automatically load a DeskProto script file on start. For
instance:
"C:\Program  Files\DeskProto  6.1\deskproto.exe"    "C:\Program  Files
\DeskProto 6.1\Scripts\ScriptedBottle.js"

A very convenient way to configure a command line parameter is by editing
the  Shortcut  on  the  desktop  (click  it  with  the  right  mouse-button,  in  the
context  menu  choose  Properties,  select  Tab  Shortcut):  you  can  add  the
command line parameter to field Target.

The  above  options  start  DeskProto  and  load  data,  nothing  more  (except  of
course in scripts). Calculating toolpaths and writing the NC file still have to
be  done  by  the  user.  DeskProto  allows  you  to  automate  this  as  well.  You
then  need  to  start  DeskProto  with  TWO  command  line  parameters,  the
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second being the name of the NC file.

For instance: issue the following command:
"C:\Program Files\DeskProto 6.1\deskproto.exe"  C:\casting.stl  C:\casting.
nc
As  a  result  DeskProto  will  be  started,  the  file  casting.stl  will  be  loaded,
toolpaths  will  be  calculated,  the  NC  file  casting.nc  will  be  written,  and
DeskProto  will  be  shut  down  automatically.  The  user  just  sees  DeskProto
coming up and closing down again.
The parameters used will be the parameters as set in the defaults. This works
great  when  the  application  involves  repeating  the  same  job  with  a  slightly
different  geometry.  The  application  programmer  can  include  DeskProto  in
his  application  without  bothering  the  end-user.  Calling  DeskProto  with  the
correct  command  line  parameters  can  be  done  by  a  macro  that  runs  in  the
CAD software used, or by a stand alone application.

In this case too: the first file may be either an STL file or a DPJ file. When a
DPJ file is loaded the parameters in this file will of course be used, not the
current DeskProto defaults. This can be used when the STL file used has the
same name for all models.
This option allows you to achieve full automation like mentioned above, for
two sided milling.
For instance:
"C:\Program  Files\DeskProto  6.1\deskproto.exe"   C:\TwoSided.dpj   C:
\TwoSided.nc
When you do this with a template project file DeskProto will prompt the user
to browse an STL file

We strongly advise to create both command line parameters including a path
specification. In case the first  parameters comes with a path and the second
does not, the NC file will be written in the directory of the first (STL or DPJ)
file.

This trick also works in case the  parameters  cause DeskProto to  save  more
than one NC program file  because of a toolchange:  the standard DeskProto
naming conventions will be used for the NC files.
In case the DPJ file that is loaded contains more than one part,  then for all
parts  NC  files  will  be  written,  also  extending  the  NC  filename  using  the
standard DeskProto naming conventions for multiple NC files.

The file extension of the NC-file needs not be the one that is prescribed by
the postprocessor: the name on the command line will overwrite that.
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6.8 Scripts and Script Wizards

A Script  or Macro  is  a  program: a series  of commands for DeskProto that
will  be  executed  one  by  one.  Programs  are  written  in  a  programming
language:  DeskProto  scripts  need  to  be  written  in  JScript  (JavaScript,  file
extension .js). 

A script can be called in DeskProto using the command Run Script...  in the
File menu.
You can also start a Script by calling it as command line parameter.
Default directory for script files is the Scripts subdirectory of DeskProto ( C:
\Program Files\DeskProto 6.1\Scripts)

A Script  is  an  ASCII  text  file  with  a  number  of  lines:  each  line  contains  a
command or part of a command to be executed. The script can call a number
of  objects  (functions)  that  DeskProto  has  made  available  to  the  Scripting
Interface. Most of these objects are Properties (a variable that can be set  or
read) and Methods (a function with one or more parameters).

A  very  simple  example  of  a  DeskProto  script  file  is  present  already
(ScriptedBottle.js):

var  strSampleLocation  =  DeskProto.preferenceSet.getSampleLocation
();
DeskProto.project.loadGeometry(false,  strSampleLocation  +  "Bottle.
stl");
DeskProto.project.activePart.setRotation(-90.0, 0.0, 0.0);
DeskProto.project.activePart.segmentMethod = 2;
DeskProto.project.calculateToolpaths();
DeskProto.project.writeNCProgram( "ScriptOutputNCfile.ext" );
DeskProto.exit();

This script will load the Bottle geometry, orientate it correctly for machining,
set the segment to use the upper half only, calculate the toolpaths using the
default Operation parameters, save these toolpaths in an NC program file and
exit.  
The  second parameter  of  function  LoadGeometry  could have  contained  the
complete path. However as the location of the Samples folder is different per
Windows version (sorry: thanks to Microsoft) this solution is better.

The  available  scripting  objects  are  described  in  the  DeskProto  Script
Reference:  a  series  of  HTML  files  that  can  be  found  in  the  directory
\DPScript\   on  the  DeskProto  CD.   Open  the  file  \DPScript\index.html   to
start reading. If you do not have this CD then please email us.
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A special type of Script that is available in DeskProto is the Script wizard
or Custom Wizard. This is a very powerful option, making it possible to add
you  own  Wizards  to  DeskProto.  Such  wizard  can  make  it  easy  to  use  a
special machine, or to create a special type of product.  A good example are
the Wax Ring Wizards that come with DeskProto:
· the  123WaxRing  Wizard  in  combination  with  the  123WaxRing  fixture

make it very easy to machine a wax ring from three sides.
· the 5thAxisWaxRing Wizard makes it possible to use the 5t axis of the

Roland JWX-10 milling machine to create hollow rings.
Both  wizards  are  Script  Wizards,  and  can  be  found  in  C:\Program  Files
\DeskProto 6.1\Wizard.  You are free to change these (if you know what you
are doing) or use these as examples for your own script wizards.

A DeskProto Custom wizard (also called Script wizard) is a series of HTML
files,  each  file  containing  one  script  to  be  executed.  Each  of  these  HTML
files defines one page of the Wizard, and you can use any HTML option to
layout this page.
For each Custom wizard one DPW-file  is  present that  lists  the HTML files
being part of that wizard
For more information see the DeskProto Script Reference just mentioned.

All Script Wizards can be started via the Start  Screen or via Start Custom
Wizard in the File menu.
You can also start a Custom Wizard by calling it's DPW-file as a  command
line parameter.
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6.9 Graphically finding the rotation

Finding  the  correct  XYZ  rotation  values  to  orientate  the  geometry  as
required can be very difficult, especially when angles other than 90 degrees
are involved.  Here is  a tip to easily find these three rotation  values  by  first
rotating the geometry on screen.
Follow the following steps:

1. Set the rotation settings for the Part to [X=0, Y=0, Z=0].
(Part Parameters, tab page Transform)

2. Rotate the geometry to the required orientation, using the mouse, as seen
from  above  (assuming  the  X-axis  of  the  machine  to  be  horizontal  on  the
screen,  and  the  Y-axis  of  the  machine  to  be  vertical  on  the  screen).  So
imagine  that  your  viewpoint  is  above  the  machine:  you  are  looking
downward from the positive Z-axis.

3.  Now  simply  copy  the  rotation  settings  from  the  view  (View  menu,
Viewpoint, Custom) and enter them as the rotation settings for the part (Part
Parameters, tab page Transform).

4.  Finally  check  whether  the  rotations  are  exactly  the  way  you  want  (by
looking at some default views for example).

A different feature that you can use here is the option called Show downward
faces in the Subjects dialog.
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6.10 Compatible CAD Software

For  importing  3D  Geometry  DeskProto  supports  STL  files,  the  most
widespread de facto standard used by CAD-systems for prototype building.
So  file  transfer  from  your  CAD  system  should  be  possible  without  any
problems: any current 3D CAD system can export STL files. In addition, the
two  formats  DXF  and  VRML  that  are  available  as  well  guarantee  a
successful geometry transfer from nearly any source.

For 2D data the formats DXF, EPS and AI are supported. DXF files typically
are created by CAD programs, 2D CAD as well as 3D CAD. Graphic design
software  as  used  by  graphics  designers  typically  writes  2D in  formats  EPS
and AI.

For Bitmap data DeskProto can read the formats BMP, GIF, JPG, PNG and
TIFF. Any graphics program will be able to write one of these files,  just  as
any digital camera.

We do not offer a complete listing of compatible software (as this would be
too long for this manual), however a few remarks on export filters for a few
widespread CAD systems are in order.
Note: all trademarks are owned by their respective owners.

General remarks:

The original Stereolithography system has more severe requirements for the
STL  file  than  DeskProto.  It  accepts  only  positive  coordinate  values,  small
gaps of say 0.001 mm between two triangles are lethal, a complete and true
solid must be present. DeskProto does not care about all these errors.

In some solid modelers, for instance in Pro Engineer, extra care is needed to
export  STL  files  as  they  require  a  solid  model  for  this  option.  For
stereolithography this is needed indeed, and it might cost a lot of extra work
to get a valid solid. For DeskProto the  STL file need not be a valid solid. 
Both binary and ASCII STL files are accepted.

Some  surface  modelers  produce STL files  that  contain  invalid  normals.  In
that case the drawing in DeskProto shows part  of the surface  in  black.  The
reason for this is that for part of the geometry the normal-vectors in the STL
file  are  reversed  (resulting  in  an  invalid  solid).  You  can  correct  this  by
switching  off  the  option  'Skip  Backfaces'  in  the  Edit  Project  parameters
dialog box.

For DXF files the situation is a bit more complex. Almost any CAD system
can  export  DXF,  however  DeskProto  only  supports  a  specific  type  of
geometry in the DXF file: geometry in small triangles (facets). In DXF these
supported entities are called 3D Face and Polyface Mesh. All  other  entities



Various

Page 241

DeskProto Reference

in the DXF file will be ignored by DeskProto.
In general it is advised to use STL, however for some CAD packages STL is
not supported and DXF should be used instead:
3D Studio Max  (older versions)
Corel Dream 3D
Form Z  (older versions)

The  same  applies  to  2D  DXF  files:  here  too  DeskProto  supports  only  a
subset of the complete file definition. The supported entities are: 
Point: will result in a drilling operation on that location.
Line: will result in a tool movement from begin to end (linear interpolation). 
Polyline  and  LW  polyline:  a  series  of  lines  and/or  arcs  connected  to  each
other. 
Arc: will be converted to many small line segments by DeskProto.
Circle  and  Ellipse:  will  be  converted  to  many  small  line  segments  by
DeskProto.

The entities mentioned above (in DeskProto meant for 2D use)  in the DXF
file can also have a Z-coordinate. For instance in a 3D polyline.  When you
open such DXF file in a DeskProto 2D operation then DeskProto will report
that is has detected Z-values in the file, and will ask you if you want to use
them.
After Yes the 2D operation will produce a 3D toolpath, after No the Z-values
will be ignored.

The  standard  for  VRML files  is  almost  completely  covered  by  DeskProto,
both for VRML Version 1 and Version 2. Not supported (yet) are the entities
Sphere,  Cone  and  Cylinder,  and  the  concept  of  Custom  Node  Type
definitions. Note that the file-extension for VRML is WRL.

A file type that is also used to transfer data between CAD and CAM systems
is  the  IGES file.  DeskProto  does  not  support  IGES files,  as  they  store  the
data in a much more complex way, making many types of conversion errors
possible. In theory IGES offers higher quality transfer than STL, however for
prototyping  purposes  STL  is  sufficient.  IGES  may  have  advantages  for
moldmaking,  as  more  tooling  strategies  are  possible  on  IGES  data.  Many
high-end  CAM  packages  are  offering  this  type  of  functionality,  but  this  at
high cost both in money and ease-of-use.

Program specific remarks:

Almost  any  3D  CAD  program  offers  a  few  parameters  (called  for  instance
Export options) to set the accuracy of the STL file (and thus the number of
triangles  and  the  file  size).  Many  will  also  offer  some  'Preview'  option,
giving you feedback about the values to use for an acceptable resolution.
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Old versions of AutoCAD behave strangely for 3D objects:
In  AutoCAD  R11/R12  an  STL  file  can  be  generated  using  the  command
SOLSTLOUT,  which  is  a  part  of  the  AME  modeling  extension.  The
geometry must  first  be placed in the positive octant  (all  X,  Y and Z  values
positive).

In  AutoCAD  R13  the  command  STLOUT  must  be  used,  which  is  only
possible  for  3D solids  (geometry  created  using  the  solid  modeling  option).
First move the part to the positive octant. In case you are using the Designer
parametric  extension  you  first  have  to  explode  the  part  before  running
STLOUT. You can then Undo to get back to the part as originally designed. 
The  accuracy  can  be  controlled  using  the  AutoCAD  system  variable
FACETRES.  Its range is between 0.01 and 10, the default value is 1, which
is OK for most parts. Increasing this value will increase the number of facets
(and the STL file size as well).

In Autodesk Mechanical Desktop you also have to build a solid before you
can write an STL file. Here the procedure is to first  explode the solid (only
the  part,  not  'all';  remove  it  from  any  assembly  first),  then  set  the  facet
resolution (advised: max = 10) by typing "facetres <0.5>:10", move the solid
in the positive X, Y, Z octant, and then do file...export...file type STL.
Use a continuous line layer for this entire procedure.

Newer AutoCAD versions and Autodesk Inventor just show STL as one of
the available export options.

In  older  versions  of  Pro/Engineer  the  required  export  option  is  not  called
STL,  but  SLA  (Stereo  Lithography  Apparatus)  instead.  Pro/E  offers  two
parameters  to  set  the  accuracy  of  the  STL  file:  Chord  Height  and  Angle
Control. Do note that a true solid is needed to enable this option.
For  Chord  Height  enter  0  (zero):  Pro/E  then  will  show  the  minimum  and
maximum permitted values. Use the minimum value for a smooth prototype. 
For  Angle  Control  in  most  cases  the  default  of  0.5  is  OK.  For  smoother
surfaces  use  a  higher  value.  In  case  you  are  asked  if  non-negative
coordinates are needed, both options are okay for DeskProto.

The  Rhino  software  has  a  special  link with  DeskProto  that  is  already  built
into the program. When both Rhino and DeskProto are installed on the same
PC, then  DeskProto can  be  called  directly  from  Rhino  using  the  command
“Print  3D”  in  the  Rhino  File  menu.  Rhino  will  than  start  DeskProto  with
your current geometry loaded.
When  creating  an  STL  file  in  Rhino  you  have  many  options  to  set  the
accuracy,  so  many that  it  may be  confusing.   The Preview  buttons  offers  a
good help here, as the preview offers a good indication if the STL file will be
sufficiently smooth.
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In  Solid  Edge  STL  output  is  only  possible  in  the  Part  editor,  so  not  for
assemblies. If this is still needed you can convert an assembly (ASM file) to
a part  using the 'Insert'  command in  the  Part  editor.  As  the  object  to  insert
you can choose an assembly, which will then be converted to a part and after
that can be exported to STL.

In  Unigraphics  (now  Siemens  NX)  two  parameters  are  used  to  define  the
accuracy  of  the  STL  file:  Triangle  Tolerance  (tri  tol)  and  Adjacency
Tolerance. 
Triangle Tolerance must be set between 0.0025 and 2.5 (mm). The default of
0.8 results in a poor part: use a value around  0.01 instead.
Adjacency  Tolerance  is  only  needed  for  surfaces,  to  prevent  small  gaps
between  the  triangles.  Use  the  default  (this  setting  does  not  influence
DeskProto).
Note: in Unigraphics,  STL export is  only available  as optional  extra,  at  an
extra price.
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Free movement height 116
Layers 118
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Roughing 118
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2D file 114, 195
filetypes 195

loading 195

Size 47

transforming 197
2D milling 195

2D operation 199

default 158, 200

parameters 113
parameters dialog 113

3
3D face 188

4
4th axis  

commands 111
settings 140

use 67

5
5th axis  

commands 111

settings 140

tilt angle 103
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About box 183

Add  
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AI file 195

Aligning 2D data 125

Aligning bitmap data 125
Always show message 169

Always stay low 95

Ambient 94

Ambient area 76
Ambient level 76

Ambient skipping 99

Angle with X-axis 87

ANSI encoded 186
Anti-aliasing 169

Arc 195

Area to machine 92

Autocad 188, 195
Automatic Tool Changer 149

Automation 235, 237

B
Backfaces 189

skip 63

Basic 2D wizard 29

Basic 3D wizard 29
bitmap 201

dimensions 121

DPI 121

position 121
project on part 123

Size 47

Z-values 123

Bitmap file  
filetypes 203

loading 203

transforming 203

Bitmap operation 205
default 159, 205

parameters 119

parameters dialog 119

settings 120
Bitmap wizard 29

Block  

size 74

size (two sided wizard) 168
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Block toolpaths 87

BMP file 201

Borders 94

Bottom level 70
Buffering (graphic) 169

Button, size 46

Buttons 15, 43

C
CAD software 240

Calculate  

simulation 131
toolpaths 127

Calculation precision 106

Camera position 58

Center 110
Centre 110

Centre around rotation axis 70

Chaining 64, 99, 111

Check for update 182
Circular strategy 110

Circular toolpaths 87

Climb milling 95

Clipboard 42
Collet collision 99

Colors 165

COM Port 166

Command line parameters 235
Comment  

ctr files 213

Context sensitive Help 183

Contour only toolpath 87
Conventional milling 95

Coordinates on screen 24, 46

Copy image 42

Correction factor (time) 129
Corrupt geometry 189

Create  

NC program 212

project 185
Crosswise toolpaths 87

Current  

part 191

Custom wizard 32, 237

Customizing DeskProto 34

Cutter 84, 114

dialog 152

dimensions 152
multiple diameter 152

type 152

D
Default  

2D operation 200

2D operation parameters 158

bitmap operation 205
Bitmap operation parameters 159

machine 224

operation 193

operation parameters 157
part 191

part parameters 156

project 185

project parameters 156
view 161

Delft Spline Systems 10

Depth cueing (fog) 165

Direction of milling 95
Disclaimer 5

Display driver 230

Distance between toolpaths 84

Downward faces 54
DPJ file 184, 186, 232

DPT file 184

DPW file 32, 237

Drawing  
accelerate 60

Drilling 195

peck 118

Driver 230
Drivers  

file location 162

DTP file 186

DXF-file  
2D 195

3D 188

Dynamic drawing 169

Dynamic feedrate 95
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E
Edit  

operation parameters 83
part parameters 65

Editions 181, 215

Encoding 186

End commands 111
EPS file 195

Essentials 6

Exit 41

Export  
Simulation 135

Z-grid 135

Export settings 169

External program 166

F
Feedrate 84, 114, 139

default 152
dynamic 95

first movements 95

high chip loads 95

plunge movements 95
File  

2D 114

locations 162

Files  
managing 25, 41

new 25

open 26

save 26
save as 27

Filetypes  

2D 195

3D 188
bitmap 203

Fill gaps 87

Five axis machining 111

Flip normals 63
Fog 165

Free movement height  

2D 116

3D 95

Freeformed segment 107

G
General preferences 162
Geometry 188

Add 36

corrupt geometries 189

filetypes 188
Load 36

loading 188

points only 54

rendered 54
save as 38

saving 188

Size 47

transforming 190
wireframe 54

Geometry information 47

GIF file 201

Graphics card 230

H
Hardware specification 7

Help  
Context 183

topics 173

Hidden lines 54

I
Import settings 169

Indexed machining 111, 216

Initial Settings dialog 224
Inverse milling 70

J
JPG file 201

K
Keep settings 229

L
Lamp icons 20, 50

Language setting 162

Large buttons 46
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Layer thickness 90
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2D 118

Layout  
view 53

Liability 5

Library  

cutter dialog 152
cutters 151

how to use it 213

machine dialog 139

machines 137
postprocessor dialog 144

postprocessors 143

License 180

Line 195
Load  

2D file 114, 195

bitmap file 203

geometry 36, 188
LPT Port 166

M
Machine 67

advanced setfings 140

dialog 139

selecting 212

Machining level 114
Machining simulation 105

Machining time 129

correction factor 139

Macro 237
Material block 74

Meander milling 95

Menu bar 14

Migrate settings 227
Mirror 70

2D 115

moiré effect 201

Mold 70
Mould 70

Mouse  

rotate/pan/zoom 60

show coordinates 24, 46

N
NC files window 23, 52

NC Output 166
NC Program 132

NC-program 212

creating 212

select machine 212
select postprocessor 212

write 128

New  

project 25, 185
Normals 189

flip 63

N-sided wizard 29
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Offset toolpaths 87
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2D file 114
file location 162

project 26, 185

Open GL 60, 169

OpenGL 230
Operation 193

2D 199

2D Operation Param dialog 113
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Bitmap Operation Param dialog119

bitmap settings 120

default 157, 193

parameters dialog 83
simulation 210

toolpath 208

visible 193, 199, 205

z-grid 207
Optimization 95

Orientator 54
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Parallel toolpaths 87

Parameters  

2D operation 113

Bitmap operation 119
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Parameters  

operation 83

part 66

project 62
Part 191

current 191

default 156, 191

NC-program 212
parameters 239

parameters dialog 66

Size 47
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Plotfile 195
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2D 119

Point 195
Polyface mesh 188

Polyline (2D and 3D) 195
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Postprocessor 139
dialog 144
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feedrate 148
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file size 145

line numbers 145

movement command 146

rapid movement 148
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spindle speed 149
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toolchange 149
units 146

Precision 84, 106

project 2D contour on 3D 116

Preferences 162
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preview 40
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Printer driver 166
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create 185

default 156, 185

file 186

geometry 188
NC-program 212

opening 185
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saving 186
structure 20, 50, 184

template 234

toolpath 208

tree 20, 50
Project 2D contour on 3D 116

Project file 232
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Quick Start 174
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Radial strategy 110

Radial toolpaths 87
Ramping 90, 118

Rapid 208

Recent file list 41

Redo 107
Reduced feedrate 95
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Report 178
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Rest material simulation 105

Rotary wizard 29
Rotate 70

2D 115
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files 28
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Save  
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project 26, 186

project as 27
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3D 70

Script 237

Script Wizard 237
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Send NC program to ... 132, 166

Send toolpaths to ... 134

Settings  

initial 224
keep 229

migrate 227

Settings, import/export 169
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Simulation 105, 210
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calculating 210

export 135
Skin 90
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Sort 95

Specifications 7
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Spindle speed 84, 114, 139

default 152
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Spiral strategy 110

Spiral toolpaths 87
Start commands 111
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Stepsize along toolpath 84

STL-file 188
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Support 9, 223

problem report 178
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Template project 234
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Tilt angle 103

Time  
machining 129

Title 54

Title bar 13

Toolbar 15, 43
Toolpath 208

calculating 208

simulation 105

Toolpaths 134
calculate all 132
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2D 115
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Translation (language) 162
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Tree  

project tree 20, 50

Trial period 222

Troubleshooting 222
Two sided wizard (block size) 168

Two-sided machining 217
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Undo 107

Units 162, 224

Update 182
Upgrade 227

Upgrading 181

Upper half of geometry 74

USB Port 166
UTF encoded 186

V
Vertical surfaces 99

roughing 90

View 60

default 161

layout 53
project tree 20, 50

Subjects dialog 54

View window 18

Viewpoint 58
custom 58

dialog 58

Visible operation 193, 199, 205

VRML-file 188

W
Waterline toolpaths 87

Windows driver 230
Wireframe 54

Wizard 168, 237

choosing type of wizard 29

custom 32, 237
html 32

script 32, 237

Working area 139

Workpiece zero point  
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Write  

NC program 128

Z
Z-grid 132, 207

calculating 207
export 135

Zoom 60
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